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ÜBERSICHT _______________________________________________  
Willkommen in der Software-Bedienungsanleitung für den System-Prozessor Shure P4800. Das Ziel dieses 
Dokuments ist es, Ihnen ein Verständnis der Funktionen des P4800 zu vermitteln, während Sie den Umgang mit der 
Software-Oberfläche erlernen. Das Gerät kann als unabhängiger Front-End- und Back-End-System-Prozessor 
eingesetzt werden, der sich extern durch eine einfache Benutzerschnittstelle steuern lässt, während die Software 
dazu dient, die interne Signalführung und Audioverarbeitung des Geräts zu konfigurieren. Das Gerät ist für kleine und 
mittelgroße Soundsysteme vorgesehen, für die die Leistung und Flexibilität eines Digital-Signalprozessors benötigt 
wird, der sich aber bei der Installation einfach konfigurieren und vom Benutzer einfach bedienen lassen soll.  

Aufbau dieser Anleitung 
Möglicherweise empfinden Sie die Software-Oberfläche als so intuitiv und benutzerfreundlich, dass Sie die 
Dokumentation gar nicht mehr lesen wollen, sondern gleich mit der Programmierung des Geräts beginnen möchten. 
Vorher sollten Sie aber unbedingt die Übersicht überfliegen und dann den Abschnitt Einrichtung auf Seite 12 
aufmerksam lesen. Antworten auf Fragen zur Benutzung der Software finden Sie in den folgenden Abschnitten dieser 
Anleitung. 

�� Übersicht ......................................Stellt die wesentlichen Merkmale des System-Prozessors vor und 
diskutiert die Betriebsmodi der Oberfläche und des Hauptfensters. 

�� Einrichtung ..................................Beschreibt die grundlegenden Schritte in der Software, um den 
System-Prozessor für eine Installation einzurichten. 

�� Erstellen einer Konfiguration ..Behandelt die Elemente einer Signalflusskonfiguration des 
System-Prozessors wie Verstärkungsstruktur des Geräts, Signalführung von Eingängen zu 
Ausgängen, Hinzufügen von Prozessoren in den Signalweg und Arbeiten damit im Hauptfenster. 

�� Speichern einer KonfigurationErläutert die Speicherung einer Konfiguration im Computer, 
Speicherung als Preset im P4800 und Datensicherung vom Gerät zum Computer. 

�� Prozessor-Funktionen...............Beschreibt die Funktionen, die in vielen Signalprozessor-Modulen 
vorkommen, wie Fader, Momentaufnahmen von Parameter-Einstellungen sowie Speichern und 
Abrufen von Einstellungen in den bzw. aus dem Computer. 

�� Feste Prozessoren .....................Erläutert die Funktionen der Ein- und 
Ausgangsverstärkungs-Prozessoren und des Matrixmischers. 

�� Modulare Prozessoren ..............Erklärt die jeweiligen Funktionen der einzelnen modularen 
Signalprozessoren. 

�� Steuerpins ....................................Beschreibt die interne Architektur der externen 
Gerätesteuerfunktion des System-Prozessors und erläutert die Konfiguration der Steuerpins 
des P4800 mit der Software, nachdem die externe Hardware angeschlossen wurde. 

�� Sicherheit .....................................Behandelt die Sicherheitsfunktionen des System-
Prozessors, die den Benutzerzugang zu den Geräteeinstellungen einschränken. 

Merkmale des System-Prozessors 
Der P4800 ist ein digitaler Audio-Prozessor mit 4 Ein- und 8 Ausgängen und einer Software-Oberfläche, die die 
Bedienelemente an der Gerätevorderseite vollständig ersetzt. Er bietet 24-Bit-Umwandlung, Sampling mit 48 kHz und 
einen minimalen Dynamikbereich von 100 dB. Die Soundplex-Digitalsignalverarbeitung gewährleistet hohe Leistung 
und Systemstabilität. Das Gerät kann, abhängig von der Komplexität der Konfigurationen, zwischen 16 und 128 vom 
Benutzer definierte Presets speichern. 

Software-Oberfläche mit Drag & Drop 
Die Computerschnittstelle zum System-Prozessor ahmt die funktionalen Blockdiagramme nach, die im 
Soundsystem-Design verwendet werden. Dadurch lässt sich die Software sehr leicht erlernen, weil die 
Benutzeroberfläche für Tontechniker sofort vertraut erscheint. Systemkonfigurationen können ausschließlich 
durch Klicken, Ziehen und Ablegen mit der Maus erstellt und bearbeitet werden. Dieser 
Digitalsignalprozessor ist in großem Umfang konfigurierbar, seine modularen Signalprozessoren lassen sich 
beliebig vom Benutzer anordnen.  
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Modulare Signalprozessoren 
Jedes Signalprozessormodul ist in einem Grafikblock eingeschlossen, der mit der Maus bearbeitet werden 
kann. Zum Zugriff auf die Einstellungen des Prozessors wird auf den Block doppelgeklickt, um sein 
Parameterfenster einzublenden. Einstellungen können im Computer gespeichert und von dort abgerufen 
sowie zwischen ähnlichen Modulen kopiert werden. Prozessor-Einstellungen lassen sich außerdem über die 
Verknüpfungsfunktion miteinander synchronisieren. Der P4800 enthält die folgenden 
Signalprozessormodule. 

��Leistungsstarker digitaler 
Rückkopplungsreduzierer von Shure ��2- bis 5-Wege-Frequenzweichen und -Verteiler 

��Automatische Pegelregelung und Ausgleicher ��Gate/Expander 
��Kombinierende und nichtkombinierende 

grafische Equalizer mit 10 und 30 Bändern 
��Mono- und Stereo-Kompressoren/Limiter mit 

Soft-Knee-Option 
��Parametrische Equalizer mit 3 bis 10 Bändern 

und Filter mit steilflankiger und Kuhschwanz-
Charakteristik 

��Separate Filter mit steilflankiger und 
Kuhschwanz-Charakteristik mit einer Flanke von 
24 dB pro Oktave 

��Ducker ��Peak-Stop-Limiter 

Externe Gerätesteuerung 
Nach der Installation und Programmierung über die Software-Oberfläche lässt sich der System-Prozessor nicht 
nur per Computer und MIDI steuern, sondern auch über eine einfache Hardware-Schnittstelle für den 
Endbenutzer. Die Steuerpins an der Geräterückseite können mit externer Hardware verbunden werden, sodass 
der P4800 auf Schließen von Kontakten, Potentiometer und Schalter reagiert. Die Ausgangspins lassen sich so 
konfigurieren, dass sie Preset- und Stummschalt-Zustände an LEDs, Steuerrelais und andere Vorrichtungen 
leiten. 

Sicherheit 
Die Sicherheitsfunktion verhindert, dass andere Personen nach der Installation am Gerät „spielen“ und dabei 
Einstellungen verändern. Der Benutzerzugang lässt sich vollständig beschränken, sodass der Benutzer keine 
Einstellungen verändern und nicht einmal Presets umschalten kann. Dann ist es nur möglich, die Einstellungen 
des jeweiligen Presets auf der Software-Oberfläche zu sehen. Außerdem kann die Endbenutzer-Kontrolle 
konfiguriert werden, sodass Zugang zu bestimmten Einstellungen möglich ist, zu anderen aber nicht. 

Mindesterfordernisse für die Software des P4800 
Für einwandfreie Installation und einwandfreien Betrieb erfordert die Software Version 3 des P4800 einen PC 
mit der folgenden Ausstattung: 

�� 20 MB verfügbarer Festplatten-Speicherplatz 
�� CD-ROM-Laufwerk 
�� VGA-Monitor mit 640 x 480/256 Farben oder höherer Auflösung 
�� Maus oder anderes Zeigegerät 

Die CPU-Taktrate und der erforderliche Speicher sind abhängig von der Windows-Version und der Anzahl 
der im Hintergrund ausgeführten Anwendungen. Der gleichzeitige Betrieb der P4800 Software mit anderen 
Programmen wie SIA-Smaart® oder Gold Line TEF™ erfordert einen schnelleren Prozessor und mehr RAM-
Speicher. Die nachstehende Tabelle enthält die Mindesterfordernisse zur Ausführung der P4800 Software, 
während keine anderen Anwendungen einschließlich Virenschutz-, Firewall-, Instant-Messaging- und E-Mail-
Anwendungen ausgeführt werden. 

 

Windows-Version CPU-Taktrate RAM 

95, 95B und 98 Pentium 166 MHz 32 MB 

98, Second Edition Pentium 166 MHz 48 MB 

NT Pentium 233 MHz 64 MB 

ME Pentium 300 MHz 64 MB 

2000 Professional Pentium 300 MHz 96 MB 

XP Professional, Home Pentium 300 MHz 128 MB 
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Betriebsmodi der Benutzerschnittstelle 
Die Benutzerschnittstelle verfügt über zwei hauptsächliche Betriebsmodi: Design-Modus und Live-Modus. Dadurch besteht 
die Möglichkeit, unabhängig davon, ob das Gerät am Computer angeschlossen ist, Konfigurationen für den System-
Prozessor zu erstellen. Bestimmte Funktionen sind nur in einem Modus verfügbar und werden an entsprechender Stelle in 
der Anleitung erläutert. 

Design-Modus 
Beim Starten wird die Anwendung immer im Design-Modus geöffnet. In diesem Modus werden die Presets 
erstellt, die später im System-Prozessor gespeichert werden. In diesem Modus ist es nicht erforderlich, dass 
der Computer am Gerät angeschlossen ist. Die erstellten Signalfluss-Konfigurationen können in Szene-
Dateien im Computer gespeichert werden und lassen sich später wieder öffnen und über die RS-232-
Verbindung zum Gerät übertragen. Dadurch können Presets an anderen Orten als unmittelbar an der Anlage 
erstellt werden. Szene-Dateien entsprechen Presets in jedem Aspekt mit der Ausnahme, dass sie im 
Computer und nicht im Gerät gespeichert werden.  

Live-Modus 
In diesem Modus können Echtzeit-Einstellungen an den Hardware-Presets vorgenommen werden, während 
der Computer am System-Prozessor angeschlossen ist. Auf diese Weise können die Änderungen der 
Signalverarbeitung beim Ändern von Einstellungen sofort gehört werden, um die Presets vor Ort 
„maßzuschneidern“. Alle Bedienvorgänge im Live-Modus werden direkt in das jeweils geöffnete Preset 
geschrieben. 

Vorschau-Modus 
Beim Arbeiten im Live-Modus mit einem Gerät, das mehrere Presets enthält, können diese einzeln zur 
Veränderung in Echtzeit abgerufen werden. Wenn ein Preset gewählt wird, das in das Signalflussdiagramm 
geladen werden soll, schaltet das Fenster in den Vorschau-Modus, damit die Wahl bestätigt werden kann, 
bevor das Preset als nächstes Live-Preset zugewiesen wird. Die Schnittstelle kehrt zum Live-Modus zurück, 
wenn das Preset geladen oder der Vorgang abgebrochen wird. 
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Das Hauptfenster 
In diesem Abschnitt werden die Elemente des Hauptfensters vorgestellt und ein Teil der Terminologie der Software 
eingeführt. Dieses Fenster ist der hauptsächliche Arbeitsplatz in der Software-Schnittstelle. Das Fenster kann proportional 
vergrößert oder maximiert werden, sodass es den gesamten Bildschirm ausfüllt. Durch Schließen dieses Fensters wird die 
Anwendung beendet. 

1. Titelleiste 
Die Informationen in der Titelleiste dieses Fensters ändern sich entsprechend des Betriebsmodus. Im 
Design-Modus enthält die Titelleiste „P4800: Offline“ und zeigt die Standard-Sicherheitsstufe an. Im Live-
Modus werden Informationen über das angeschlossene Gerät angezeigt. 

Die Geräte-Kennnummer wird mit den DIP-Schaltern an der Geräterückseite eingestellt, und der 
Gerätename und die Sicherheitsstufe werden im Menü [Device] (Gerät) im Live-Modus gewählt. 

2. Hauptmenü 
Einige Menüoptionen sind nur in bestimmten Modi verfügbar und werden in den anderen Modi 
abgeblendet. Kontextbezogene Menüs sind auch verfügbar, indem mit der rechten Maustaste geklickt 
wird, wenn der Cursor sich im Signalflussdiagramm (unten Nummer 11) befindet. 

Abbildung 1 - Hauptfenster 

Abbildung 2 - Titelleiste im Live-Modus 

Geräte-Kennnummer Sicherheitsstufe Gerätename 
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3. Steuerleiste 
Dieser Fensterabschnitt verändert sich im Erscheinungsbild und in der Funktion abhängig vom 
Betriebsmodus. Im Live-Modus bildet die Steuerleiste die LED-Pegelanzeigen an der Vorderseite des 
Geräts nach. 

Die Pegelanzeigen lassen sich ein- und ausschalten, indem mit der linken Maustaste darauf geklickt 
oder indem [View > Enable I/O Meters] (Ansicht > E/A-Pegelanzeigen aktivieren) im Hauptmenü gewählt 
wird. 

Im Vorschau-Modus bietet die Steuerleiste die Möglichkeit, das gewählte Preset zu laden oder den Vorgang 
abzubrechen und zum vorherigen Live-Preset zurückzukehren. 

4. Schaltfläche „Live Mode“ (Live-Modus) 
Durch Klicken auf diese Schaltfläche wird in den Live-Modus geschaltet, in dem jedes im Gerät 
gespeicherte Preset als Vorschau angezeigt und bearbeitet werden kann. Um in diesen Modus schalten 
zu können, muss der Computer am P4800 angeschlossen sein. 

5. Schaltfläche „Design Mode“ (Design-Modus) 
Durch Klicken auf diese Schaltfläche wird in den Design-Modus geschaltet. Das Preset, mit dem im Live-
Modus gearbeitet wird, bleibt im Signalflussdiagramm geladen, wodurch das jeweilige Preset als Vorlage 
verwendet und mehrere Presets durch wiederholtes Speichern im Gerät erstellt werden können. 

6. Informationsfeld 
Hier werden Informationen über das Preset oder die Szene-Datei angezeigt, das/die gegenwärtig auf 
dem Bildschirm geladen ist, wie Name, Datum der letzten Speicherung und Beschreibung. Im Live-
Modus erscheint ein Pulldown-Menü im Namensfeld, in dem alle im Gerät gespeicherten Presets 
aufgelistet werden (siehe Abbildung 3 oben). 

7. Store Preset (Preset speichern) 
Diese Schaltfläche ist nur im Design-Modus verfügbar. Durch Klicken darauf werden die aktuellen 
Signalflussdiagramm-Einstellungen als Hardware-Preset im System-Prozessor gespeichert. 

8. Recall Preset (Preset abrufen) 
Diese Schaltfläche ist nur im Design-Modus verfügbar. Durch Klicken darauf wird ein Preset aus dem 
System-Prozessor in das Signalflussdiagramm geladen.  

9. Save As (Speichern unter) 
Durch Klicken auf diese Schaltfläche werden die aktuellen Signalfluss-Konfiguration und -Einstellungen 
in eine Szene-Datei gespeichert. 

10. Open (Öffnen) 
Diese Schaltfläche ist nur im Design-Modus verfügbar. Durch Klicken darauf wird der Inhalt einer Szene-Datei 
in das Signalflussdiagramm geladen. 

11. Signalflussdiagramm 
Das Signalflussdiagramm stellt dar, wie Audiosignale durch die verschiedenen Prozessoren in der 
Hardware geführt werden. Es veranschaulicht, wie Audiosignale von links nach rechts durch die Ein- und 

Abbildung 3 - Steuerleiste im Live-Modus

Abbildung 4 − Steuerleiste im Vorschau-Modus
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Ausgangskanalstreifen verlaufen. Jeder Kanalstreifen enthält feste Komponenten zum Einstellen der 
Verstärkung und Mischen der Kanäle. Sie enthalten außerdem eine Reihe von leeren Steckplätzen zum 
Hinzufügen von verschiedenen Verarbeitungsarten. 

12. Eingangskanalstreifen 
Die Eingangskanalstreifen entsprechen den vier Eingangskanälen des System-Prozessors. Jeder 
Streifen kann bis zu fünf verschiedene Signalprozessoren aufnehmen. 

13. Eingangskanal-Kennzeichnung 
Hier wird die Kanal-Kennzeichnung angezeigt, die im Fenster „Input Gain“ (Eingangsverstärkung) 
eingegeben wird. 

14. Eingangsverstärkung 
Dies ist die Anfangsstufe der Verstärkungsstruktur des System-Prozessors. Durch Doppelklicken auf 
diesen Block wird das Fenster „Input Gain“ eingeblendet, das Skalierungs-Optionen von -10 dBV/+4 
dBu, Kanal-Stummschaltung, Polaritätsregelung und einen +/-30 dB-Fader für jeden Eingangskanal 
aufweist. Außerdem werden hier die Namen für die Eingangskanäle eingegeben. 

15. Modusanzeige 
Hier wird der jeweilige Modus des Signalflussdiagramms angezeigt, wie nachstehend abgebildet. 

Design-Modus Live-Modus Vorschau-Modus 

  

16. Eingangswähler 
Durch Klicken auf diese nummerierten Eingangswähler am Mischpunkt jedes Ausgangsstreifens erfolgt 
automatisch die Verbindung mit dem entsprechenden Eingangskanal-Mischpunkt. 

17. Matrixmischer 
Dies ist die Zwischenstufe der Verstärkungsstruktur des System-Prozessors. Durch Klicken auf diesen Block 
wird das Fenster „Matrix Mixer“ eingeblendet, in dem das Signal von jedem Eingangskanalstreifen zu jedem 
Ausgangskanalstreifen geführt und relative Pegel mit den Fadern eingestellt werden können. Dieses Fenster 
verfügt über eine separate Registerkarte für jeden Ausgangskanalstreifen, auf der Verstärkungs-, Polaritäts- 
und Stummschaltungs-Steuerelemente für jeden an seinem Mischpunkt angeschlossenen Eingangskanal 
angezeigt werden. 

18. Kanalnummern 
Diese Nummern entsprechen jeweils den vier Ein- und acht Ausgangskanälen des P4800. 

19. Mischpunkte 
Durch Klicken auf diese Punkte werden Signale zwischen Eingangsstreifen und Ausgangsstreifen 
geführt. Zwischen den verbundenen Punkten werden Linien angezeigt, die den Signalfluss darstellen. 
Jeder Eingangsstreifen kann mit beliebigen oder allen Ausgangsstreifen verbunden sein. 

20. Prozessor-Steckplätze 
Diese Steckplätze dienen zur Unterbringung von Prozessormodulen. Sie können durch Ziehen und 
Ablegen aus der Prozessor-Toolbox, mit der Option [Add Processor] (Prozessor hinzufügen) des 
Hauptmenüs oder mit dem Kontextmenü, das durch Klicken mit der rechten Maustaste eingeblendet 
wird, bestückt werden. 

21. Ausgangsverstärkung 
Dies ist die Endstufe der Verstärkungsstruktur des System-Prozessors. Durch Doppelklicken auf diesen 
Block wird das Fenster „Output Gain“ eingeblendet, das Skalierungs-Optionen von -10 dBV/+4 dBu, Kanal-
Stummschaltung, Polaritätsregelung, ein -20 dB-Dämpfungsglied und einen +/-30 dB-Fader für jeden 
Ausgangskanal aufweist. Außerdem kann hier ein benutzerdefinierter Name für jeden Ausgangskanal 
eingegeben werden, der für die jeweilige Einrichtung gilt.    
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22. Ausgangskanal-Kennzeichnung 
Hier wird die Kanal-Kennzeichnung angezeigt, die im Fenster „Output Gain“ (Ausgangsverstärkung) 
eingegeben wird. 

23. Ausgangsstreifen 
Die Ausgangskanalstreifen entsprechen den acht Ausgangskanälen des System-Prozessors. Jeder 
Streifen kann bis zu sechs verschiedene Signalprozessoren aufnehmen. 

24. Alle Eingänge stumm schalten 
Durch Klicken auf dieses Steuerelement werden automatisch alle Eingangskanäle stummgeschaltet. 

25. Alle Ausgänge stumm schalten 
Durch Klicken auf dieses Steuerelement werden automatisch alle Ausgangskanäle stummgeschaltet. 

26. DSP-Belegungsanzeige 
Hier wird der Prozentanteil der Digitalsignalverarbeitungs-(DSP)-Ressourcen des P4800 angezeigt, der 
durch die jeweilige Konfiguration der Prozessorblöcke, die in das Signalflussdiagramm gesetzt wurden, 
eingenommen wird. Der angezeigte grüne Balken verlängert sich, wenn die Belegung zunimmt. 

27. Verzögerungsspeicher-Anzeige 
Hier wird der Prozentanteil des Verzögerungsspeichers angezeigt, der durch die Delay-Prozessoren, die 
in das Signalflussdiagramm gesetzt wurden, eingenommen wird. Der angezeigte blaue Balken 
verlängert sich, wenn die Belegung zunimmt. 

Die Prozessor-Toolbox 
Die Prozessor-Toolbox wird beim Starten der Anwendung neben dem Hauptfenster eingeblendet. Dieses Fenster 
enthält die Bibliothek der Prozessormodule, die in leere Steckplätze des Signalflussdiagramms gezogen und dort 
abgelegt werden können. Seine Größe kann in vertikaler Richtung durch Ziehen des unteren Rands nach oben oder 
unten verändert werden. Eine Bildlaufleiste erscheint an der rechten Seite, sodass unabhängig von der Höhe des 
Fensters Zugriff auf jeden Prozessorblock möglich ist. 

Ein- und Ausblenden 
Die Prozessor-Toolbox wird vor jedem anderen offenen Fenster in der Anwendung angezeigt, wenn sie nicht durch 
Klicken auf das Steuerfeld rechts in der Titelleiste geschlossen wird. Mit [View > Show 
Processor Toolbox] (Ansicht > Prozessor-Toolbox anzeigen) aus dem Hauptmenü wird sie 
wieder eingeblendet. Neben dieser Menüoption wird ein Häkchen gesetzt, wenn dieses 
Fenster angezeigt wird. Durch die Wahl dieser Option, während die Prozessor-Toolbox 
eingeblendet ist, wird das Fenster geschlossen. 

Prozessorblöcke 
Prozessorblöcke sind die grafische Darstellung der Prozessormodule. 
Nachdem sie in das Signalflussdiagramm gesetzt wurden, ist Zugriff 
auf die Einstellungen möglich, indem auf den betreffenden Block 
doppelgeklickt wird, um sein Parameterfenster einzublenden. 

Dropdown-Schaltflächen 
Eine Dropdown-Schaltfläche erscheint über jeder Prozessor-Kategorie in der Prozessor-
Toolbox. Klicken Sie auf eine Dropdown-Schaltfläche, um alle Prozessorblöcke innerhalb 
dieser Kategorie anzuzeigen oder zu verbergen. 

Prozessor-
blöcke 

Abbildung 5 - Prozessor-Toolbox 

Dropdown-
Schaltfläche
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EINRICHTUNG _____________________________________________  
In diesem Abschnitt werden die grundlegenden Schritte für die vollständige Einrichtung des System-Prozessors 
erläutert. Bevor diese Anweisungen ausgeführt werden, sollte der Abschnitt „Übersicht“ gelesen werden, der einige 
grundlegende Merkmale der Software-Schnittstelle beschreibt. 

Viele dieser Anweisungen können ausgeführt werden, ohne dass das Gerät angeschlossen ist, indem die Konfigurationen 
im Computer gespeichert und später zum Gerät übertragen werden. Um die Möglichkeiten des System-Prozessors optimal 
vorzustellen, wird bei diesen Anweisungen folgendes vorausgesetzt: 

�� Beim Arbeiten in der Software ist das Gerät angeschlossen. 
�� Die Installation umfasst externe Gerätesteuerung. 
�� Geräte-Sicherheit ist erforderlich. 

In den Anweisungen können Schritte vorkommen, die nicht unmittelbar auf die bestehende Installation zutreffen. Wir 
empfehlen jedoch, den gesamten Abschnitt „Einrichtung“ durchzuarbeiten, um die empfohlenen Arbeitsabläufe für die 
Einrichtung des Geräts kennen zu lernen. 

Software installieren 
Wenn die Software noch nicht installiert wurde, die nachstehenden Anweisungen ausführen, um die 
Anwendung von der CD-ROM zu installieren. 

So wird die Software von der CD-ROM installiert: 

1. Die CD in das CD-ROM-Laufwerk des Computers einlegen. 

2. Das Installationsprogramm startet automatisch. Die angezeigten Anweisungen ausführen. 

 - Falls die Installation nicht automatisch beginnt - 

1. Auf die Schaltfläche [Start] der Windows Taskleiste klicken und [Ausführen…]  
aus dem Popup-Menü wählen. 

2. „D:\setup“ eingeben (wobei „D“ der CD ROM-Laufwerksbuchstabe ist). 

3. Auf [OK] klicken und die Anweisungen des Installationsprogramms ausführen. 

Wenn die Software per Datenübertragung erhalten wurde, die Datei mit der Endung „.exe“ im 
Windows Explorer öffnen. Die Anweisungen des Installationsprogramms ausführen. 

Kommunikation herstellen 
Dieses Verfahren ist auszuführen, wenn der Computer zum ersten Mal an das Gerät angeschlossen wird. 
Dies ist die erste Möglichkeit zur Überprüfung, ob der Computer und der P4800 einwandfrei miteinander 
kommunizieren. Für weitere Informationen zum Anschließen des Computers an das Gerät und zum 
Einstellen der Geräte-Kennnummer siehe den Abschnitt Computeranschlussoptionen der Hardware-
Installationsanleitung. 

1. Den Computer an den System-Prozessor anschließen 
Den COM-Anschluss des Computers mit dem seriellen RS-232-
Anschluss an der Vorder- oder Rückseite des P4800 verbinden.  

2. Die Software-Anwendung starten 

3. Den COM-Anschluss wählen 
a) Die Option [Devices>Select COM Port] (Geräte > COM-

Anschluss wählen) im Hauptmenü wählen. 

b) Das Dialogfeld „Select COM Port“ (COM-Anschluss wählen) wird 
eingeblendet. 

c) Den COM-Anschluss wählen, an den das RS-232-Kabel 
angeschlossen ist, und auf [OK] klicken. Abbildung 6 − Dialogfeld„Select COM 

Port“ (COM-Anschluss wählen) 
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4. Den System-Prozessor in den Live-Modus schalten 
a) Auf die Schaltfläche [Live Mode] in der Steuerleiste des 

Hauptfensters klicken. 

b) Das Dialogfeld „Select Devices“ (Geräte wählen) mit einer Liste 
aller verfügbaren Geräte wird eingeblendet. Die Kennnummer an 
der linken Seite der Liste wird mit den DIP-Schaltern an der 
Geräterückseite eingestellt.  

c) Den System-Prozessor wählen, mit dem gearbeitet werden 
soll, und auf [Connect] (Verbinden) klicken. 

d) Die Software-Schnittstelle schaltet in den Live-Modus, ersichtlich 
durch die blaue Farbe des Signalflussdiagramms und der in der 
Steuerleiste angezeigten Signal-Pegelanzeigen. 

5. Das Gerät benennen 
a) Die Option [Devices>Name Device] (Geräte > Gerät benennen) im 

Hauptmenü wählen. 

b) Das Dialogfeld „Name Devices“ (Geräte benennen) wird 
eingeblendet. 

c) Einen aus bis zu fünfzehn Zeichen bestehenden Gerätenamen 
eingeben und auf [Name] (Benennen) klicken. 

d) Der Gerätename erscheint im Live-Modus in der Titelleiste des 
Hauptfensters und wird im Menü [Devices] (Geräte) aufgelistet. 

Externe Steuerung konfigurieren 
Wenn externe Geräte an den Steuerpins angeschlossen sind, muss das Gerät zum Erkennen der externen 
Steuerung konfiguriert werden. Diese Konfiguration wird auf Geräteebene gespeichert und sollte eingerichtet 
werden, bevor Presets erstellt werden. Wenn kein Anschluss an das Gerät besteht, kann eine Konfiguration 
erstellt und im Computer gespeichert werden, um sie später über die RS-232-Verbindung zum P4800 zu 
übertragen. Siehe die Anweisungen dafür im Abschnitt Steuerpins auf Seite 76. 

1. In den Design-Modus schalten 
Zum Konfigurieren der externen Steuerung muss der Design-Modus aktiviert sein. Im Live-Modus auf die 
Schaltfläche [Design Mode] in der Steuerleiste des Hauptfensters klicken. 

2. Steuerpins konfigurieren 
Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im Hauptfenster wählen, 
woraufhin das Fenster „Control Pins“ (Steuerpins) eingeblendet wird. Zuerst wird entschieden, zwischen wie 
vielen Presets umgeschaltet werden soll und welche Art der Codierung das Gerät für die Preset-Nummern 
verwenden soll. Dann werden die anderen Steuerungs-Verbindungen vorgegeben. 

3. Die Konfiguration im Gerät oder PC speichern 
Die Menüoption [Configuration>Store to Device] (Konfiguration>Im Gerät speichern) oder [Configuration>Save 
to PC] (Konfiguration>Im PC speichern) wählen. 

Hinweis: Wenn es nach der Konfiguration der Steuerungs-Eingangsanschlüsse erforderlich 
werden sollte, Presets vom Computer umzuschalten, müssen die Verbindungen im 
Fenster „Control Pins“ vor dem Fortfahren deaktiviert werden. 

Abbildung 7 - Dialogfeld „Select Devices“ 
(Geräte wählen) 

Abbildung 8 - Dialogfeld „Name 
Device“ (Gerät benennen) 
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Eine Signalfluss-Vorlage erstellen 
Dieser Vorgang kann im Live-Modus oder Design-Modus ausgeführt werden. Wenn mehrere Presets im System-
Prozessor gespeichert werden sollen, ist eine beträchtliche Zeiteinsparung möglich, indem eine Signalfluss-
Vorlage erstellt wird, die die Attribute enthält, die gemeinsam für diese Presets gelten. Diese Vorlage kann dann 
aus dem Gerät abgerufen oder aus einer Szene-Datei im PC geöffnet, nach Erfordernis bearbeitet und dann als 
neues Preset im Gerät gespeichert werden. 

1. Ein- und Ausgangskanäle benennen 
Auf die Eingangs- und Ausgangs-Verstärkungsblöcke doppelklicken, um die Prozessorparameter-
Fenster einzublenden, und die Kanal-Kennzeichnungen unter den Pegelstellern bearbeiten. Für weitere 
Informationen siehe den Abschnitt Ein- und Ausgänge kennzeichnen auf Seite 17. 

2. Das Signalflussdiagramm bestücken 
Signalprozessorblöcke aus der Prozessor-Toolbox ziehen und im Signalflussdiagramm ablegen. Wenn 
Frequenzweichen verwendet werden, sollten diese als erster Prozessortyp in die Konfiguration gesetzt 
werden, gefolgt von Limitern, um Schäden an den Lautsprechern zu vermeiden. Für weitere 
Informationen siehe den Abschnitt Prozessoren hinzufügen auf Seite 20. 

3. Verknüpfte Gruppen erstellen 
Die Taste STRG drücken und dabei klicken, um mehrere Prozessoren des gleichen Typs zu wählen, die 
als Gruppe gesteuert werden sollen, z.B. als Stereo-Paare, Lautsprechergruppen, Zonen usw. Es ist 
auch möglich, Verstärkungsblöcke zu verknüpfen, um den Gesamtpegel des Systems zu steuern. Für 
weitere Informationen siehe den Abschnitt Verknüpfungen auf Seite 25. 

4. Ausgangspegel einstellen 
Auf die Ausgangsverstärkungsblöcke doppelklicken, um das Fenster „Output Gain“ 
(Ausgangsverstärkung) einzublenden. Die Ausgangsverstärkung jedes Kanals um -30 dB reduzieren, 
um zu verhindern, dass laute Signale durch das System laufen. Wenn Ausgangskanäle miteinander 
verknüpft sind, muss nur ein Fader betätigt werden, um alle verknüpften Kanäle auf den gleichen Pegel 
einzustellen. 

5. Signale von Eingängen zu Ausgängen führen 
Das Signal durch Klicken und Ziehen von Eingangsstreifen-Verbindungspunkten zu Ausgangsstreifen-
Verbindungspunkten durch den Matrixmischer führen. Für weitere Informationen siehe den Abschnitt 
Signalführung auf Seite 18. 

6. Prozessor-Parameter einstellen 
Auf die einzelnen Prozessorblöcke doppelklicken, um ihre Parameter-Fenster einzublenden. Beim 
Arbeiten im Design-Modus ohne Verbindung zum Gerät können vorläufige Pegel eingestellt und später, 
wenn der Anschluss zum Gerät besteht, überarbeitet werden. Für weitere Informationen zum Arbeiten 
mit Prozessoren siehe den Abschnitt ProzessorFunktionen auf Seite 31 sowie die Referenzabschnitte für 
die einzelnen Prozessoren. 

7. Prozessoren zu Steuerungsanschlüssen zuordnen 
Jedes Preset muss eine Zuordnung zu den Steuerpin-Anschlüssen haben, damit das Gerät die externen 
Geräte erkennen kann, wenn das Preset aktiv ist. Das Fenster „Control Pin“ öffnen und die 
Kontrollkästchen neben den Ein- und Ausgangskanälen markieren, die von den einzelnen 
Steuerungsanschlüssen angesprochen werden. Für weitere Informationen siehe den Abschnitt 
Steuerpins auf Seite 76. 

8. Prozessoren für schreibgeschützten Zugriff sperren 
Dieser Schritt ist nur erforderlich, wenn die Sicherheit für den Endbenutzer definiert werden soll. Dieser 
Sicherheitstyp wird für jeden Prozessor auf Presetebene gespeichert. Die Prozessoren wählen, die vor 
Änderungen durch den Benutzer geschützt werden sollen, und [Security>Level 2>Lock Selected] 
(Sicherheit>Stufe 2>Sperre gewählt) im Hauptmenü wählen. Für eine umfassende Erläuterung und 
weitere Anweisungen siehe den Abschnitt Sicherheit individueller Prozessoren auf Seite 87. 



Einrichtung 

SHURE System-Prozessor P4800 Software-Bedienungsanleitung Seite 15 von 108 

9. Preset benennen 
Einmal mit der linken Maustaste irgendwo im 
Informationsfeld in der Mitte der Steuerleiste klicken, um 
das Dialogfeld „Preset Information“ (Preset-
Informationen) einzublenden. Einen aus bis zu 15 
Zeichen bestehenden Namen für das Preset und eine 
Beschreibung eingeben und auf [OK] klicken. Für 
weitere Ein Preset oder eine Szene-Datei benennen auf 
Seite 19 

10. Das fertiggestellte Preset im Gerät speichern 
Beim Arbeiten im Live-Modus wurde das Preset bereits 
im Gerät gespeichert. Wenn im Design-Modus gearbeitet 
wird, auf die Schaltfläche [Store Preset] (Preset speichern) in der Steuerleiste des Hauptfensters klicken. 
Für weitere Informationen siehe den Abschnitt Preset-Verwaltung auf Seite 28. Ein Duplizieren dieses 
Presets ist nur im Design-Modus möglich. Einfach weiter auf die Schaltfläche [Store Preset] klicken, um 
Duplikate zu erzeugen, bis so viele Presets im Gerät gespeichert sind, wie benötigt werden. 

11. Externe Steuerung aktivieren 
Wenn die Steuerungsanschlüsse vorher deaktiviert wurden, um den System-Prozessor vom Computer 
steuern zu können, das Fenster „Control Pins“ öffnen und die Steuerungsanschlüsse wieder aktivieren, 
nachdem das Erstellen und Bearbeiten der Presets beendet ist. 

Sicherheit einrichten 
Dies ist der letzte Schritt bei der Einrichtung des Geräts. Vor dem Fortfahren sollte der Abschnitt Sicherheit 
auf Seite 85 gründlich gelesen werden. Die folgenden Anweisungen sind lediglich als Übersicht des 
Verfahrens anzusehen. 

1. Den System-Prozessor in den Live-Modus schalten 
Zum Einstellen der Gerätesicherheit muss der Live-Modus aktiviert sein. Im Design-Modus auf die 
Schaltfläche [Live Mode] in der Steuerleiste des Hauptfensters klicken. 

2. Kennwort einstellen 
Die Option [Security>Set Password] (Sicherheit>Kennwort einstellen) im Hauptmenü wählen, woraufhin 
das Dialogfeld „Create Password“ (Kennwort erstellen) eingeblendet wird. Ein Kennwort eingeben, die 
Taste TAB drücken und dann das Kennwort zur Bestätigung erneut eingeben. Auf [OK] klicken. 

3. Benutzer-Zugangsstufe einstellen 
Die Option [Security>Set Level] (Sicherheit>Stufe einstellen) im Hauptmenü wählen, woraufhin das 
Dialogfeld „Set Security“ (Sicherheit einstellen) eingeblendet wird. Die gewünschte Benutzer-
Zugangsstufe wählen. Auf [OK] klicken.Informationen siehe den Abschnitt.  

Abbildung 9 - Dialogfeld „Preset Information“ 
(Preset-Informationen) 
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ERSTELLEN EINER KONFIGURATION _________________________  
Eine Konfiguration ist eine bestimmte Kombination von Signalführungs-Verbindungen, Wahl und Anordnung von 
modularen Prozessoren und Prozessor-Einstellungen. Eine Konfiguration wird im Signalflussdiagramm des 
Hauptfensters erstellt und entweder als Preset im Gerät oder als Szene-Datei im Computer oder auf beide Weisen 
gespeichert. Im System-Prozessor ist anfänglich einfach ein leeres Preset geladen, d.h. im Gerät bestehen keine 
Signalführungs-Verbindungen und es erfolgt keine Signalverarbeitung. 

Signalfluss-Konfiguration 
Um Audio-Informationen durch das Gerät zu leiten, müssen Signale durch Verbinden von Mischpunkten von den 
Eingängen zu den Ausgängen geführt werden. In diesem Abschnitt werden die Grundlagen des Signalfluss-Designs 
in der Benutzerschnittstelle des System-Prozessors erläutert. 

Verstärkungsstruktur 
Der System-Prozessor bietet Pegelregelung an drei Stufen des Signalflusses: Eingangsverstärkung, 
Matrixmischer und Ausgangsverstärkung. Es ist wichtig, diese Verstärkungsstruktur zu verstehen, bevor 
Signale durch das Gerät geleitet werden, um Schäden an den hinter dem System-Prozessor 
angeschlossenen Geräten durch übermäßige Verstärkungspegel zu vermeiden. Die folgende Abbildung zeigt 
eine Übersicht der Verstärkungsstruktur des P4800. 

Eingangsverstärkung 
Durch Doppelklicken auf einen Eingangsblock wird das Fenster „Input Gain processor“ (Eingangsverstärkungs-
Prozessor) eingeblendet, in dem Steller für alle vier Kanäle angezeigt werden. Dieses Fenster ermöglicht 
Einstellung vor der Verarbeitung, es bietet Bedienelemente für Skalierung, Verstärkung und Polarität für jeden 
Kanal und gestattet die Zuweisung von benutzerdefinierten Namen für die Eingangskanalstreifen.  

Hinweis: Signalpegel, die die Eingangsschwelle des System-Prozessors überschreiten, müssen 
extern eingestellt werden, um eine Übersteuerung der A/D-Wandler zu vermeiden.  

Hier befindet sich der Eingangspunkt eines Signals in das Signalflussdiagramm. Hinter dem 
Eingangsverstärkungs-Prozessor wird das Signal der Reihe nach durch die Prozessor-Steckplätze in seinem 
Eingangskanalstreifen geführt. Am Ende des Kanalstreifens erreicht das Signal einen Mischpunkt, von dem 
es zu beliebigen oder allen Ausgängen durch den Matrixmischer geführt werden kann.  

Matrixmischer 
Nachdem ein Signal zum Mischpunkt eines Ausgangskanalstreifens geführt wurde, tritt es in die 
Matrixmischer-Stufe der Verstärkungsstruktur ein. Durch Doppelklicken auf einen Mischblock wird das 
Fenster „Matrix Mixer“ eingeblendet, das für jeden Ausgangskanalstreifen einen Fensterabschnitt enthält. 
Wenn Frequenzweichen über mehrere Ausgangskanäle gesetzt werden, werden die Mischer-
Fensterabschnitte für diese Kanäle zusammengefasst, um diese Konfiguration zu reflektieren. Dieses 

Abbildung 10 - Verstärkungsstruktur des P4800 

Regelt die Signalverstärkung 
nach der digitalen Umwandlung 
und vor der Verarbeitung im 
Einganskanalstreifen.    

Führt das Signal vom Eingang 
zum Ausgang und regelt die 
Signalverstärkung vor der 
Ausgangskanal-Verarbeitung. 

Abschließende 
Verstärkungseinstellung des 
verarbeiteten Digitalsignals vor 
der Analogumwandlung am 
Geräteausgang. 

Signalführungs-Verbindung

1. Eingangsverstärkung 2. Matrixmischer 3. Ausgangsverstärkung
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Fenster dient zum Einstellen der Polarität und der relativen Pegel aller Eingänge, die zum gewählten 
Ausgangskanal geführt werden. 

Hinter dem Matrixmischer wird das Signal der Reihe nach durch die Prozessor-Steckplätze des 
zugewiesenen Ausgangsstreifens geführt. Am Ende des Kanalstreifens erreicht das Signal den 
Ausgangsverstärkungsblock. 

Ausgangsverstärkung 
Dies ist die Endstufe der Pegelregelung im System-Prozessor. Durch Doppelklicken auf einen 
Ausgangsverstärkungsblock wird das Fenster „Output Gain processor“ (Ausgangsverstärkungs-Prozessor) 
eingeblendet. Es dient für Einstellungen nach der Verarbeitung und verfügt dafür über Bedienelemente für 
Skalierung, Verstärkung und Polarität sowie ein optionales 20-dB-Dämpfungsglied für jeden Kanal. In diesem 
Fenster ist es außerdem möglich, den Ausgangskanalstreifen benutzerdefinierte Namen zuzuweisen. Hinter 
dem Ausgangsverstärkungs-Prozessor wird das Signal durch den Digital-Analog-Wandler zum Audio-
Ausgang geführt. 

Kanäle stumm schalten 
Es gibt verschiedene Möglichkeiten zum Stummschalten der Ein- und Ausgangskanäle des System-
Prozessors. Stummgeschaltete Kanäle werden im Signalflussdiagramm gekennzeichnet, wie in der 
nachstehenden Tabelle dargestellt. 

Verstärkungsblock Eingänge 3 und 4 
zum Matrixmischer 

Ausgang vom 
Matrixmischer 

Frequenzweichen-
Ausgangskanäle 

    

Alle Ein- oder Ausgänge stumm schalten 
�� Auf das Steuerelement „Mute All Inputs“ (Alle Eingänge stumm schalten) oder „Mute All 

Outputs“ (Alle Ausgänge stumm schalten) an der Unterseite des Hauptfensters klicken. 
�� Die Menüoption [Processor>Mute All Inputs] (Prozessor>Alle Eingänge stumm schalten) 

oder [Processor>Mute All Outputs] (Prozessor>Alle Ausgänge stumm schalten) wählen. 
�� Das Gerät ausschalten, um automatisch alle Ausgänge stumm zu schalten. 

Einzelne Kanäle stumm schalten 
1. Das Fenster „Input Gain“, „Matrix Mixer“ oder „Output Gain“ durch Doppelklicken auf den 

entsprechenden Verstärkungs- oder Mischblock einblenden. 

2. Auf die Stummschaltungs-Schaltfläche für den entsprechenden Kanal klicken. 

3. Der Block wird durch ein rotes „M“ gekennzeichnet, um darauf hinzuweisen, dass er 
stummgeschaltet ist. 

Ein- und Ausgänge kennzeichnen 
Beim Erstellen einer neuen Szene-Datei sind Ein- und Ausgänge unbenannt, sie können aber im Fenster „Input 
Gain“ und/oder „Output Gain“ leicht mit Namen versehen werden. Kanal-Kennzeichnungen werden zusammen 
mit dem Preset oder der Szene-Datei gespeichert, sodass Ein- und Ausgänge für jede Systemkonfiguration mit 
benutzerdefinierten Namen versehen werden können. 

So wird eine Kanal-Kennzeichnung geändert: 

1. Auf den Verstärkungsblock des Kanals doppelklicken. 

2. Im Prozessor-Fenster das Namensfeld des Kanals suchen. 

3. Klicken und den Mauszeiger über den Text ziehen, um ihn zu markieren. 

4. Einen neuen Namen von bis zu fünfzehn Zeichen eingeben. 

5. Die Änderung wird wirksam, indem auf ein anderes Steuerelement geklickt oder das Fenster 
geschlossen wird. 
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Signalführung 
Im System-Prozessor ist es möglich, ein Signal von jedem der vier Eingänge zu beliebigen oder allen der 
acht Ausgänge zu führen. Damit Signale von den Eingangskanalstreifen zu den Ausgangskanalstreifen 
gelangen, müssen sie durch den Matrixmischer geführt werden. Zum Verbinden der Eingänge mit den 
Ausgängen sind die nachstehend beschriebenen Methoden verfügbar. 

Verbindungen im Signalflussdiagramm herstellen 
Für einfache System-Konfigurationen lassen sich Eingänge am besten mit Ausgängen verbinden, indem die 
Maus im Signalflussdiagramm eingesetzt wird. 

Auf Mischpunkte klicken 
1. Auf einen Eingangsmischpunkt klicken. 

2. Der Cursor ändert sich, was bedeutet, dass jetzt eine Ausgangsverbindung bestimmt werden 
muss. 

3. Auf einen Ausgangsmischpunkt klicken. 

Tipp! Nach dem Klicken auf einen Eingangsmischpunkt kann die Verbindung mit der Taste 
ESC aufgehoben werden, bevor auf einen Ausgangsmischpunkt geklickt wird. 

Klicken und zwischen Mischpunkten ziehen 
1. Auf einen Eingangsmischpunkt klicken und von dort zu einem Ausgangsmischpunkt ziehen.  

2. Entlang des Signalwegs erscheint eine Verbindungslinie. Sie wechselt zu grün, wenn die 
Verbindung zulässig ist. 

3. Die Maustaste freigeben, um die Verbindung herzustellen. 

Auf Eingangswähler klicken 
1. Auf den nummerierten Eingangswähler eines Ausgangskanals für den zugehörigen 

Eingangskanal klicken. 

2. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mischpunkten und der 
nummerierte Eingangswähler wird markiert.  

Verbindungen im Matrixmischer-Fenster herstellen 
Für komplexere Konfigurationen mit vielen sich kreuzenden Verbindungslinien bietet das Matrixmischer-
Fenster eine präzisere Methode zum Verbinden von Eingängen mit Ausgängen. 

1. Auf den Mischblock für den Ausgang doppelklicken, mit dem die Verbindung hergestellt werden 
soll. 

2. An der linken Seite des Matrixmischer-Fensters auf die Eingangs-Schaltfläche für jeden 
Eingangskanal klicken, der verbunden werden soll. 

3. Eine Verbindungslinie erscheint im Signalflussdiagramm zwischen den Mischpunkten, und der 
nummerierte Eingangswähler wird für jede aktive Verbindung markiert.  

Verbindungen löschen 
�� Auf eine Verbindungslinie klicken und die Taste ENTF drücken.  
�� Auf den Eingangswähler der entsprechenden Verbindung klicken. 

Dadurch wird die Verbindung ausgeschaltet. 
�� Auf eine Verbindungslinie klicken und das durch Klicken mit der rechten Maustaste 

eingeblendete Kontextmenü verwenden. 
�� Zum Wählen mehrerer Verbindungen beim Klicken die Taste STRG gedrückt halten. 
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Ein Preset oder eine Szene-Datei benennen 
Da bis zu 128 verschiedene Presets im System-Prozessor gespeichert werden können, ist es hilfreich, wenn 
sie mit Namen und kurzen Beschreibungen versehen werden. Diese Angaben werden im Informationsfeld in 
der Mitte der Steuerleiste des Hauptfensters angezeigt. 

Der hier eingegebene Name wird sowohl dem Preset beim Speichern der Konfiguration im Gerät als auch 
der Szene-Datei beim Speichern im PC zugewiesen. Die Beschreibung wird außerdem in allen Dialogfeldern 
angezeigt, in denen Presets oder Szene-Dateien aufgelistet werden. Diese Angaben können jederzeit im 
Live-Modus oder Design-Modus geändert werden. 

So wird ein Preset oder eine Szene-Datei benannt: 

1. Einmal mit der linken Maustaste irgendwo im 
Informationsfeld klicken. 

2. Das Dialogfeld „Information“ wird eingeblendet.  

3. Einen Namen mit bis zu 15 Zeichen und eine Beschreibung 
mit maximal 80 Zeichen eingeben. 

4. Auf [OK] klicken. 

5. Das Informationsfeld wird mit diesen Angaben aktualisiert. 

Prozessor-Konfiguration 
Das Arbeiten mit Prozessoren kann auf zwei Ebenen erfolgen: auf der Konfigurationsebene im Signalflussdiagramm 
und im individuellen Parameterfenster jedes einzelnen Prozessors, das durch Doppelklicken auf den Prozessorblock 
aufgerufen wird. Dieser Abschnitt behandelt das Arbeiten mit Prozessoren im Signalflussdiagramm und erläutert die 
Unterschiede zwischen den zwei Hauptkategorien von Prozessoren. 

Prozessortypen 
Im Signalflussdiagramm wird mit zwei Haupttypen von Prozessoren gearbeitet: feste und modulare. Der 
wesentliche Unterschied zwischen diesen beiden Typen besteht darin, dass feste Prozessoren Bestandteile der 
Verstärkungsstruktur des P4800 sind und daher in jeder Signalfluss-Konfiguration vorkommen. Modulare 
Prozessoren sind die Prozessorblöcke, die ausgewählt und gemäß den Anforderungen des gewünschten 
Systems angeordnet werden. 

Feste Prozessoren 
Die Verstärkungs- und Mischblöcke werden als feste Prozessoren angesehen, weil ihre Positionen auf den 
Kanalstreifen permanent sind. Sie können nicht gelöscht, versetzt, kopiert oder eingefügt werden. Sie 
können jedoch verknüpft werden und ihre Einstellungen lassen sich speichern und abrufen. 

Modulare Prozessoren 
Diese Prozessorblöcke werden als modular bezeichnet, weil sie in jeden leeren Steckplatz (außer 
Frequenzweichen und Verteiler) gesetzt und nach Wunsch versetzt, kopiert, eingefügt und gelöscht werden 
können. Jeder Prozessorblock im Signalflussdiagramm arbeitet vollständig unabhängig. Wenn das 
Prozessorparameter-Fenster eines modularen Prozessors geöffnet wird, werden nur die Einstellungen für 
diesen Block geändert, außer unter den nachstehenden Bedingungen. 

�� Der Block bildet die Hälfte eines Stereopaares. 
�� Der Block gehört zu einer verknüpften Gruppe. 

Abbildung 11 - Informationsfeld 

Informationsfeld 

Abbildung 12 - Dialogfeld „Scene Information“ 
(Szene-Informationen)



Erstellen einer Konfiguration 

SHURE System-Prozessor P4800 Software-Bedienungsanleitung Seite 20 von 108 

Prozessoren hinzufügen 
Jeder Kanalstreifen weist eine Reihe von leeren Steckplätzen auf, die jeden der modularen Prozessorblöcke 
aufnehmen können. Mit der Ausnahme von Frequenzweichen und Verteilern bestehen keine 
Einschränkungen, wo Prozessoren im Signalflussdiagramm angeordnet werden oder wie oft ein gegebener 
Prozessor im gleichen Kanalstreifen eingesetzt wird. Leere Steckplätze zwischen Prozessoren haben keine 
Auswirkungen auf den Signalfluss, sodass die Blöcke in den Kanalstreifen nicht unmittelbar nebeneinander 
liegen müssen.  

Wenn Prozessorblöcke anfänglich dem Signalflussdiagramm hinzugefügt werden, weisen sie 
Werksvoreinstellungen auf. Die Einstellungen jedes einzelnen Prozessors können im zugehörigen 
Parameterfenster individuell geändert werden. Die Blöcke behalten ihre Einstellungen bei, wenn sie in einen 
anderen Steckplatz kopiert oder verschoben werden. 

Leere Steckplätze bestücken 
Prozessorblöcke können mit der Prozessor-Toolbox oder durch Menübefehle dem Signalflussdiagramm 
hinzugefügt werden. Diese Methoden werden nachstehend beschrieben. 

Mit der Prozessor-Toolbox 
Ein Prozessorblock kann mit der Maus aus der Prozessor-Toolbox entnommen werden. Der Mauszeiger 
ändert sich, um darauf hinzuweisen, dass der Block durch die nächste Mausaktion in das 
Signalflussdiagramm gesetzt wird. Das Aussehen des Cursors ist von seiner Position abhängig, wie in der 
nachstehenden Tabelle dargestellt. 

 

Position, an der der Prozessor 
angeordnet werden kann 

 

Unzulässige Position für diesen 
Prozessor 

So wird ein Prozessorblock aus der Prozessor-Toolbox hinzugefügt: 
�� Die linke Maustaste klicken und halten, um einen Prozessorblock aus der Prozessor-Toolbox 

zum Signalflussdiagramm zu ziehen. Die Maustaste freigeben, um den Block an der jeweiligen 
Cursorposition anzuordnen. 
- ODER - 

�� Einmal auf einen Prozessorblock in der Prozessor-Toolbox klicken und dann auf den 
vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.  

Tipp! Wenn ein Prozessorblock, nachdem in der Prozessor-Toolbox darauf geklickt wurde, 
doch nicht in das Signalflussdiagramm gesetzt werden soll, kann der Vorgang durch 
Drücken der Taste ESC abgebrochen werden. 

Mit einem Menübefehl 
Es ist möglich, dem Signalflussdiagramm Prozessoren hinzuzufügen, ohne die Prozessor-Toolbox zu öffnen, 
indem das Hauptmenü oder das über Klicken mit der rechten Maustaste zugängliche Kontextmenü 
verwendet wird, wie nachstehend beschrieben. 

So wird ein Prozessorblock über das Menü hinzugefügt: 

1. Durch Klicken einen leeren Steckplatz wählen. 

2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und daraus einen 
Prozessor wählen. 
- ODER - 

3. Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden. 

Ein weiterer Vorteil in der Verwendung eines Menübefehls zum Positionieren von Prozessorblöcken besteht 
darin, dass der gleiche Prozessortyp mit nur einem Menübefehl in mehrere Steckplätze gesetzt werden 
kann. 
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So werden mehrere Prozessorblöcke hinzugefügt: 

1. Durch Gedrückthalten der Taste STRG und Klicken mehrere leere Steckplätze wählen. 

2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und einen 
Prozessor wählen, der dann in jeden gewählten Steckplatz gesetzt wird. 
- ODER - 

3. Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden. 

Stereo-Prozessoren 
Stereo-Prozessoren werden auf ähnliche Wiese wie die anderen modularen Prozessorblöcke in das 
Signalflussdiagramm gesetzt. Jeder der Stereokanäle erscheint jedoch als ein separater Block. Durch 
Doppelklicken auf einen der Blöcke wird das Parameterfenster für beide Kanäle eingeblendet. 

Jeder der folgenden dynamischen Prozessoren kann als Stereopaar fungieren: 
Blockname Beschreibung 

�� ST COMP Stereo-Kompressor 
�� SFT ST COMP Stereo-Kompressor - Soft-Knee-Option 
�� ST LIM Stereo-Limiter 
�� SFT ST LIM Stereo-Limiter - Soft-Knee-Option 

So wird ein Stereo-Prozessorblock aus der Prozessor-Toolbox hinzugefügt: 

1. Auf einen Prozessorblock klicken. 

Wenn ein Stereo-Prozessor aus der Prozessor-Toolbox gewählt wird, sieht der Cursor etwas anders aus 
als für andere Prozessoren, wie in der folgenden Tabelle dargestellt. 

 
Position, an der der erste Kanal des Stereo-
Prozessors angeordnet werden kann 

 
Position, an der der zweite Kanal des Stereo-
Prozessors angeordnet werden kann 

2. Den ersten Kanal des Stereopaars hinzufügen. 
�� Die linke Maustaste klicken und halten, um einen Prozessorblock aus der Prozessor-Toolbox 

zum Signalflussdiagramm zu ziehen. Die Maustaste freigeben, um den ersten Prozessorkanal 
an der jeweiligen Cursorposition anzuordnen. 
- ODER - 

�� Einmal auf einen Prozessorblock in der Prozessor-Toolbox klicken und dann auf den 
vorgesehenen leeren Steckplatz im Signalflussdiagramm klicken.  

3. Der Cursor ändert sich, um darauf hinzuweisen, dass der zweite Kanal des Prozessors 
positioniert werden muss. 

�� Auf den vorgesehenen Steckplatz klicken, um den zweiten Stereokanal hinzuzufügen. 

So wird ein Stereo-Prozessor über das Menü hinzugefügt: 

1. Die Taste STRG gedrückt halten und durch Klicken leere Steckplätze in zwei verschiedenen 
Kanälen wählen. 

2. Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden, und beide Kanäle 
des Stereopaars positionieren. 
- ODER - 

3. Die Option [Processor>Add] (Prozessor>Hinzufügen) in der Hauptmenüleiste verwenden. 
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Frequenzweichen und Verteiler 
Da Frequenzweichen ausschließlich Ausgangsprozessoren sind, können sie auch nur in Ausgangskanalstreifen 
positioniert werden. Sie können wie andere Prozessorblöcke in Ausgangsstreifen hinzugefügt werden, dabei 
muss jedoch folgendes berücksichtigt werden: 

�� Eine Frequenzweiche erstreckt sich nach unten über die angegebene Anzahl von Ausgängen. 
Daher muss ein Kanalstreifen gewählt werden, unter dem noch genügend viele Ausgänge 
vorhanden sind. 

�� Ein Frequenzweichenblock kann nur nebeneinander liegende Ausgänge benutzen. 
�� Frequenzweichen können an keinen Ausgangsstreifen überlappen. 
�� Für alle Ausgänge, die von der Frequenzweiche belegt werden, mit Ausnahme des obersten 

Kanalstreifens verschwinden die Mischpunkte. 
�� Von Ausgängen unter dem obersten Kanalstreifen verschwinden die Prozessor-Steckplätze 

links von der Frequenzweiche. 
�� Für Verteiler gelten die gleichen Auswirkungen auf den Signalfluss und Einschränkungen wie für 

Frequenzweichen. 

Wenn die Konfiguration Frequenzweichen erfordert, sollten sie aufgrund dieser Überlegungen dem 
Signalflussdiagramm hinzugefügt werden, bevor Mischpunkte verbunden und andere Prozessoren den 
Ausgangskanalstreifen hinzugefügt werden. 

Ducker 
Der Ducker sollte nur auf dem Eingangskanalstreifen abgelegt werden, der das Durchsagesignal trägt. Das 
System gestattet nicht das Ablegen eines Duckers auf einem Ausgangsstreifen. 

Prozessoren ersetzen 
Nur jeweils ein Prozessorblock kann einen gegebenen Steckplatz belegen. Um einen vorhandenen Prozessor 
durch einen anderen zu ersetzen, muss zuerst der vorhandene aus dem Steckplatz gelöscht und dann der neue 
Prozessor mit einer der oben beschriebenen Methoden hinzugefügt werden. 

DSP-Ressourcen verwalten 
Obwohl der P4800 über ausreichend Verarbeitungsleistung für viele Anwendungen verfügt, ist es möglich, 
das Signalflussdiagramm mit mehr Prozessorblöcken zu bestücken, als die DSP-(Digital Signal Processing)-
Ressourcen des Geräts handhaben können. In diesem Abschnitt wird in allgemeiner Weise erläutert, wie der 
System-Prozessor die Signalverarbeitungserfordernisse einer Konfiguration verwaltet. Außerdem enthält er 
Ratschläge, wie die DSP-Ressourcen optimal ausgenutzt werden können. 

Ressourcenzuweisung 
Indem ein Prozessorblock auf einen Kanalstreifen gesetzt wird, werden ihm die DSP-Ressourcen zugewiesen, die 
er benötigt, um mit maximaler Kapazität zu arbeiten. Aus diesem Grund werden so viele verschiedene 
Ausführungen der gleichen Prozessorblocktypen bereitgestellt, damit nur der Umfang an Verarbeitung gewählt 
werden kann, der für ein gegebenes Modul benötigt wird. Beim Erstellen einer einfachen Konfiguration ist es nicht 
bedeutsam, wie viel DSP-Kapazität verbraucht wird. Wenn die Konfiguration jedoch komplizierter wird, ist es 
wichtig solche Prozessorblöcke zu verwenden, die nur die minimalen Verarbeitungsressourcen, die für die 
jeweilige Aufgabe benötigt werden, in Anspruch nehmen. 

Wenn beispielsweise ein parametrischer Equalizer mit zehn Bändern auf einen Kanalstreifen gesetzt wird, 
wird dadurch die Verarbeitungsleistung zugewiesen, die von allen zehn Filtern benötigt wird, auch wenn 
tatsächlich nur vier davon eingesetzt werden. In diesem Fall wäre der PEQ5 die optimale Wahl. 

Verzögerungsspeicher 
Der System-Prozessor verfügt über einen Zwischenspeicher für bis zu 20 Sekunden Verzögerungszeit, die 
unter jeder beliebigen Kombination von Verzögerungsprozessoren aufgeteilt werden kann. Wie bei der 
Zuweisung der DSP-Ressourcen wird der Verzögerungsspeicher den Prozessorblöcken gemäß der 
maximalen Verzögerungszeit, die im Blocknamen angegeben ist, zugewiesen.  

Wenn zum Beispiel eine Verzögerung von 45 Millisekunden benötigt wird, ist kein 2-Sekunden-Delay 
erforderlich, weil das 150-ms-Delay vollkommen ausreicht. Auch wenn beide Prozessoren auf den 
gleichen Verzögerungswert eingestellt werden, belegt der DLY 2s volle zwei Sekunden im 
Verzögerungsspeicher. 
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Hinweis: Der Verzögerungsspeicher sollte nicht mit den DSP-Systemressourcen verwechselt werden. 
Jede Verzögerung verbraucht die gleiche DSP-Kapazität unabhängig von der Länge 
ihrer maximalen Verzögerungszeit. 

Belegungsanzeigen 
Diese Anzeigen an der Unterseite des Hauptfensters geben an, wie viel DSP-Ressourcen und 
Verzögerungsspeicher von der jeweiligen Konfiguration verbraucht wird, sodass die Auswahl der 
Prozessoren dementsprechend erfolgen kann. Wenn ein Prozessorblock dem Signalflussdiagramm 
hinzugefügt oder daraus entfernt wird, berechnet die DSP-Anzeige sofort die Systemressourcen, die von der 
neuen Prozessorkonfiguration verbraucht werden, und zeigt diese an. 

Hinweis: Angezeigt wird der Prozentanteil der Gesamtressourcen, die ein Preset verbraucht, und 
nicht die von einzelnen Prozessoren verbrauchten Ressourcen. 

Da der P4800 die digitale Signalverarbeitung mit mehreren Prozessor-Chips durchführt, werden die verfügbaren 
Ressourcen unter Umständen nicht präzise auf der DSP-Anzeige dargestellt. Wenn angezeigt wird, dass 20 % 
verfügbar sind, aber kein Prozessor hinzugefügt werden kann, kann der Grund darin liegen, dass die verfügbaren 
Ressourcen auf mehreren Prozessor-Chips verteilt und nicht zusammenhängend verfügbar sind. Der folgende 
Abschnitt über DSP-Optimierung enthält einige Ratschläge für solche Fälle. 

Hinweis: P4800 Einheiten mit einer Seriennummer, die mit dem Buchstaben N oder höher 
beginnt, ermöglichen die Speicherung jeder beliebigen Szene, die im Design-Modus 
erstellt werden kann. Für ältere Einheiten (aus Seriennummern, die mit L oder M 
beginnen, ersichtlich) sollten Szenen, die gemäß DSP-Anzeige weniger als 87 % 
belegen, verwendbar sein. Da die Ressourcen allerdings über mehrere Prozessorchips 
verteilt sind, stellt die Anzeige die verfügbare Kapazität des digitalen Signalprozessors 
eventuell nicht präzise dar. Es ist möglich, dass ein älteres Gerät eine Szene nicht 
verwenden kann, selbst wenn die DSP-Anzeige weniger als 87 % anzeigt. Dies kann 
vorkommen, wenn Ihre Szene mehrere DFR5-, DFR10- und/oder GEQ30-Blöcke belegt. 
Um sicherzustellen, dass eine Szene für einen P4800 mit einer Seriennummer, die mit L 
oder M beginnt, verwendbar ist, sollten Sie das Gerät anschließen und auf den Live-
Modus schalten. Im Live-Modus sind die in der Prozessor-Toolbox aufgeführten DSP-
Anzeigen- und Prozessorbelegungsprozentsätze skaliert, um die Gerätekapazität genau 
wiederzugeben. 

Ratschläge zur DSP-Optimierung 
Wenn beim Versuch, dem Signalflussdiagramm einen 
Prozessor hinzuzufügen, die in Abbildung 13 dargestellte 
Meldung angezeigt wird, kann die Konfiguration optimiert 
werden, um Ressourcen freizustellen und den Prozessor 
anschließend hinzuzufügen. Es folgen Ratschläge zur 
Optimierung des DSP-Verbrauchs einer Konfiguration. 

�� Prozessorblöcke von einer Seite des Matrixmischers zur 
anderen versetzen, beginnend mit dem Prozessor, der 
den größten Prozentanteil der Systemressourcen belegt 
(siehe Annhang B: auf Seite 102 für Einzelheiten zum 
DSP-Verbrauch der Prozessoren).  

Wenn beispielsweise ein DFR10 an der 
Ausgangsseite des Signalflussdiagramms  
vorhanden ist, diesen zur Eingangsseite und umgekehrt versetzen. 

�� Mehrere Equalizer im gleichen Signalweg nach Möglichkeit zu einem Modul zusammenfassen. 

Zum Beispiel verbrauchen zwei PEQ3 mehr DSP-Ressourcen als ein PEQ7. Außerdem sind 
alle PEQ auch mit Filtern mit steilflankigen und Kuhschwanz-Charakteristika verfügbar, um die 
DSP-Ressourcen zu schonen. Das einzige besondere Merkmal des CUT/SHELF-Moduls ist die 
24-dB/Okt.-Flanke. Wenn dieses Merkmal nicht benötigt wird, besteht kein Grund, dass der 
Filter mit steilflankigen und der Filter mit Kuhschwanz-Charakteristika in einem separaten Modul 
von einem anderen PEQ im gleichen Signalpfad vorhanden sind. 

Abbildung 13 - Meldung über DSP-Ressourcen
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�� Mehrere Delays im gleichen Signalweg nach Möglichkeit zu einem Modul zusammenfassen. 

Obwohl durch die Verwendung von zwei DLY5ms, wenn sieben Millisekunden Verzögerung 
benötigt werden, Verzögerungsspeicher eingespart wird, wird doppelt soviel DSP-Kapazität 
als bei Verwendung eines DLY150ms verbraucht. 

�� Nach Möglichkeit Prozessoren an der Eingangsseite des Matrixmischers und nicht an der 
Ausgangsseite hinzufügen. 

�� Prozessoren von nicht benutzten Kanälen entfernen. 

�� Verteiler benutzen, um identische Signalverarbeitung in mehreren Ausgangskanälen 
zusammenzufassen. 

�� Einen PEQ10 anstelle eines GEQ30 benutzen. In den meisten Fällen werden nicht alle dreißig Filter 
verwendet, und der PEQ10 verbraucht weniger als die halbe DSP-Kapazität. 

�� DFR durch parametrische EQ ersetzen, nachdem Rückkopplungen aus dem System entfernt wurden. 

Wenn beispielsweise in einer Konfiguration mehrere DFR in mehreren Eingängen für eine bessere 
Verstärkungsleistung vor dem Rückkopplungseinsatz benötigt werden, könnte anfänglich in jedem 
Eingang ein DFR verwendet werden, um Rückkopplungen zu vermeiden. Nach dem Anwenden der 
Filter die DFR-Filter kopieren und in einen PEQ einfügen, dann den DRF löschen. Dieser Vorgang 
kann für jeden Eingang durchgeführt werden, sodass zuletzt nur ein DFR im kritischsten 
Lautsprecherausgang für automatische Erkennung von Rückkopplung verbleibt. 

Hinweis: Es ist möglich, dass in der DSP-Anzeige nach der Optimierung der Konfiguration keine 
Änderung ersichtlich ist, weil der Gesamtanteil der verfügbaren Kapazität gleich 
geblieben ist. Die Ressourcen wurden lediglich umgeschichtet, sodass sie besser 
ausgenutzt werden können. 

Kopieren und Einfügen 
Die herkömmlichen Befehle für Kopieren, Ausschneiden und Einfügen funktionieren nur bei den modularen 
Prozessorblöcken. Damit bieten sie eine praktische Möglichkeit zum Duplizieren von Prozessorblöcken 
mitsamt ihren Einstellungen in andere Kanäle. 

So wird ein Prozessorblock kopiert und eingefügt: 

1. Einen Prozessorblock durch einmaliges Klicken mit der linken Maustaste wählen. 

2. Den Kopierbefehl mit einer der folgenden Methoden wählen. 
�� Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden. 
�� [Edit>Copy] (Bearbeiten>Kopieren) aus dem Hauptmenü wählen. 
�� STRG+C auf der Tastatur betätigen. 

3. Einen leeren Steckplatz wählen. 

4. Den Einfügbefehl mit einem der Menüs oder STRG+V wählen. 

Hinweis: Dieses Befehle funktionieren nicht bei Mehrfachwahl.  

Aus Steckplätzen löschen 
Modulare Prozessorblöcke lassen sich auf einfache Weise aus einer Konfiguration entfernen, ohne andere 
Bereiche des Signalflusses zu beeinträchtigen.  

So wird ein Prozessorblock gelöscht: 

1. Den Prozessorblock durch einmaliges Klicken mit der linken Maustaste wählen. 

2. Den Löschbefehl mit einer der folgenden Methoden wählen. 
�� Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden. 
�� [Edit>Delete] (Bearbeiten>Löschen) aus dem Hauptmenü wählen. 
�� Die Taste ENTF drücken. 
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Verknüpfungen 
Mehrere Prozessorblöcke des gleichen Typs können miteinander verknüpft werden, um sie gemeinsam zu 
steuern. Änderungen, die im Prozessorparameter-Fenster eines beliebigen Blocks einer Verknüpfungsgruppe 
vorgenommen werden, ändern gleichzeitig die Einstellungen jedes anderen Blocks in dieser Gruppe. Es gibt 
jedoch einige Aktionen, die auch in verknüpften Blöcken unabhängig funktionieren. 

�� Löschen, Kopieren, Ausschneiden und Einfügen 
�� Verschieben eines Blocks zu einem anderen Steckplatz oder Kanalstreifen 
�� Benennen des Prozessorparameter-Fensters 

Feste Prozessoren in der gleichen Stufe der Verstärkungsstruktur lassen sich auch zu einer Gruppe 
zusammenfassen, wodurch die Pegelsteller der gruppierten Kanäle synchronisiert werden. Beispielsweise können 
zwei Eingangskanal-Verstärkungsblöcke zu einer Gruppe zusammengefasst werden, um sie als Stereopaar zu 
steuern. Es ist auch möglich, alle Ausgangs-Verstärkungsblöcke zu verknüpfen, um die Pegel der 
Ausgangskanäle zusammen von einem Steller zu steuern. 

Hinweis: Nur Prozessoren des exakt gleichen Typs können miteinander verknüpft werden. 

Eine verknüpfte Gruppe erstellen 
Beim Erstellen einer Verknüpfungsgruppe werden alle Prozessoren in der Gruppe auf die gleichen 
Einstellungen synchronisiert. Wurden vor dem Erstellen der verknüpften Gruppe bereits Einstellungen für 
einen der Prozessoren spezifiziert, kann dieser Prozessor beim Verknüpfen als Quelle vorgegeben werden, 
sodass diese Einstellungen auf die anderen Prozessorblöcke „vererbt“ werden. Sollen dagegen frühere 
Prozessor-Einstellungen wegfallen, können die Werksvoreinstellungen als anfängliche Quelle gewählt 
werden. Nach dem Erstellen der Verknüpfungsgruppe wirken sich Änderungen der Einstellungen in einem 
der verknüpften Blöcke auf alle anderen Blöcke der gleichen Gruppe aus. 

So wird eine verknüpfte Gruppe erstellt: 

1. Durch Gedrückthalten der Taste STRG und Klicken 
mehrere Prozessorblöcke wählen. 

2. [Processor >Link>New Link Group] 
(Prozessor>Verknüpfen>Neue Verknüpfungsgruppe) aus 
dem Hauptmenü oder [Link>New Link Group] 
(Verknüpfen>Neue Verknüpfungsgruppe) aus dem durch 
Klicken mit der rechten Maustaste eingeblendeten 
Kontextmenü wählen. 

3. Das Dialogfeld „Create Link Group“ 
(Verknüpfungsgruppe erstellen) wird eingeblendet. 

4. Einen aus zwei Zeichen bestehenden Namen für die 
Verknüpfungsgruppe eingeben. 

5. Eine Quelle für die anfänglichen Einstellung der 
Verknüpfungsgruppe wählen. 

6. Auf [OK] klicken, um die Einstellungen zu bestätigen. 

Der aus zwei Zeichen bestehende Name der Verknüpfungsgruppe erscheint sowohl im Prozessorblock im 
Signalflussdiagramm als auch in der Verknüpfungsanzeige unten rechts im Prozessorparameter-Fenster, wie 
in der nachstehenden Tabelle dargestellt. 

Prozessorparameter-Fenster Signalflussdiagramm 

  

Hinweis: Prozessoren können jeweils nur zu einer Verknüpfungsgruppe gehören. 

Abbildung 14 - Dialogfeld „Link Group“ 
(Verknüpfungsgruppe) 
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Zu einer Verknüpfungsgruppe hinzufügen 
Prozessorblöcke können einer bestehenden Verknüpfungsgruppe hinzugefügt werden, wenn sie von genau 
dem gleichen Typ und mit keiner anderen Gruppe verknüpft sind. Jeder Prozessor, der einer 
Verknüpfungsgruppe hinzugefügt wird, erhält die jeweiligen Einstellungen der Gruppe. 

So werden Blöcke einer bestehenden 
Verknüpfungsgruppe hinzugefügt: 

1. Durch Klicken einen Prozessorblock wählen oder mit 
STRG+Klicken mehrere Blöcke wählen. 

2. [Processor >Link>Add To] 
(Prozessor>Verknüpfen>Hinzufügen) aus dem 
Hauptmenü oder [Link>Add To] 
(Verknüpfen>Hinzufügen) aus dem durch Klicken mit der 
rechten Maustaste eingeblendeten Kontextmenü wählen. 

3. Das Dialogfeld „Add to Link group“ (Zur 
Verknüpfungsgruppe hinzufügen) wird eingeblendet. Dort 
werden nur die Verknüpfungsgruppen aufgelistet, die den 
gleichen Prozessortyp wie der gewählte Block enthalten. 

4. Eine Verknüpfungsgruppe wählen. 

5. Auf [OK] klicken. 

Verknüpfung von Prozessorblöcken aufheben 
Prozessorblöcke können ohne Auswirkungen auf die anderen verknüpften Blöcke aus einer 
Verknüpfungsgruppe entfernt werden. Es ist auch möglich, eine Verknüpfungsgruppe aufzulösen, indem die 
Verknüpfung aller Blöcke in der Gruppe aufgehoben wird.  

So werden Blöcke aus einer bestehenden Verknüpfungsgruppe entfernt: 

1. Durch Klicken einen Prozessorblock wählen oder mit STRG+Klicken mehrere Blöcke wählen. 

2. [Processor>Link>Unlink] (Prozessor>Verknüpfen>Verknüpfung aufheben) aus dem Hauptmenü 
oder aus dem durch Klicken mit der rechten Maustaste eingeblendeten Kontextmenü wählen. 

Hinweis: Eine Verknüpfungsgruppe muss mindestens zwei Prozessorblöcke enthalten. Wenn alle 
Blöcke bis auf einen aus einer Verknüpfungsgruppe entfernt werden, wird die Gruppe 
dadurch vollständig aufgelöst. 

Umgehen 
Jeder modulare Prozessorblock kann im Hauptfenster 
umgangen werden. Dadurch ist es möglich, den Signalweg 
zu überprüfen, während ein bestimmter Prozessor 
vorübergehend herausgenommen wird. Umgangene 
Blöcke werden im Signalflussdiagramm durch ein gelbes 
Zeichen markiert. 

So wird die Umgehung ein- und ausgeschaltet: 

1. Durch Klicken einen Prozessorblock wählen oder mit 
STRG+Klicken mehrere Blöcke wählen. 

2. Die Umgehung mit einer der folgenden Methoden aktivieren: 
�� STRG+B auf der Tastatur betätigen. 
�� [Processor>Bypass Selected] (Prozessor>Umgehung gewählt) im Hauptmenü wählen. 
�� Mit der rechten Maustaste klicken, um das Kontextmenü einzublenden. 

Hinweis: Frequenzweichen und Verteiler können nicht umgangen werden.  

Abbildung 15 - Dialogfeld „Add to Link Group“ 
(Zur Verknüpfungsgruppe hinzufügen) 

Abbildung 16 - Umgangener Prozessorblock 

Umgangener Block 
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SPEICHERN EINER KONFIGURATION__________________________  
Eine Konfiguration kann nach dem Erstellen im Computer als Szene-Datei oder im P4800, wenn er angeschlossen 
ist, als Preset gespeichert werden. Im Live-Modus wird eine erstellte Konfiguration direkt in das jeweils geöffnete 
Preset geschrieben. Sie kann jederzeit durch Klicken auf die Schaltfläche [Save As] (Speichern unter) in der 
Steuerleiste des Hauptfensters im PC gespeichert werden. 

Szene-Dateien 
Es ist möglich, eine ganze Bibliothek von Signalfluss-Konfigurationen in der System-Prozessor-Software zu erstellen, 
ohne am Gerät angeschlossen zu sein. Konfigurationen, die im PC als Szene-Dateien gespeichert werden, können 
später abgerufen, überarbeitet und als Presets zum Gerät übertragen werden. Szene-Dateien werden mit der 
Dateinamenerweiterung „.scn“ gespeichert. 

Eine neue Szene speichern 
Wenn kein Anschluss zum Gerät besteht, wird jede neue Signalfluss-Konfiguration als Szene-Datei im 
Computer gespeichert.  

So wird eine neue Szene-Datei gespeichert: 

1. Im Hauptfenster [File>Save As Scene File] (Datei>Als Szene-Datei speichern) im Hauptmenü 
wählen oder auf die Schaltfläche [Save As] (Speichern unter) in der Steuerleiste klicken. 

2. Das Dialogfeld „Save Scene As“ (Szene speichern unter) wird eingeblendet. 
3. Zum Laufwerk und Verzeichnis für die neue Datei gehen. 
4. Einen Dateinamen und auf Wunsch eine Beschreibung eingeben. 
5. Auf [Save] (Speichern) klicken. 

Hinweis: Szene-Dateien für andere Shure Digitalsignalprozessor-Geräte wie z.B. DFR11EQ 
oder DP11 verwenden die gleiche Dateinamenerweiterung .SCN. Daher sollten Szene-
Dateien für verschiedene Gerätetypen in separaten Verzeichnissen gespeichert werden.  

Beschreibungsfeld verwenden 
Der optionale Eintrag in das Beschreibungsfeld hilft bei der Identifizierung von Szene-Dateien beim Öffnen. 
Die Beschreibung der Szene-Datei wird beim Speichern der Szene-Datei als Preset im Gerät in die Preset-
Beschreibung kopiert.  

Szene-Dateien überarbeiten 
Wenn in einer bestehenden Szene-Datei Änderungen vorgenommen werden, können diese unter einem 
anderen Dateinamen oder durch Überschreiben der vorherigen Version gespeichert werden. 

So wird eine Szene-Datei überarbeitet: 
1. Im Hauptfenster [File>Open Scene File] (Datei>Szene-Datei öffnen) im Hauptmenü wählen oder 

auf die Schaltfläche [Open] (Öffnen) in der Steuerleiste klicken. 
2. Das Dialogfeld „Open Scene“ (Szene öffnen) wird eingeblendet. 
3. Zum Laufwerk und Verzeichnis der Szene-Datei gehen, die geöffnet werden soll. 
4. Auf die Datei klicken, um sie zu wählen, und dann auf die Schaltfläche [Open] klicken. 
5. Die gewünschten Änderungen vornehmen. 
6. [File>Save As Scene] (Datei>Als Szene speichern) im Hauptmenü wählen oder auf die 

Schaltfläche [Save As] (Speichern unter) in der Steuerleiste klicken. 
7. Das Dialogfeld „Save Scene As“ (Szene speichern unter) wird eingeblendet. 
8. Auf den ursprünglichen Dateinamen klicken, um ihn zu wählen, und dann auf [Save] (Speichern) 

klicken. 
9. Ein eingeblendetes Dialogfeld fordert zur Bestätigung auf, dass die vorherige Szene-Datei 

überschrieben werden soll. 
10. Auf [Yes] (Ja) klicken, um die Datei zu überschreiben. 
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Preset-Verwaltung 
Der System-Prozessor kann mindestens 16 und, abhängig von ihrer Komplexität, bis zu 128 Presets in seinem 
Speicher unterbringen. Im Gerät gespeicherte Presets können umbenannt, gelöscht oder zusammen gesichert 
werden. 

Ein Preset im Gerät speichern 
Wenn der Anschluss zum Gerät besteht, können im Design-Modus neue Signalfluss-Konfigurationen im 
Gerät als Presets gespeichert oder vorhandene Szene-Dateien geöffnet und im Gerät gespeichert werden. 

So wird ein Preset im Gerät gespeichert: 

1. Im Hauptfenster [File>Store As Preset] (Datei>Als 
Preset speichern) im Hauptmenü wählen oder im 
Design-Modus auf die Schaltfläche [Store Preset] 
(Preset speichern) in der Steuerleiste klicken. 

2. Das Dialogfeld „Select Devices“ (Geräte wählen) wird 
eingeblendet. 

3. Die Wahl aus der Liste der verfügbaren Geräte 
vornehmen und auf [Connect] (Verbinden) klicken. 

 
 

 

 

 

4. Das Dialogfeld „Store Preset“ 
wird eingeblendet. 

4. Einen Preset-Namen von bis zu 
fünfzehn Zeichen eingeben. 

5. Eine Preset-Nummer eingeben 
oder die Voreinstellung 
verwenden. 

6. Eine Beschreibung eingeben, 
falls gewünscht, um den Inhalt 
des Presets bei 
anschließenden Einstellungen 
besser identifizieren zu können. 

7. Auf [Store] (Speichern) klicken.   

 

 

Abbildung 17 - Dialogfeld „Select Devices“  
(Geräte wählen) 

Abbildung 18 - Dialogfeld „Store Preset“ 
(Preset speichern) 
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Ein Preset umbenennen 
Nachdem ein Preset im Gerät gespeichert wurde, können sein Name und seine Beschreibung im 
Live-Modus geändert werden. 

So wird ein Preset umbenannt: 

1. Auf die Schaltfläche [Live Mode] in der Steuerleiste klicken. 

2. Das Preset, das umbenannt werden soll, aus dem 
Pulldown-Menü im Informationsfeld in der Steuerleiste 
wählen. 

3. Das Hauptfenster schaltet in den Vorschau-Modus für das 
gewählte Preset. 

4. Auf die Schaltfläche [Load] (Laden) in der Steuerleiste 
klicken, um das Preset in den Live-Modus zu holen. 

5. Einmal irgendwo im Informationsfeld klicken. 

6. Das Dialogfeld „Rename Preset“ (Preset umbenennen) 
wird eingeblendet. 

7. Den neuen Namen und/oder die neue Beschreibung eingeben. 

8. Auf [OK] klicken. 

Ein Preset löschen 
Im Design-Modus können Presets, die nicht 
mehr benötigt werden, aus dem Gerät gelöscht 
werden. 

So wird ein Preset gelöscht: 

1. Auf die Schaltfläche [Design Mode] in der 
Steuerleiste klicken. 

2. [File>Delete Preset] (Datei>Preset löschen) 
wählen. 

3. Das Dialogfeld „Select Devices“ (Geräte 
wählen) wird eingeblendet. 

4. Die Wahl aus der Liste der verfügbaren 
Geräte vornehmen und auf [Connect] 
(Verbinden) klicken. 

5. Das Dialogfeld „Delete Preset“ (Preset 
löschen) wird eingeblendet. 

6. Das Preset wählen, das gelöscht werden 
soll, oder mit UMSCHALTTASTE+Klicken 
mehrere Presets wählen. 

7. Auf [Delete] (Löschen) klicken. 

 

 

Hinweis: Das jeweils geöffnete Preset kann nicht gelöscht werden. Um dieses Preset zu löschen, 
muss vorher ein anderes Preset geöffnet werden. 

Abbildung 19 - Dialogfeld „Rename Preset“
(Preset umbenennen) 

Abbildung 20 - Dialogfeld „Delete Preset“ (Preset löschen) 
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Datensicherung 
Alle im Gerät gespeicherten Presets können in einer einzelnen Archivierungsdatei gesichert und später wieder 
hergestellt werden. Datensicherung und Wiederherstellung sind nur im Design-Modus möglich. 

So werden alle Presets im Gerät gesichert: 

1. Auf die Schaltfläche [Design Mode] in der 
Steuerleiste klicken. 

2. [File>Backup Device] (Datei>Geräte-
Datensicherung) aus dem Hauptmenü wählen. 

3. Das Dialogfeld „Select Devices“ (Geräte wählen) 
wird eingeblendet. 

4. Die Wahl aus der Liste der verfügbaren Geräte 
vornehmen und auf [Connect] (Verbinden) klicken. 

5. Das Dialogfeld „Backup Devices“ (Geräte-
Datensicherung) wird eingeblendet. 

6. Auf [Backup Device] (Geräte-Datensicherung) 
klicken. 

7. Das Dialogfeld „Save Backup As“ (Datensicherung 
speichern unter) wird eingeblendet, wie unten 
rechts in Abbildung 22 dargestellt. 

8. Zum gewünschten Verzeichnis gehen und einen 
Dateinamen eingeben. 

9. Auf [Save] (Speichern) klicken. 

So werden gesicherte Daten im Gerät wiederhergestellt: 

1. [File>Restore Device] (Datei>Geräte-Datensicherung 
wiederherstellen) aus dem Hauptmenü wählen. 

2. Das Dialogfeld „Open Backup“ (Datensicherung öffnen) 
ähnlich dem Dialogfeld „Save Backup“, das rechts in 
Abbildung 22 dargestellt ist, wird eingeblendet. 

3. Zum entsprechenden Verzeichnis gehen und die 
richtige Sicherungsdatei aus der Liste wählen. 

4. Auf [Open] (Öffnen) klicken. 

5. Das Dialogfeld „Select Devices“ (Geräte wählen) wird 
eingeblendet. 

6. Die Wahl aus der Liste der verfügbaren Geräte 
vornehmen und auf [Connect] (Verbinden) klicken. Die 
gesicherten Daten werden zurück zum Gerät 
übertragen. 

 

Abbildung 21 - Dialogfeld „Backup Device“ 
(Geräte-Datensicherung) 

Abbildung 22 - Dialogfeld „Save Backup As“ 
(Datensicherung speichern unter) 
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Abbildung 23 - Standard-
Steuerelemente

Faderstreifen 

Faderknopf

Drehpfeil-Schaltflächen  

 Wertefeld 

PROZESSORFUNKTIONEN___________________________________  
In diesem Abschnitt werden Softwarefunktionen beschrieben, die in vielen der Prozessorparameter-Fenster enthalten 
sind. Für die Funktionen von einzelnen Prozessoren siehe den Abschnitt Feste Prozessoren auf Seite 34 und den 
Abschnitt Modulare Prozessoren auf Seite 40. 

Fader 
Fader sind in vielen Prozessor-Fenstern wie in dem Beispielsfenster in Abbildung 23 enthalten. Fader gestatten die 
Verstärkungseinstellung durch eine Auf- oder Abwärtsbewegung der Maus in der gleichen Weise, wie Fader an 
einem wirklichen Mischer betätigt werden. Es ist auch möglich, den Pegel numerisch anzugeben, indem ein Wert in 
das Feld eingegeben wird. Zuerst den Fader wählen und dann den Pegel mit einer der nachstehend beschriebenen 
Methoden einstellen. 

Wählen 
Ein Fader wird gewählt, indem der Mauscursor über den Faderknopf gebracht und darauf mit der linken 
Maustaste geklickt oder indem im Wertefeld unter dem Faderstreifen geklickt wird. Der Faderknopf wird 
markiert, um darauf hinzuweisen, dass er gewählt wurde. Wenn das 
Fenster mehrere Fader enthält, kann mit TAB von links nach rechts 
und mit UMSCHALTTASTE+TAB in entgegengesetzter Richtung 
zwischen ihnen gewechselt werden. 

 
Faderknopf gewählt 

 
Faderknopf nicht gewählt 

Pegel einstellen 
So wird der Pegel mit der Maus eingestellt: 
�� Auf den Faderknopf klicken und die Maustaste 

gedrückt halten, um ihn nach oben oder unten zu ziehen. 
�� Auf den Faderstreifen an dem Pegel klicken, der eingestellt 

 werden soll.  
�� Mit der rechten Maustaste auf den Faderknopf klicken, um den  

Pegel auf 0 dB einzustellen. 

So wird der Pegel mit einzelnen Tasten eingestellt: 

1. Den Fader wählen, der eingestellt werden soll.  

2. Den Wert mit einer der folgenden Tasten einstellen.  

Taste Ergebnis 
Nach-Oben-Taste Erhöhung um 0,5 dB 
Nach-Unten-Taste Absenkung um 0,5 dB 
Bild-Auf-Taste Erhöhung um 3 dB 
Bild-Ab-Taste Absenkung um 3 dB 
Leerzeichentaste Stellt den Wert auf 0 dB 

Wertefeld 
Im Wertefeld kann der Wert auf Zehntel-Dezibel angegeben werden. Zu allen Fadern gehört ein Wertefeld. In 
den meisten Prozessor-Fenstern sind die Wertefelder direkt unter den Fadern angeordnet. Die beiden 
Ausnahmen sind die GEQ10- und GEQ30-Fenster, die nur ein Verstärkungswert-Feld für die gesamte 
Fadergruppe aufweisen. In diesen Fenstern zuerst den Knopf des Faders wählen, der eingestellt werden 
soll, und dann einen Wert in das Feld eingeben. 
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Drehpfeil-Schaltflächen 
An der linken Seite aller Wertefelder befinden sich Drehpfeil-Schaltflächen. Damit lassen sich die 
Einstellungen auf einfache Weise ändern, ohne dass ein Wert eingegeben werden muss. 

So wird der Wert mit den Drehpfeil-Schaltflächen verändert: 
�� Auf die Aufwärts- oder Abwärts-Drehpfeil-Schaltfläche klicken, um den Pegel um +/-0,5 dB zu 

ändern. 
�� Auf eine Drehpfeil-Schaltfläche klicken und die Maustaste gedrückt halten, um den Pegel 

kontinuierlich zu erhöhen bzw. zu verringern. Wird die Schaltfläche länger gehalten, erhöht sich 
die Geschwindigkeit der Änderung. 

Einstellungen speichern und abrufen 
Die Einstellungen in jedem Prozessorparameter-Fenster können in einer Computerdatei gespeichert und 
wieder abgerufen werden, wenn irgendwann später eine ähnliche Einstellung für den gleichen Prozessortyp 
benötigt wird. In dieser Weise lassen sich benutzerdefinierte oder installationsspezifische Voreinstellungen für 
häufig verwendete Prozessoren erstellen. Wenn viele Einstellungen im PC gespeichert werden sollen, wird 
empfohlen, ein Verzeichnis ausschließlich für Prozessor-Einstellungen oder für eine bestimmte Installation 
einzurichten. 

So werden Prozessor-Einstellungen gespeichert: 
1. Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden. 
2. [File>Save Settings] (Datei>Einstellungen speichern) aus dem Menü wählen oder STRG+S auf 

der Tastatur drücken. 
3. Einen Dateinamen eingeben. 
4. Auf [Save] (Speichern) klicken. 
5. Die Anwendung fügt eine Dateinamenerweiterung entsprechend dem erstellenden Prozessortyp 

hinzu. 

So werden die Prozessor-Einstellungen abgerufen: 
1. Auf einen Prozessorblock doppelklicken, um sein Prozessorparameter-Fenster einzublenden. 
2. [File>Recall Settings] (Datei>Einstellungen abrufen) aus dem Menü wählen oder STRG+R auf 

der Tastatur drücken. 
3. Die gewünschte Datei mit Einstellungen wählen. 
4. Auf [Open] (Öffnen) klicken. 

Hinweis: Einstellungen können nur für einen Prozessor vom gleichen Typ wie der, von dem die 
Datei mit Einstellungen erstellt wurde, abgerufen werden. 

Prozessorfenster benennen 
Das Parameterfenster jedes modularen Prozessorblocks im Signalflussdiagramm kann mit einem 
eindeutigen Namen versehen werden. Dies ist praktisch, wenn mehrere Fenster gleichzeitig geöffnet sind. 
Die Standardtitel von Prozessorfenstern enthalten sowohl den Namen des allgemeinen Prozessortyps als 
auch die Kennzeichnung des Kanalstreifens, auf den sie gesetzt wurden. 

Um zwischen ähnlichen Prozessoren unterscheiden zu können, kann der Fenstername gemäß den 
besonderen Funktionen oder Einstellungen des Prozessors angepasst werden. Der neue Fenstername 
erscheint sowohl in der Titelleiste des Prozessorparameter-Fensters als auch in der Windows-Taskleiste, 
wenn das Parameterfenster minimiert ist. 

So wird ein Prozessorparameter-Fenster umbenannt: 

1. Auf einen Block doppelklicken, um sein Prozessorparameter-Fenster einzublenden. 

2. [Options>Name] (Optionen>Benennen) im Menü wählen. 

3. Den neuen Namen mit bis zu fünfzehn Zeichen eingeben. 

4. Auf [OK] klicken. 

Hinweis: Hierdurch wird nur der Name des Prozessorparameter-Fensters geändert. Der Titel des 
Prozessorblocks im Signalflussdiagramm ändert sich nicht. 
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Momentaufnahmen 
Die Funktion Momentaufnahme ist in jedem Prozessorparameter-Fenster verfügbar, das eine Frequenzgang-
Kennlinie oder Übertragungs-Kennlinie enthält. Damit kann ein Bild der aktuellen Kennlinie erfasst und zur 
Bezugnahme bei der Überarbeitung der Prozessor-Einstellungen angezeigt werden. Der Prozessor behält diese 
Momentaufnahme, bis eine neue im gleichen Prozessor-Fenster gemacht oder die Anwendung beendet wird. 

Die nachstehenden Beispiele von Frequenzgang-Kennlinien stammen aus dem Parameterfenster eines 
parametrischen Equalizers mit fünf Bändern und Filtern mit steilflankiger und Kuhschwanz-Charakteristik 
(PEQ5+CS). 

So wird die Momentaufnahme-Funktion verwendet: 

1. Auf die Schaltfläche [TAKE] 
(Aufnehmen) klicken. Dadurch wird 
die Frequenzgang-Kennlinie oder 
Übertragungs-Kennlinie 
aufgenommen. 

2. Auf die Schaltfläche [SHOW]  
(Anzeigen) klicken. 
Dadurch wird die 
Momentaufnahme hinter 
der aktuellen Kennlinie 
angezeigt.  

Die Schaltfläche wird grün markiert, wenn die Momentaufnahme angezeigt wird. 

Abbildung 25 - Ändern der Frequenzgang-Kennlinie 

3. Die Prozessor-Einstellungen 
ändern. Während die 
Kennlinie verändert wird, 
kann sie mit der 
Momentaufnahme der 
vorherigen Kennlinie, die im 
Hintergrund angezeigt wird, 
verglichen werden. 

4. Erneut auf die 
Schaltfläche [SHOW] 
klicken, um die 
Momentaufnahme 
aus- und einzublenden 

Abbildung 26 - Ausblenden der Momentaufnahme

Abbildung 24 - Erstellen einer Momentaufnahme

Hinweis :  Wenn die Momentaufnahme angezeigt wird, bevor Prozessor-Einstellungen geändert wurden, 
ist sie hinter der aktuellen Kennlinie versteckt. Die Momentaufnahme wird sichtbar, sobald die 
Kennlinie durch andere Einstellungen verändert wird. 
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FESTE PROZESSOREN______________________________________  
Diese Prozessoren bilden die drei verschiedenen Stufen der Verstärkungsstruktur des System-Prozessors (siehe 
Seite 16 für weitere Informationen zu diesem Thema). Sie werden als feste Prozessoren bezeichnet, weil die 
Verstärkungs- und Mischblöcke im Signalflussdiagramm nicht verschoben oder gelöscht werden können. 

Eingangsverstärkung 
Der Eingangsverstärkungs-Prozessor enthält einzelne Steller für alle vier Eingangskanäle. Auf den 
Verstärkungsblock am linken Ende eines Eingangskanalstreifens doppelklicken, um dieses Fenster zu öffnen. 

Skalierung 

Diese Schaltflächen dienen zum Skalieren der einzelnen Eingangskanäle zur Anpassung an den 
Ausgangspegel des Geräts vor dem System-Prozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu 
gewechselt werden. Die Voreinstellung ist +4 dBu. 

 
+4 dBu gewählt 

 
-10 dBV gewählt 

Signalpolarität 
Auf diese Schaltfläche klicken, um die Polarität des Signals, das am Eingangskanalstreifen anliegt, 
umzukehren. Die Voreinstellung ist normale Polarität. 

 Normale Polarität 

 Umgekehrte Polarität 

Pegelsteller 
Mit diesen Stellern wird der Signalpegel für jeden Eingangskanal eingestellt. Zuerst den Faderknopf wählen, 
dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen. 
Für umfassende Anweisungen für diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der 
Einstellbereich reicht von +30 dB bis -30 dB, und die Voreinstellung ist 0 dB oder Arbeitspegel. 

                             Skalierung 

Signalpolarität

Pegelsteller

Kanalstummschaltung

Kanal-Kennzeichnung

Verknüpfungsanzeige
Abbildung 27 - Fenster „Input Gain“ (Eingangsverstärkung) 
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Hinweis: Die Eingangspegelsteller regeln den Pegel des Signals, nachdem es bereits im System-
Prozessor digital umgewandelt wurde. Signalpegel, die die Eingangsschwelle des 
System-Prozessors überschreiten, müssen extern eingestellt werden.  

Kanalstummschaltung 
Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv. 

 
Stummschaltung aktiv 

 
Stummschaltung inaktiv 

Kanal-Kennzeichnung 
Dieses Textfeld dient zur benutzerdefinierten Einstellung der Eingangskanalstreifen-Kennzeichnung im 
Signalflussdiagramm. Die Voreinstellung ist „Untitled In“ (Unbenannt Ein) für jede Eingangskanalnummer. 

Verknüpfungsanzeige 
Hier wird der Verknüpfungszustand des Eingangskanals angezeigt. Jede Einstellung, die in einen 
verknüpften Kanal geändert wird, wird für alle Kanäle in der gleichen Verknüpfungsgruppe geändert. Für eine 
umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe den Abschnitt Verknüpfungen 
auf Seite 25. 

 Kanal verknüpft 

 Kanal nicht verknüpft 
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Matrixmischer 
Der Matrixmischer-Prozessor enthält Bedienelemente für Mischpunkt-Verbindungen im Signalflussdiagramm, die 
unter separaten Registerkarten im Fenster für jeden Ausgangsmischpunkt angeordnet sind. Auf einen beliebigen 
Mischblock doppelklicken, um dieses Fenster einzublenden. 

 

Fenster-Registerkarten 
Das Fenster wird mit dem Ausgangs-Fensterabschnitt für den 
Mischblock, auf den doppelgeklickt wurde, eingeblendet. Auf 
eine andere Registerkarte klicken, um auf die Bedienelemente 
für einen anderen Ausgangsmischpunkt zuzugreifen. 

Die Fenster-Registerkarten entsprechen den 
Ausgangsmischpunkten im Signalflussdiagramm. 
Wenn Frequenzweichen in der Konfiguration 
verwendet werden, entsprechen die 
Registerkarten-Titel dem Bereich der 
Ausgangsstreifen, über die sich die 
einzelnen Frequenzweichen erstrecken. 

 

 Skalierung

 Signalpolarität

Pegelsteller

Kanalstummschaltung

Kanal-Kennzeichnung

Verknüpfungs-
anzeige 

Ausgangs-
Fensterabschnitt 

Titel des 
Fensterabschnitts 

Fenster-Registerkarten 

Eingangssteller Ausgangs-
steller 

Abbildung 28 - Fenster „Matrix Mixer“ (Matrixmischer) 

Abbildung 29 - Mixer-Registerkarten mit Frequenzweichen 
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Eingangssteller 
Auf diese Schaltfläche klicken, um eine Verbindung für den zugehörigen Eingangskanal-Mischpunkt zu 
aktivieren. Bedienelemente für inaktive Eingänge werden abgeblendet angezeigt. Die Voreinstellung ist inaktiv. 

Eingangswähler 
Auf diese Schaltfläche klicken, um eine Verbindung für den zugehörigen Eingangskanal-Mischpunkt zu 
aktivieren. Bedienelemente für inaktive Eingänge werden abgeblendet angezeigt. Die Voreinstellung ist inaktiv. 

 Verbindung aktiviert 

 Verbindung inaktiv 

Signalpolarität 
Auf diese Schaltfläche klicken, um die Polarität des Signals umzukehren. Die Voreinstellung ist normale 
Polarität. 

 Normale Polarität 

 Umgekehrte Polarität 

Pegelsteller 
Mit diesen Stellern wird der Signalpegel für jeden Kanal eingestellt. Zuerst den Faderknopf wählen, dann den 
Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen. Für 
umfassende Anweisungen für diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der Einstellbereich 
reicht von +10 dB bis - unendlich dB, und die Voreinstellung ist 0 dB oder Arbeitspegel. 

Kanalstummschaltung 
Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv. 

 
Stummschaltung aktiv 

 
Stummschaltung inaktiv 

Kanal-Kennzeichnung 
Hier wird die Kanal-Kennzeichnung angezeigt, die im Eingangsverstärkungs- oder Ausgangsverstärkungs-
Fenster angegeben wurde. 

Verknüpfungsanzeige 
Hier wird der Verknüpfungszustand des Ausgangsstellers der jeweiligen Fenster-Registerkarte angezeigt. 
Jede Einstellung, die an einem verknüpften Ausgangssteller geändert wird, ändert sich auch bei allen 
anderen Mischerausgängen in der gleichen Verknüpfungsgruppe. Beim Wechseln der Fenster-
Registerkarten ändert sich die Anzeige entsprechend dem Verknüpfungszustand der jeweiligen 
Registerkarte. Für eine umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe den 
Abschnitt Verknüpfungen auf Seite 25. 

Hinweis: Wenn Mischblöcke miteinander verknüpft werden, werden lediglich die Ausgangssteller 
vom Matrixmischer verknüpft. Die Eingangssteller bleiben unabhängig. 
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Ausgangsverstärkung 
Der Ausgangsverstärkungs-Prozessor enthält einzelne Steller für alle acht Ausgangskanäle. Auf den 
Verstärkungsblock am rechten Ende eines Ausgangskanalstreifens doppelklicken, um dieses Fenster zu öffnen. 

 

Skalierung 
Diese Schaltflächen dienen zum Skalieren der einzelnen Eingangskanäle zur Anpassung an den 
Ausgangspegel des Geräts vor dem System-Prozessor. Durch Klicken kann zwischen -10 dBV und +4 dBu 
gewechselt werden. Die Voreinstellung ist +4 dBu. 

 
+4 dBu gewählt 

 
-10 dBV gewählt 

Signalpolarität 
Auf diese Schaltfläche klicken, um die Polarität des Ausgangssignals umzukehren. Die Voreinstellung ist 
normale Polarität. 

 
Normale Polarität 

 
Umgekehrte Polarität 

 

Skalierung

Signalpolarität

Kanalstummschaltung

Kanal-Kennzeichnung 

Verknüpfungsanzeige

 Ausgangs-
Dämpfungsglied

Pegelsteller

Abbildung 30 - Fenster „Output Gain“ (Ausgangsverstärkung) 
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Pegelsteller 
Mit diesen Stellern wird der Signalpegel für jeden Ausgangskanal eingestellt. Zuerst den Faderknopf wählen, 
dann den Pegel mit der Maus, den Pfeiltasten oder durch Eingabe eines Werts in das Wertefeld einstellen. 
Für umfassende Anweisungen für diese Bedienung siehe den Abschnitt Fader auf Seite 31. Der 
Einstellbereich reicht von +30 dB bis -30 dB, und die Voreinstellung ist 0 dB oder Arbeitspegel. 

Ausgangs-Dämpfungsglied 
Auf diese Schaltfläche klicken, um den Signalausgang um -20 dB zu dämpfen. Die Voreinstellung ist inaktiv. 

 
Dämpfungsglied aktiv 

 
Dämpfungsglied inaktiv 

Kanalstummschaltung 
Auf diese Schaltfläche klicken, um den Kanal stumm zu schalten. Die Voreinstellung ist inaktiv. 

 
Stummschaltung aktiv 

 
Stummschaltung inaktiv 

Kanal-Kennzeichnung 
Dieses Textfeld dient zur benutzerdefinierten Einstellung der Ausgangskanalstreifen-Kennzeichnung im 
Signalflussdiagramm. Die Voreinstellung ist „Untitled Out“ (Unbenannt Aus) für jede Ausgangskanalnummer. 

Verknüpfungsanzeige 
Hier wird der Verknüpfungszustand des Ausgangskanals angezeigt. Jede Einstellung, die in einen 
verknüpften Kanal geändert wird, wird für alle Kanäle in der gleichen Verknüpfungsgruppe geändert. Für eine 
umfassende Erläuterung von Verknüpfung und Verknüpfungsgruppen siehe den Abschnitt Verknüpfungen 
auf Seite 25. 

 Kanal verknüpft 

 Kanal nicht verknüpft 
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MODULARE PROZESSOREN _________________________________  
In diesem Abschnitt werden die Funktionen und Bedienelemente der einzelnen Prozessorblockparameter-Fenster 
beschrieben. In einigen Fällen weisen mehrere Prozessorblöcke fast gleiche Bedienelemente auf, zum Beispiel der 
Abwärts-Expander und das Gate. In diesen Fällen werden die Prozessoren als Gruppe mit nur einem 
Parameterfenster zur Veranschaulichung beschrieben. Bedienelement-Einstellungen, die nur bei einem der 
Prozessoren in der Gruppe vorkommen, werden in der Beschreibung solcher Bedienelemente entsprechend 
angemerkt. 

Automatische Verstärkungsregelung/Leveler (AGC) 
Der AGC/Leveler bewirkt einen mehr gleichbleibenden Lautstärkepegel für Programmmaterial, das lauter und leiser 
wird. Er wirkt als Kombination aus Aufwärts-Expander und Kompressor, indem er die Verstärkung des 
Eingangssignals erhöht, wenn der Pegel zu niedrig ist, und sie reduziert, wenn der Pegel zu hoch ist.  

Blockname Beschreibung 
�� AGC Automatische Verstärkungsregelung 
 

Funktion 
Der Leveler kann in Situationen verwendet werden, in denen die Aufrechterhaltung eines konstanten 
Lautstärkepegels erwünscht ist, wie zum Beispiel für Podium- und Lesepult-Mikrofone, bei denen sich der 
Abstand des Sprechers zum Mikrofon ändert. Der Leveler gleicht niedrige Pegel aus, indem er die 
Verstärkung langsam erhöht. Wenn der Sprecher lauter in das Mikrofon spricht, verringert die AGC 
allmählich die Verstärkung. 

Merkmale des Parameterfensters 
Übertragungskennlinie 
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als 
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende 
Übertragungskennlinie repräsentiert die Änderung im Signalausgangspegel. 

Abbildung 31 - AGC-Fenster 

Pegelsteller  Übertragungskennlinie

Linie der maximalen 
Verstärkung

Schwellwert-Schieberegler  
Verstärkungsreduzierungs-
Anzeige 

Übertragungskennlinien-Anzeige Angelpunkt-Schieberegler 

Kompressionsgrad-Schieberegler
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Linie der maximalen Verstärkung 
Der größte Betrag, um den die AGC das Signal anhebt, ist +12 dB, wie durch die Linie der maximalen 
Verstärkung gekennzeichnet. Dadurch werden Probleme durch unerwünschte Störungsmodulationen und 
akustische Rückkopplung vermieden, die durch übermäßige Anhebung von niedrigpegeligen Signalen 
entstehen können. Die Linie der maximalen Verstärkung erscheint nur in der Übertragungskennlinie, wenn 
die Kombination von Schwellwert-, Angelpunkt- und Verhältnis-Einstellungen in der AGC die +12-dB-Grenze 
bedrängt. 

Übertragungskennlinien-Anzeige 
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass 
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann 
mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige) aus- und 
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet. 

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung 
der Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die 
Verstärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] 
ausgeschaltet werden. 

Schwellwert-Schieberegler 
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser 
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezogen 
werden, um die Schwellwert-Einstellung zu ändern. 

Kompressionsgrad-Schieberegler 
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Übertragungskennlinie kann mit der Maus nach oben 
und unten gezogen werden, um die Kompressionsgrad-Einstellung zu ändern. 

Angelpunkt-Schieberegler 
Die Position des Angelpunkt-Schiebereglers entspricht der Einstellung der Angelpunkt-Steuerung. Dieser 
Schieberegler am unteren Rand der Übertragungskennlinie kann mit der Maus nach links und rechts 
gezogen werden, um die Angelpunkt-Einstellung zu ändern. 

Verstärkungsreduzierungs-Anzeige 
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die im Eingangssignal mit den 
jeweiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain 
Reduction Meter] (Optionen>Verstärkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der 
Voreinstellung ist sie eingeschaltet. 

Pegelsteller 
Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfügbaren 
Verstärkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der 
Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 erklärt werden. 

Anzeige Schwellwert überschritten 
Diese Anzeige leuchtet gelb, wenn das Eingangssignal zum Prozessorblock den vorgegebenen Schwellwert 
überschreitet. 

 Signalpegel hat den Schwellwert überschritten 

 Signalpegel hat den Schwellwert nicht erreicht 
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Schwellwert 
Hier wird der Pegel angezeigt, den die Signalverstärkung erreichen muss, bevor der Prozessor 
sie erhöht. Signalpegel unterhalb des Schwellwerts werden bei Arbeitspegel durch den 
Prozessor geführt. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, Eingeben 

eines Werts oder Betätigung des Schwellwert-Schiebereglers über der Übertragungskennlinie geändert 
werden. Der verfügbare Wertebereich reicht von -60 VU bis +20 VU in Schritten von 0,5 VU mit einer 
Voreinstellung von 0 VU. 

Kompressionsgrad 
Hier wird der Betrag der Verstärkungsreduzierung angezeigt, der am Ausgang des Prozessors 
relativ zum Eingangspegel, der den Angelpunkt überschreitet, erreicht wird. Eine Einstellung von 
4:1 bedeutet zum Beispiel, dass eine Erhöhung von 4 dB im Pegel des Programmmaterials eine 

Erhöhung des Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann durch Klicken auf die 
Drehpfeil-Schaltflächen, Eingeben eines Werts oder Betätigung des Kompressionsgrad-Schiebereglers an der 
rechten Seite der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von 1:1 bis 10:1 
in Schritten von 1/10 mit einer Voreinstellung von 2:1. 

Einregelzeit 
Hier wird angegeben, wie lange der Prozessor wartet, bis er auf steigende oder fallende 
Eingangspegel reagiert, nachdem der Eingangspegel den Schwellwert erreicht hat. Die 
verfügbaren Werte reichen von 0,2 s bis 3 s mit einer Voreinstellung von 2 Sekunden. 

Abklingzeit 
Hier wird angegeben, wie lange der Prozessor wartet, bis er auf den Arbeitspegel zurückkehrt, 
nachdem der Eingangspegel näher zur Angelpunkt-Einstellung angestiegen oder abgefallen 
ist. Der verfügbare Wertebereich erstreckt sich von 0,5 s bis 5 s mit einer Voreinstellung von 5 
Sekunden. 

Angelpunkt 
Die Angelpunkt-Einstellung ist der angestrebte Ausgangspegel der AGC. Das ist ein 
Entscheidungspunkt, der bestimmt, ob der Eingangspegel angehoben oder abgesenkt wird. 
Signalpegel unterhalb des Angelpunktes (aber oberhalb des Schwellwerts) werden 

angehoben, während Pegel oberhalb des Angelpunktes abgesenkt werden. Der Wert kann durch Klicken auf 
die Drehpfeil-Schaltflächen, Eingeben eines Werts oder Betätigung des Angelpunkt-Schiebereglers unter der 
Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von -60 VU bis +20 VU in 
Schritten von 0,5 VU mit einer Voreinstellung von 0 VU. 

Voreinstellung 
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf 
die Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 
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Kompressor/Limiter 
Kompressoren und Limiter reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der 
Eingangspegel einen bestimmten Schwellwert überschreitet. Der System-Prozessor bietet die folgenden Typen von 
Kompressoren und Limitern: 

Blockname Beschreibung 

��COMP Kompressor 
��SFT COMP Soft-Knee-Kompressor 
��LIM Limiter 
��SFT LIM Soft-Knee-Limiter 
��ST COMP 
��SFT ST COMP 
��ST LIM 
��SFT ST LIM 

 

Gleich wie oben, für Verwendung für zwei Kanäle, 
die ein Stereopaar bilden 

��PEAK LIM  Peak-Stop-(„Look-Ahead“)-Limiter 

Funktion 
Der Kompressor dient zum Skalieren des Ausgangs eines Signals, sodass es für Geräte mit einem 
schmaleren Dynamikbereich wie Verstärker, Bandgeräte oder Lautsprecher geeignet ist. Der Limiter dient 
zum Schutz des Systems vor plötzlichen Lautstärke-Spitzenpegeln, die die Lautsprecher möglicherweise 
beschädigen könnten. Durch Verzögerung des Signals um 1 ms hat der Peak-Stop-Limiter eine Ansprechzeit 
von 0 ms, um noch mehr Kontrolle über Signalspitzentöne zu erzielen. Der Kompressor und der Limiter 
funktionieren auf ähnliche Weise, wobei der Limiter jedoch in der Regel für eine kürzere Ansprechzeit und 
einen höheren Kompressionsgrad eingestellt ist. Die folgenden Arten von Prozessoren sind sowohl in 
Limitern als auch in Kompressoren verfügbar. 

�� Soft-Knee - Diese Prozessoren bieten einen graduellen Übergang vom nicht komprimierten zum 
komprimierten Signal. Solche Prozessoren verbrauchen einen höheren Anteil der DSP-
Gesamtkapazität als diejenigen ohne Soft-Knee-Option. 

�� Stereo - Diese Prozessoren gestatten die Aufrechterhaltung eines Stereoeindrucks, indem zwei 
Blöcke gesetzt werden, die in zwei verschiedenen Kanälen als ein einzelner Prozessor 
fungieren. Beide Prozessorkanäle reagieren mit der gleichen Pegelabsenkung, wenn der Eingang 

     Abbildung 32 - SFT LIM-Fenster 

Pegelsteller Übertragungs-
kennlinie

Schwellwert-Schieberegler Kompressionsgrad-
Schieberegler 

Verstärkungsreduzierungs-
Anzeige 

Übertragungskennlinien-Anzeige 
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eines der Kanäle die Schwellwert-Einstellung überschreitet. Diese Prozessoren verbrauchen einen 
höheren Anteil der DSP-Gesamtkapazität als Mono-Prozessoren. 

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente von Kompressoren und Limitern, 
wobei der in Abbildung 32 dargestellte SFT LIM als Beispiel dient. Alle in diesem Abschnitt behandelten 
Prozessoren sind sehr ähnlich in der Verwendung. Unterschiede in ihren Merkmalen und ihrer Funktionalität 
werden gegebenenfalls angeführt. 

Übertragungskennlinie 
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als 
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende 
Übertragungskennlinie repräsentiert die Änderung im Signalausgangspegel. 

Übertragungskennlinien-Anzeige 
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass 
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann 
mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige) aus- und 
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet. 

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung 
der Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die 
Verstärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] 
ausgeschaltet werden. 

 
Schwellwert-Schieberegler 
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser 
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezogen 
werden, um die Schwellwert-Einstellung zu ändern. 

Kompressionsgrad-Schieberegler 
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am rechten Rand der Übertragungskennlinie kann mit der Maus nach oben 
und unten gezogen werden, um die Kompressionsgrad-Einstellung zu ändern. 

Verstärkungsreduzierungs-Anzeige 
Hier wird die gesamte Pegelabschwächung angegeben, die im Eingangssignal mit den jeweiligen 
Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain Reduction 
Meter] (Optionen>Verstärkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der Voreinstellung 
ist sie eingeschaltet. 

Pegelsteller 
Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfügbaren 
Verstärkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der 
Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 erklärt werden. 

Anzeige Schwellwert überschritten 
Diese Anzeige leuchtet gelb, wenn das Eingangssignal zum Prozessorblock den vorgegebenen Schwellwert 
überschreitet. 

 Signalpegel hat den Schwellwert überschritten 

 Signalpegel hat den Schwellwert nicht erreicht 
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Schwellwert 
Hier wird der Verstärkungspegel angegeben, den das Signal erreichen muss, bevor der 
Prozessor es komprimiert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, 
Eingeben eines Werts oder Betätigung des Schwellwert-Schiebereglers über der 

Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von -60 VU bis +20 VU in 
Schritten von 0,5 VU mit einer Voreinstellung von 0 VU. 

Kompressionsgrad 
Hier wird der Betrag der Verstärkungsreduzierung angegeben, der am Ausgang des 
Prozessors relativ zum Eingangspegel erreicht wird. Eine Einstellung von 4:1 bedeutet zum 
Beispiel, dass eine Erhöhung von 4 dB im Pegel des Programmmaterials eine Erhöhung des 

Ausgangspegels vom Prozessor von 1 dB bewirkt. Der Wert kann durch Klicken auf die Drehpfeil-
Schaltflächen, Eingeben eines Werts oder Betätigung des Kompressionsgrad-Schiebereglers an der rechten 
Seite der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich reicht von 1:1 bis INF:1 in 
Schritten von 1/10 mit einer Voreinstellung von 2:1 für Kompressoren und 10:1 für Limiter. Der Peak-Stop-
Limiter weist einen konstanten Kompressionsgrad von Unendlich zu Eins (INF:1) auf. 

Einregelzeit 
Hier wird angegeben, wie lange der Prozessor wartet, bis er anfängt, die Verstärkung zu 
reduzieren, nachdem der Eingangssignalpegel den Schwellwert überschritten hat. Der 
verfügbare Wertebereich reicht von 1 ms bis 200 ms mit einer Voreinstellung von 5 ms für 

Kompressoren und 2 ms für Limiter. Der Peak-Stop-Limiter weist eine konstante Ansprechzeit von 0 ms auf. 

Abklingzeit 
Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zurückkehrt, 
nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der verfügbare 
Wertebereich reicht von 50 ms bis 1000 ms mit einer Voreinstellung von 100 ms für 
Kompressoren und 50 ms für Limiter. 

Knee 
Bei „Soft“-Prozessoren zeigt dieses Bedienelement eine Pulldown-Liste an, aus der Soft-Knee- oder Hard-
Knee-Kompression gewählt werden kann. Die Voreinstellung ist Soft-Knee. Bei Standard-Kompressoren und 
-Limitern ist dieses Bedienelement deaktiviert. 

Soft-Knee-
Prozessor  

„Soft“ oder „Hard“ aus der Pulldown-Liste wählen. 

Standard-
Prozessor  

Das Bedienelement ist deaktiviert. 

Voreinstellung 
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 
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Momentaufnahme 

Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf die 
Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 

Soft-Knee-Prozessoren 
Die folgenden Beispiele veranschaulichen den Unterschied zwischen Hard-Knee- und Soft-Knee-
Kompression. Alle anderen Einstellungen in diesen Beispielen werden unverändert beibehalten. 

Eine Soft-Knee-Einstellung ist beim Arbeiten mit hohen Kompressionsgraden 
praktisch. Die Soft-Knee-Einstellung erhöht den Kompressionsgrad von 1:1 bei etwa 
12 dB unter dem Schwellwert langsam auf den vorgegebenen Kompressionsgrad bei 
etwa 20 dB über dem Schwellwert. Durch die langsame 
Erhöhung des Kompressionsgrads ist die Kompression 
weniger auffällig als bei der Hard-Knee-Einstellung. 

Die Hard-Knee-Einstellung aktiviert die Kompression 
unvermittelt mit dem vorgegebenen Kompressionsgrad, 
sobald der Signalpegel den Schwellwert überschreitet. Diese 
Einstellung ist besonders praktisch in einem Limiter, weil 
dadurch plötzliche Spitzen daran gehindert werden, den 
Schwellwert zu überschreiten, ohne dass das Signal 
unterhalb des Schwellwerts geändert wird. 

Stereo-Prozessoren 
Die Stereo-Prozessoren weisen die gleichen Merkmale und die gleiche Funktionalität wie ihre Mono-
Gegenstücke auf und umfassen einige zusätzliche Funktionen. 

�� Änderungen der Einstellungen von einem der beiden Prozessorkanäle werden auch auf den 
anderen Kanal angewandt. 

�� Beide Prozessorkanäle reagieren mit der gleichen Pegelabsenkung, wenn der Eingang eines der 
Kanäle die Schwellwert-Einstellung überschreitet. 

�� In den beiden Übertragungskennlinien-Anzeigen wird der Eingangspegel von Kanal A rot und der 
von Kanal B blau angezeigt. 

�� Anzeigen-Wähler gestatten die Ansicht der Übertragungskennlinien-Anzeige für Kanal A, Kanal B, 
beide Kanäle oder keinen Kanal. 

�� Die Anzeige „Schwellwert überschritten“ ist für Kanal A und Kanal B vorhanden. 

Abbildung 33 - Soft-
Knee-Kompression 

Abbildung 34 - Hard-
Knee-Kompression 
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Frequenzweichen/Verteiler 
Frequenzweichen und Verteiler teilen ein Eingangssignal in mehrere Ausgangskanäle auf. Frequenzweichen teilen 
das Frequenzspektrum des Eingangssignals in mehrere Bänder auf und geben jedes Band in einen separaten Kanal 
aus. Durch Verteiler wird das Eingangssignal einfach auf mehrere Ausgangskanäle verteilt. 

Blockname Beschreibung 

�� XOVER 2 2-Wege-Frequenzweiche 
�� XOVER 3 3-Wege-Frequenzweiche 
�� XOVER 4 4-Wege-Frequenzweiche 
�� XOVER 5 5-Wege-Frequenzweiche 

Blockname Beschreibung 

�� SPLIT 2 2-Wege-Verteiler 
�� SPLIT 3 3-Wege-Verteiler 
�� SPLIT 4 4-Wege-Verteiler 
�� SPLIT 5 5-Wege-Verteiler 

Funktion 
Eine Frequenzweiche dient dazu, den Frequenzbereich des Eingangssignals mit mehreren Bandpassfiltern 
zu unterteilen und dann jedes Frequenzband zu einem separaten Ausgang für verschiedene 
Lautsprechertypen zu leiten. Verteiler dienen dazu, das gleiche Signal zu mehreren verschiedenen 
Ausgängen zu leiten. Für Verteiler-Prozessoren gibt es kein Parameterfenster, da sie das Signal einfach bei 
Arbeitspegel ohne zusätzliche Verarbeitung verteilen. Frequenzweichen und Verteiler sind ausschließlich für 
Ausgangsverarbeitung vorgesehen und können nicht in Eingangskanalstreifen positioniert werden. Siehe 
den Abschnitt Prozessoren hinzufügen: Frequenzweichen und Verteiler auf Seite 22 für weitere 
Informationen zum Positionieren von Frequenzweichen und Verteilern im Signalflussdiagramm. 

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente von Frequenzweichen, wobei der 
oben in Abbildung 35 dargestellte XOVER 4 als Beispiel dient. Die Merkmale der anderen Frequenzweichen 
mit Ausnahme der Anzahl der Bandpassfilter sind identisch. 

Frequenzgang-Plotter 
Dieser Bereich des Fensters stellt die Bandpassfilter und Übergangspunkte, die durch Klicken und Ziehen 
mit der Maus verändert werden können, grafisch dar. 

Abbildung 35 - XOVER4-Fenster 

Passband-
Steuerelemente 

Ausgangskanal-
Kennzeichnungen

Frequenzgang-Plotter

Ecken-
Ziehpunkte 

Verstärkungs-
Ziehpunkt

Passband Frequenzweichen-
Ziehpunkt
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Passbänder 
Jedes Band verfügt über Ziehpunkte an beiden Seiten, die nach links und rechts gezogen 
werden können, um die obere und untere Eckfrequenz individuell einzustellen. Außerdem 
befindet sich ein Verstärkungs-Ziehpunkt in der Mitte jedes Bands, das nach oben und unten 

gezogen werden kann, um den Ausgangspegel des Passbands einzustellen. Wenn ein Ziehpunkt gewählt wird, 
wird er mit einem farbigen Kreis gefüllt, um darauf hinzuweisen, dass er das aktive Steuerelement ist. Die obere 
und untere Filterflanke werden mit den Passband-Bedienelementen im unteren Abschnitt des Fensters 
eingestellt. 

Frequenzweichen-Ziehpunkt 
Dieser Ziehpunkt gibt die Frequenz des Übergangspunktes zwischen zwei 
Passbändern an. Er kann nach links und rechts gezogen werden, um gleichzeitig die 
Eckfrequenzen der sich schneidenden Filterflanken einzustellen. Wenn ein 
Frequenzweichen-Ziehpunkt gewählt wird, wird er grün, um darauf hinzuweisen, 
dass er das aktive Steuerelement ist, und die zugehörigen Ecken-Ziehpunkte werden 
gefüllt, um darauf hinzuweisen, dass sie gewählt sind. Beim Verschieben des 
Frequenzweichen-Ziehpunktes behalten die Ecken-Ziehpunkte ihre Positionen relativ 
zueinander bei. 

Ausgangskanal-Kennzeichnungen 
Diese Kennzeichnungen über den Spalten mit den Passband-Bedienelementen haben die gleichen Farben 
wie die zugehörigen Bandpasskurven im Frequenzgang-Plotter. Sie geben an, zu welchen Ausgangskanal 
jedes Passband geführt ist.  

Verstärkungen einstellen und anzeigen/Plot normalisieren 
Mit diesen Schaltflächen werden die 
Passbänder abwechselnd mit ihren 
tatsächlichen Verstärkungspegeln und 
normalisiert angezeigt. Die Voreinstellung ist 
[Set and Show Gains on Plot] (Verstärkungen 
in Plot einstellen und anzeigen). 

Wenn die Verstärkungspegel von Passbändern 
sich beträchtlich unterscheiden, erscheint der 
Übergangspunkt von seiner tatsächlichen 
Position versetzt, wie in Abbildung 36 an der 
rechten Seite dargestellt. Der Anzeigemodus 
für den normalisierten Plot dient dazu, die 
genaue Position des Übergangspunktes zu 
sehen, wie in Abbildung 37 unten rechts 
dargestellt. 

• Auf die Schaltfläche [Set and Show Gains 
on Plot] klicken, um die Passband-
Verstärkungspegel anzuzeigen und 
einzustellen. Bei dieser Einstellung 
werden Filterpegel im Frequenzgang-
Plotter berücksichtigt, und die 
Verstärkungs-Ziehpunkte sind auf den 
Passbändern zu sehen. 

• Auf die Schaltfläche [Normalize Plot] (Plot 
normalisieren) klicken, um die Passbänder 
bei Arbeitspegel im Frequenzgang-Plotter 
anzuzeigen. Die tatsächlichen 
Verstärkungswerte werden durch diese 
Einstellung nicht verändert. 

Abbildung 37 - Anzeige des normalisierten Plots 

Abbildung 36 - Anzeige der Passband-Verstärkungspegel 
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Voreinstellung 
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 

Stummschaltung 
Auf diese Schaltfläche klicken, um den Ausgangskanal stumm zu schalten. Wenn die Stummschaltung aktiv 
ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 
Stummschaltung 
aktiv 

 
Stummschaltung 
inaktiv 

Polarität 
Auf diese Schaltfläche klicken, um die Polarität des Signals, das am Ausgangskanalstreifen anliegt, 
umzukehren. Die Voreinstellung ist normale Polarität. 

 Normale Polarität 

 Umgekehrte Polarität 

Untere Eckfrequenz 
Hier wird die Frequenzeinstellung der unteren Ecke des Passbands angegeben. Der 
verfügbare Wertebereich ist abhängig von der Einstellung der oberen Eckfrequenz, da sich 
Eckfrequenzen nicht überlappen können. Der Wert kann durch Klicken auf die Drehpfeil-

Schaltflächen, Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geändert werden. Die 
Voreinstellungen für die verschiedenen Passbänder sind nachstehend für jeden Frequenzweichentyp 
angeführt. 

Typ der 
Frequenzweiche 2 Wege 3 Wege 4 Wege 5 Wege 

Band 1 AUS AUS AUS AUS 

Band 2 2,0 kHz 200 Hz 150 Hz 60 Hz 

Band 3 − 2,0 kHz 1,5 kHz 150 Hz 

Band 4 − − 5,0 kHz 1,0 kHz 

Band 5 − − − 6,0 kHz 

Unterer Filtertyp/oberer Filtertyp 
Hier wird die Flanke der zugehörigen Passbandecke angegeben. Einen Wert aus dem 
nachstehenden Pulldown-Menü wählen. Die Voreinstellung ist 24 dB/Okt. Linkwitz-Riley. 

Abkürzung Beschreibung 

6 Butt 6 dB/Okt. Butterworth 

12 Butt 12 dB/Okt. Butterworth 

12 Bess 12 dB/Okt. Bessel 

12 L-R 12 dB/Okt. Linkwitz-Riley 

18 Butt 18 dB/Okt. Butterworth 

24 Butt 24 dB/Okt. Butterworth 

24 Bess 24 dB/Okt. Bessel 

24 L-R 24 dB/Okt. Linkwitz-Riley 
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Hinweis: Die Verwendung eines 12-dB/Okt.-Filters in benachbarten Bändern ergibt eine Kerbe an 
der Übergangsfrequenz, wenn die Ausgänge addiert werden. Bei der Ausrichtung von 
Lautsprechern muss darauf geachtet werden, dass diese Kerbe im akustischen 
Frequenzgang nicht wahrnehmbar ist. Erforderlichenfalls die Polarität von einem der 
Bänder mit der Schaltfläche „Polarität“ umkehren.  

Obere Eckfrequenz 
Hier wird die Frequenzeinstellung der oberen Ecke des Passbands angegeben. Der 
verfügbare Wertebereich ist abhängig von der Einstellung der unteren Eckfrequenz, da sich 

Eckfrequenzen nicht überlappen können. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, 
Verwendung der Tastatur-Bedienelemente oder Eingeben eines Werts geändert werden. Die 
Voreinstellungen für die verschiedenen Passbänder sind nachstehend für jeden Frequenzweichentyp 
angeführt. 

Typ der 
Frequenzweiche 2 Wege 3 Wege 4 Wege 5 Wege 

Band 1 2,0 kHz 200 Hz 150 Hz 60 Hz 

Band 2 AUS 2,0 kHz 1,5 kHz 150 Hz 

Band 3 − AUS 5,0 kHz 1,0 kHz 

Band 4 − − AUS 6,0 kHz 

Band 5 − − − AUS 

Verstärkung 
Hier wird die aktuelle Verstärkungseinstellung des Passbandfilters angegeben. Der Bereich der verfügbaren 
Verstärkungswerte liegt zwischen -18 dB und +12 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 
dB. Der Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 beschrieben 
werden. 

Tasten der Tastatur 
Mit Tasten der Tastatur können Feineinstellungen der Ziehpunkt-Positionen im Frequenzgang-Plotter 
vorgenommen werden. Einen Ziehpunkt durch Klicken wählen und dann die folgenden Tasten verwenden. 

Taste Frequenzweichen- und 
Ecken-Ziehpunkte Verstärkungs-Ziehpunkt 

← 
Verringert die Frequenz 

um einen Bildschirm-
Bildpunkt 

− 

→ 
Erhöht die Frequenz um 

einen Bildschirm-
Bildpunkt 

− 

↑ − Erhöht die Verstärkung um 0,5 dB 

↓ − Verringert die Verstärkung um 0,5 dB 

UMSCHALTTASTE mit ← Verringert die Frequenz 
um 1/3 Oktave 

− 

UMSCHALTTASTE mit → Erhöht die Frequenz um 
1/3 Oktave 

− 

UMSCHALTTASTE mit ↑  
oder BILD-AUF-TASTE 

− Erhöht die Verstärkung um 3 dB 

UMSCHALTTASTE mit ↓  
oder BILD-AB-TASTE 

− Verringert die Verstärkung um 3 dB 

LEERZEICHENTASTE 
 oder Klicken mit der 

rechten Maustaste 
− Stellt die Verstärkung auf 0 dB ein 

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um 
etwa 1/100 einer Oktave oder 1 %.  
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Filter mit steilflankiger und Kuhschwanz-Charakteristik 
Die Filter mit steilflankiger und Kuhschwanz-Charakteristik sind eine Art von parametrischem Equalizer, die die 
Frequenzcharakteristika eines Systems im oberen und unteren Bereich insgesamt anheben oder absenken sowie 
das obere und untere Ende des Frequenzspektrums dämpfen. 

Blockname Beschreibung 
�� CUT/SHELF Hoch- und Niederfrequenz-Filter mit steilflankiger Charakteristik/Hoch- und  
  Niederfrequenz-Filter mit Kuhschwanz-Charakteristik 

Funktion 
Diesen Prozessor verwenden, wenn ein Filter mit steilflankiger Charakteristik mit Equalization über ein 
breites Spektrum mit hohem und tiefem Endbereich kombiniert werden soll. Die Hoch- und Niederfrequenz-
Filter mit steilflankiger Charakteristik bieten eine Vielzahl von Flanken-Optionen zwischen -6 dB/Okt. und -24 
dB/Okt. Außerdem ist es möglich, die Eckflanke der Filter mit Kuhschwanz-Charakteristik entweder als 6 
dB/Okt. oder als 12 dB/Okt. vorzugeben. 

Merkmale des Parameterfensters 
Frequenzgang-Plotter 
Dieser Bereich des Parameterfensters stellt die Ziehpunkte der Filter mit steilflankiger und mit Kuhschwanz-
Charakteristik, die durch Klicken und Ziehen mit der Maus verändert werden können, grafisch dar. Beim 
ersten Öffnen des Parameterfensters befinden sich die Filter-Ziehpunkte an ihren 
Systemvoreinstellpositionen am ganz oben und unteren Rand des Frequenzspektrums. Durch Klicken auf 
einen Ziehpunkt wird seine Frequenzgang-Kennlinie angezeigt und es können Einstellungen vorgenommen 
werden. 

Frequenzgang-Diagramm 
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filter-Ziehpunkte im 
Frequenzgang-Plotter. 

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke 
im Signalflussdiagramm. 

Abbildung 38 - Fenster für Filter mit steilflankiger/Kuhschwanz-Charakteristik 
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Filter mit steilflankiger Charakteristik 
Filter mit steilflankiger Charakteristik erscheinen als Ziehpunkte am unteren Rand des Frequenzgang-
Plotters, ihre Mittenfrequenzen sind durch gestrichelte senkrechte Linien gekennzeichnet. Ihre Frequenz-
Voreinstellung ist „AUS“ und ihre Typ-Voreinstellung ist 6 dB/Butterworth. 

Filter mit Kuhschwanz-Charakteristik 
Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik erscheinen entlang einer 
horizontalen Achse in der Mitte des Frequenzgang-Plotters. Ihre Frequenz-Voreinstellung ist „AUS“ und ihre 
Typ-Voreinstellung ist 6 dB/Okt. 

Frequenz 
Hier wird die Frequenz des gewählten Filterpunktes angezeigt. Der Wert kann durch 
Klicken auf die Drehpfeil-Schaltflächen, Verwendung von Tasten der Tastatur oder 

Eingeben eines Werts geändert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit „AUS“ als 
Voreinstellung. 

Typ 
Hier wird der Flankentyp des gewählten Filters angezeigt. Die im Pulldown-
Menü verfügbaren Werte für Filter mit steilflankiger und Kuhschwanz-

Charakteristik unterscheiden sich, wie nachstehend angeführt. 

Kuhschwanz-
Charakteristik 

Steilflankige Charakteristik 

 6 dB/Oktave* 
 12 dB/Oktave 

 6 dB/Butterworth* 
 12 dB/Butterworth 
 12 dB/Bessel 
 12 dB/Linkwitz-Riley 

 18 dB/Butterworth 
 24 dB/Butterworth 
 24 dB/Bessel 
 24 dB/Linkwitz-Riley 

* Kennzeichnet die Voreinstellung 

Verstärkung 
Hier wird die aktuelle Verstärkungseinstellung des gewählten Filters mit Kuhschwanz-
Charakteristik angegeben. Der Bereich der verfügbaren Verstärkungswerte liegt 

zwischen -18 dB und +18 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Der Wert kann mit 
den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 beschrieben werden. Beim Arbeiten 
mit einem Filter mit steilflankiger Charakteristik ist dieses Steuerelement deaktiviert, dann wird das Wort 
„CUT“ angezeigt. 

Löschen 
Durch Klicken auf diese Schaltfläche werden die Filtereinstellungen auf ihre Voreinstellungen 
zurückgesetzt. Dann wird das Dialogfeld „Clear Options“ (Optionen für Löschen, Abbildung 48 auf 

Seite 68) eingeblendet, das die Option bietet, alle oder nur ausgewählte Filtereinstellungen zu löschen. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf 
die Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 

Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 
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Importieren von ASCII-Dateien 
Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in 
das Frequenzgang-Diagramm importiert werden. 

 

Feinregelung von Parametern 
Die Parameter für die gewählten Filter können mit den nachstehend beschriebenen Methoden präzise 
eingestellt werden. 

�� Eingabe von Werten in die Parameterfelder 
�� Betätigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern 
�� Verwendung der Tastatur-Tasten 

Tasten der Tastatur 
Mit den folgenden Tasten der Tastatur können Feineinstellungen für den jeweils gewählten Filter 
vorgenommen werden. 

Taste Ergebnis 

← Verringert die Frequenz um einen Bildschirm-Bildpunkt 

→ Erhöht die Frequenz um einen Bildschirm-Bildpunkt 

↑ Erhöht die Verstärkung um 0,5 dB 

↓ Verringert die Verstärkung um 0,5 dB 

UMSCHALTTASTE mit ← Verringert die Frequenz um 1/3 Oktave 

UMSCHALTTASTE mit → Erhöht die Frequenz um 1/3 Oktave 

UMSCHALTTASTE mit ↑  
oder BILD-AUF-TASTE Erhöht die Verstärkung um 3 dB 

UMSCHALTTASTE mit ↓  
oder BILD-AB-TASTE Verringert die Verstärkung um 3 dB 

LEERZEICHENTASTE 
 oder Klicken mit der 

rechten Maustaste 
Stellt die Verstärkung auf 0 dB ein 

ENTF Stellt den oder die gewählten Filter auf die Voreinstellungen zurück. 

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um 
etwa 1/100 einer Oktave oder 1 %.  

Kopieren und Einfügen 
Die Einstellungen von Filter-Ziehpunkten können zwischen Prozessorfenstern für Filter mit steilflankiger 
und Kuhschwanz-Charakteristik kopiert und eingefügt werden.  

So werden Filter kopiert und eingefügt: 

1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter 
wählen: 
�� STRG+Klicken 
�� Menüoption [Edit>Select All] (Bearbeiten>Alles auswählen) 

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) wählen. 
3. Das Prozessorfenster des Filters mit steilflankiger/Kuhschwanz-Charakteristik öffnen, in das die 

Filtereinstellungen eingefügt werden sollen. 
4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) wählen. 

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre 
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rückgängig zu 
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter 
außerhalb des Auswahlbereichs klicken. 
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Delay 
Der Delay-Prozessor speichert das Signal vorübergehend im Verzögerungsspeicher und leitet es dann nach Ablauf 
der vorgegebenen Zeitdauer weiter. Der System-Prozessor bietet die folgenden Delay-Typen: 

Blockname Beschreibung 
�� DLY5ms  Maximale Verzögerung von 5 Millisekunden 
�� DLY150ms  Maximale Verzögerung von 150 Millisekunden 
�� DLY500ms  Maximale Verzögerung von 500 Millisekunden 
�� DLY2s Maximale Verzögerung von 2 Sekunden 

Funktion 
Der Delay dient zum Abgleichen der Sound-Ausgänge von verschiedenen Lautsprechern, sodass sie 
gleichzeitig im Publikum ankommen. Der Delay kann außerdem eingesetzt werden, um Probleme mit der 
Phasenaufhebung zwischen installierten Lautsprechern zu korrigieren. Die Berechnung der Verzögerung 
erfolgt mit den Einheiten Zeit, Entfernung und Lufttemperatur.  

Hinweis: Jeder Delay-Prozessorblock verbraucht die maximale Menge des Verzögerungsspeichers, 
der aus dem Blocknamen hervorgeht, unabhängig von der tatsächlichen Verwendung. Um 
die Ressourcen des System-Prozessors zu schonen, sollte der Delay-Prozessor gewählt 
werden, dessen Maximum der tatsächlich benötigten Verzögerungszeit am nächsten liegt. 

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen von Delay-Prozessoren, wobei der oben in Abbildung 39 
dargestellte DLY150 als Beispiel dient. Die Merkmale der anderen Verzögerungsglieder mit Ausnahme 
ihrer maximalen Verzögerungszeiten sind identisch. 

Units (Einheiten) 
Mit diesem Steuerelement wird angegeben, ob die Parameter in 
englischen oder metrischen Einheiten angezeigt werden. Die 

Voreinstellung ist „Englisch“. 

Zeit 
Mit diesem Steuerelement wird die Verzögerungszeit in Millisekunden angegeben. 
Der Wertebereich liegt zwischen 0 ms und der maximalen Verzögerungszeit des 
Prozessorblocks, in diesem Fall 150 ms. Die Voreinstellung ist 0 ms. 

Entfernung 
Mit diesem Steuerelement wird die Verzögerung nach der Entfernung 
angegeben. Der Wertebereich ist abhängig von der maximalen 
Verzögerungszeit, aber die Voreinstellung ist immer null. Die gewünschte 

Maßeinheit mit den Optionsfeldern rechts neben dem Steuerelement wählen. Zur Auswahl stehen Zoll, Fuß 
und Meter. Die Voreinstellung ist Zoll. Wenn englische Einheiten gewählt sind, können Sie zwischen Inch 
und Fuß wählen. Wenn metrische Einheiten gewählt sind, wird der Abstand in Metern angegeben. Die 
Voreinstellung ist „Inch“. 

Abbildung 39 − Delay-Fenster 
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Lufttemperatur 
Dieses Steuerelement ist zu verwenden, wenn die Verzögerung 
nach der Entfernung eingestellt wird, da die 
Schallgeschwindigkeit durch die Lufttemperatur beeinflusst wird. 

Der Wertebereich reicht von -13 °F bis 122 °F oder -25 °C bis 50 °C. Die gewünschte Maßeinheit mit den 
Optionsfeldern rechts neben dem Steuerelement wählen. Die Voreinstellung ist Grad Fahrenheit. Wenn 
englische Einheiten gewählt sind, wird die Lufttemperatur in Fahrenheit angegeben. Wenn metrische 
Einheiten gewählt sind, wird die Lufttemperatur in Celsius angegeben. Die Voreinstellung ist „Fahrenheit“. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Löschen 
 Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 
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Digitale Rückkopplungsreduzier-Stufe (DFR) 
Die DFR verwendet den patentierten Adaptive-Notch-Filter-Algorithmus von Shure für die automatische 
Erkennung von Rückkopplung und Anwendung von Schmalband-Sperrfiltern. Der System-Prozessor bietet die 
folgenden DFR-Typen: 

Blockname Beschreibung 
�� DFR5  Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern 
�� DFR10  Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern 

Funktion 
Die DFR sollte als erster Prozessor in jedem Eingangskanal, der Signale von einem Mikrofon mit 
Rückkopplungsproblemen empfängt, verwendet werden. Wenn die DFR Rückkopplungen feststellt, aktiviert 
sie einen dynamischen Filter. Sie beginnt damit, dass sie einen Bandsperrfilter von -3 dB, 1/10 Oktave an 
der Rückkopplungsfrequenz einfügt. Dann wird die Filterbandtiefe in 3-dB-Schritten auf bis zu -18 dB 
gesteigert, bis die Rückkopplung aufhört. Es ist auch möglich, feste Filter an bestimmten 
Raumknotenpunkten zuzuweisen. Wenn die DFR Rückkopplung an der Frequenz eines festen Filters 
erkennt, vertieft sie diese Kerbe mit einem dynamischen Filter.  

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der digitalen 
Rückkopplungsreduzier-Stufe, wobei die oben in Abbildung 40 dargestellte DFR10 als Beispiel dient. Die 
Merkmale der DFR5 mit Ausnahme der Anzahl der verfügbaren Bandsperrfilter sind identisch.  

Frequenzgang-Diagramm 
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der aktiven Bandsperrfilter des 
Prozessors (gelb markiert). 

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke 
im Signalflussdiagramm. 

Frequenz 
Hier wird die Frequenz des gewählten Filters angezeigt. Der Wert kann durch 
Klicken auf die Drehpfeil-Schaltflächen, Verwendung von Tasten der Tastatur oder 

Eingeben eines Werts geändert werden. Der Frequenzbereich erstreckt sich von 25 Hz bis 20 kHz mit „AUS“ 
als Voreinstellung. 

Abbildung 40 - DFR10-Fenster 

         Frequenzgang- 
 Diagramm 
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Tiefe 
Hier wird die Pegelreduzierung des gewählten Filters angezeigt. Der Bereich der 
verfügbaren Verstärkungswerte liegt zwischen 0 dB und -18 dB in Schritten von 0,5 
dB mit einer Voreinstellung von 0 dB. 

Typ 
Hier wird der Bandbreiten-Typ des gewählten Filters angezeigt. „High Q“ oder „Low 
Q“ aus dem Pulldown-Menü wählen. Die Voreinstellung ist „Low Q“. 

Rückkopplungsfilter 
Die Steuerelemente der Rückkopplungsfilter werden als LED-Reihe angezeigt. Die 
Anzahl der festen und der dynamischen Filter wird durch Verschieben der roten 
Klammern mit der Maus nach links und rechts eingestellt. Aktive Filter werden gelb 
angezeigt und erscheinen im Frequenzgang-Diagramm. Für weitere Erläuterungen 
siehe den Abschnitt Filterzuweisung auf Seite 59. 

FIXED Diese festen Filter bleiben auf ihren jeweiligen Frequenzen 
unabhängig von neu festgestellten Rückkopplungen. 

DYNAMIC Diese dynamischen Filter werden automatisch von der DFR 
eingesetzt, wenn sie Rückkopplungen feststellt. 

Sperren 
Auf diese Schaltfläche klicken, um den Einsatz neuer Filter und die Vertiefung von bestehenden Filtern zu verhindern. Mit 
dieser Option wird die DFR daran gehindert, Filter für Programmmaterial anzuwenden, das erwünschte Rückkopplungen 
oder Klänge, die Rückkopplungen sehr ähnlich sind (wie z.B. Gitarreneffekte, Synthesizerklänge oder Pfeifenorgel), enthält. 

 Sperre aktiv 

 Sperre inaktiv 

Löschen 
Durch Klicken auf diese Schaltfläche werden die Filtereinstellungen auf ihre Voreinstellungen 
zurückgesetzt. Dann wird das Dialogfeld „Clear Options“ (Optionen für Löschen, Abbildung 44 
auf Seite 60) eingeblendet, das die Option bietet, alle oder nur ausgewählte Filtereinstellungen 
zu löschen. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf 
die Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 



Modulare Prozessoren 

SHURE System-Prozessor P4800 Software-Bedienungsanleitung Seite 58 von 108 

Grundlegende DFR-Einrichtung 
Es gibt zwei grundlegende Einrichtungsverfahren für den DFR zum Reduzieren von Rückkopplungen: die 
Methode „Erregen von Rückkopplungen“ und die Methode „Versicherungspolize“, wie nachstehend 
beschrieben. Jede eignet sich für eine unterschiedliche Situation. 

Hinweis: Die DFR (wie jedes andere Bandsperrfiltersystem) trägt zur Reduzierung von 
Rückkopplungen bei, kann sie aber nicht vollständig beseitigen. In einer typischen 
Anlage wird ein Zustand des „abnehmenden Nutzens“ erreicht, nachdem 4 bis 8 
Bandsperrfilter eingestellt wurden. Eine Anhebung der Verstärkung vor Rückkopplung 
von 6 bis 9 dB kann in einem typischen System erwartet werden. Um eine höhere 
Leistung des Klangsystems zu erreichen, kann es erforderlich sein, die Signalumgebung 
zu verbessern. 

�� Methode „Erregen von Rückkopplungen“ - Mit dieser Methode wird die DFR als 
vorbeugendes Mittel gegen Rückkopplungen für Eingangskanäle eingesetzt, die nahe dem 
Rückkopplungspunkt arbeiten und eine zusätzliche Stabilitätsspanne erfordern. Dafür wird die 
Verstärkung des Eingangskanals über die normale Einstellung angehoben, um absichtlich 
Rückkopplungen des Systems herbeizuführen. Die DFR stellt dann die erforderlichen Filter ein. 
Wenn anschließend die Eingangsverstärkung auf den normalen Pegel abgesenkt wird, ist das 
System stabil und einsatzbereit. 

�� Methode „Versicherungspolize“ - Bei dieser Methode wird die DFR als zusätzliche 
Versicherung gegen unerwarteten Rückkopplungen in einem ansonsten stabilen System 
eingesetzt. Dafür wird der DFR-Prozessor einfach in den Signalweg eingefügt, ohne 
irgendwelche Einstellungen zu definieren. Dieses Verfahren wird für Anlagen verwendet, die 
bereits eine hinreichende Verstärkung vor Rückkopplung aufweisen, aber Schutz vor 
gelegentlichen Rückkopplungen benötigen, die aufgrund von ortsveränderlichen Mikrofonen 
oder vom Benutzer verstellbaren Pegelstellern auftreten kann. 

So wird die Methode „Erregen von Rückkopplungen“ angewandt:  

1. Aktive Filter durch Klicken auf die Schaltfläche [Clear] (Löschen) entfernen. 

2. Alle Mikrofone hochfahren.  

3. Das DFR-Fenster beobachten und dabei die Systemverstärkung langsam erhöhen. Wenn die 
DFR akustische Rückkopplung feststellt, setzt sie neue Filter ein, die im DFR-Fenster als gelbe 
Punkte angezeigt werden.  

4. Diesen Vorgang fortsetzen, um die Verstärkung um 3 bis 6 dB über den Verstärkungspegel zu 
erhöhen, mit dem das System arbeiten soll, oder bis 4 bis 8 Filter zugeschaltet wurden. Die 
Verstärkung um 3 bis 6 dB auf die gewünschte Einstellung verringern, um das System zu 
stabilisieren.  

5. Die zugeschalteten Filter als „fixed“ (fest) zuweisen (siehe unten Zuweisung fester und 
dynamischer Filter). Die restlichen dynamischen Filter kommen während der Verwendung des 
Systems nach Bedarf zum Einsatz.  

Hinweis: Die festen Filter können in einen PEQ-Block kopiert werden, um mehr dynamische Filter 
im DFR-Fenster zu haben. 

Halte-Modus 
Als Voreinstellung speichert der digitale Rückkopplungsunterdrücker (DFR) den Zustand aller seiner Filter 
während einer Preset-Umschaltung oder eines Ein-/Ausschaltvorgangs. Allerdings kann der DFR so 
konfiguriert werden, dass bestimmte Filter gelöscht werden, wenn ein Ein-/Ausschaltvorgang oder eine 
Preset-Umschaltung erfolgt. Nach Festlegung aller Filter, die permanent sein sollen, aktivieren Sie den 
Halte-Modus. Sämtliche Filter, die nach Aktivierung des Halte-Modus eingesetzt werden, werden nach einer 
Preset-Umschaltung oder einem Ein-/Ausschaltvorgang gelöscht. 

So wird der Halte-Modus aktiviert: 

1. Absichtlich Rückkopplungen im System erregen, wie im vorherigen Abschnitt beschrieben. 

2. Die Menüoption [Options>Hold Mode] (Optionen>Halte-Modus) wählen. 
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Filterzuweisung 
Die DFR verwendet die beiden nachstehend beschriebenen Methoden der Filterzuweisung. 

�� Feste Filter - Die Sperrpositionen können manuell vorgegeben werden oder als fest bestimmt 
werden, nachdem die DFR automatisch einen dynamischen Filter eingesetzt hat. Dann bleiben 
sie unabhängig von neu festgestellten Rückkopplungsfrequenzen stationär. Wenn die DFR jedoch 
zusätzliche Rückkopplungen an ihrer Position erkennt, wird ein dynamischer Filter zur Vertiefung der 
Sperrtiefe eingesetzt. 

�� Dynamische Filter - Die Sperrposition und -tiefe werden vollständig automatisch bestimmt. Ein 
dynamischer Bandsperrfilter wird bei erhöhter Rückkopplung vertieft, und wenn neue 
Rückkopplungsfrequenzen festgestellt werden, setzt die DFR die dynamischen Filter in der 
Reihenfolge von den ältesten zu den neuesten neu ein. 

Die DFR gestattet die Wahl, wie viele der Gesamtzahl der Bandsperrfilter fest bleiben und wie viele bei 
Erkennen von Rückkopplung dynamisch zugewiesen werden. In Eingangskanälen für stationäre Mikrofone 
sollte eine größere Anzahl von festen Filtern verwendet werden. In diesem Fall bestimmt die Raumakustik 
die dominanten Rückkopplungsfrequenzen, die sich nicht merklich verändern. In Eingangskanälen für 
drahtlose oder Hand-Mikrofone sollte eine größere Anzahl von dynamischen Filtern verwendet werden. In 
dieser Situation verändern sich die Rückkopplungsfrequenzen drastisch, wenn der Benutzer des Mikrofons 
sich im Raum oder auf der Bühne bewegt.  

Das zahlenmäßige Verhältnis der festen zu den dynamischen 
Filtern lässt sich mit einer der beiden nachstehend beschriebenen 
Techniken bestimmen:  

So wird das Dialogfeld „Fixed/Dynamic Filter Options“ 
(Optionen für feste/dynamische Filter) verwendet: 

1. [Options>Fixed filters allocation] (Optionen>Feste Filter 
zuweisen) im Menü des DFR-Fensters wählen. 

2. Das Dialogfeld „Fixed/Dynamic Filter Options“ (Optionen für 
feste/dynamische Filter) wird eingeblendet. 

3. Die Anzahl der festen Filter eingeben, die zugewiesen werden 
sollen. Die Anzahl der dynamischen Filter ändert sich 
entsprechend. 

4. Auf [OK] klicken. 

So wird die Filterzuweisung mit der Maus geändert: 
1. Den Cursor zwischen die roten Klammern anordnen, wie in 

Abbildung 42 dargestellt. 
2. Der Cursor ändert seine Form zum Symbol für horizontale 

Größenänderung: 
3. Klicken und nach links ziehen, um die Anzahl der dynamischen 

Filter zu erhöhen, oder nach rechts, um die Anzahl der 
festen Filter zu erhöhen. 

Filter mit hohem bzw. niedrigem Q-Faktor 
Die DFR bietet zwei Breitenoptionen für Bandsperrfilter, wie 
unten in Abbildung 43 dargestellt. Filter mit hohem Q-Faktor 
bleiben schmal, wenn die Filtertiefe zunimmt, sodass nur ein 
minimaler Signalanteil gedämpft wird. Hierdurch wird eine hohe 
Klangqualität erhalten, die für die meisten Anwendungen 
einschließlich Musik geeignet ist. 

Bei der Einstellung eines niedrigen Q-Faktors behält die 
Filterkerbe bei der Vertiefung ihre Form bei, wodurch der Bereich 
der Frequenzdämpfung größer wird. Diese Einstellung ergibt 
eine bessere Systemstabilität auf Kosten einer geringfügig 
beeinträchtigten Klangqualität. Diese Einstellung ist für Anwendungen ausschließlich für Sprache geeignet. 

�� Zum Ändern der Einstellungen für einen vorhandenen Filter den Filter durch Klicken wählen und 
dann das Pulldown-Menü [Type] (Typ) verwenden. 

�� Im Menü [Options] wählen, ob alle neu eingesetzten dynamischen Filter den hohen oder 
niedrigen Q-Faktor erhalten sollen. 

Abbildung 41 - Optionen für  
feste/dynamische Filter 

Abbildung 42 - Ändern der 
Filterzuweisung mit der Maus 

Cursor hier positionieren ... 

... oder hier

Abbildung 43 - Breitenoptionen  
für Bandsperrfilter 

Hoher Q-Faktor 

Niedriger Q-Faktor
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Filter hinzufügen, ändern und entfernen 

So wird ein fester Bandsperrfilter manuell eingesetzt oder geändert: 
1. Einen aktiven festen Filter (gelb markiert) durch Klicken wählen oder, um einen neuen Filter zu 

aktivieren, den Filter unmittelbar rechts neben dem letzten aktiven Filter wählen. 
2. Die Frequenz, die Tiefe und den Typ nach Erfordernis einstellen. 
3. Die Änderungen wirken sich im Frequenzgang-Diagramm aus. 

Hinweis: Nur ein aktiver Filter oder der nächste inaktive Filter von links nach rechts kann gewählt werden. 

So werden alle aktiven Bandsperrfilter entfernt: 
1. Auf die Schaltfläche [Clear] (Löschen) klicken. 
2. Das Dialogfeld „Clear Options“ (Optionen für Löschen) wird 

eingeblendet. 
3. [Clear All Filters] (Alle Filter löschen) wählen und auf [OK] 

klicken. 
4. Dadurch werden alle Bandsperrfilter entfernt, sodass das 

Frequenzgang-Diagramm linear wird. 

- ODER - 

1. Die Menüoption [Edit>Select All] (Bearbeiten>Alles auswählen) 
wählen. 

2. Alle eingesetzten Filter werden rosa markiert, um anzuzeigen, dass sie gewählt sind. 
3. Die Taste ENTF drücken. 

So werden einzelne Bandsperrfilter entfernt: 
1. Auf einen Filter klicken, um ihn zu wählen, oder mit STRG+Klicken mehrere Filter wählen. 
2. Die Taste ENTF drücken. - ODER - 

Auf die Schaltfläche [Clear] (Löschen) klicken, um das Dialogfeld „Clear Options“ (Optionen für Löschen) 
einzublenden, und die Option [Clear One Filter] (Einen Filter löschen) wählen, die auch für mehrere 
gewählte Filter wirksam ist. 

Kopieren und Einfügen 
Die Einstellungen für Bandsperrfilter können zwischen DFR-Prozessorfenstern kopiert und eingefügt werden.  

So werden Filter kopiert und eingefügt: 
1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter wählen: 

�� STRG+Klicken 
�� Menüoption [Edit>Select All] (Bearbeiten>Alles auswählen) 

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) wählen. 
3. Das DFR-Prozessorfenster öffnen, in das die Filtereinstellungen eingefügt werden sollen. 
4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) wählen. 

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre 
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rückgängig zu 
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter 
außerhalb des Auswahlbereichs klicken. 

Die System-Prozessor-Software bietet außerdem die besondere Möglichkeit, aktive Filter aus dem DFR-
Fenster in das Fenster eines parametrischen Equalizers (PEQ oder PEQ + CS) zu kopieren. Indem feste Filter 
in ein PEQ-Fenster verschoben werden, können mehr dynamische Filter im DFR-Block zugewiesen werden.  

Hinweis: DFR-Filter, die in einen PEQ-Block kopiert wurden, stimmen unter Umständen nicht 
genau mit dem ursprünglichen Filter überein, sondern verwenden eine Bandbreite, die 
der des ursprünglichen Filters am nächsten liegt. 

Abbildung 44 - Dialogfeld „Clear Options“ 
(Optionen für Löschen) 
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Gate/Abwärts-Expander 
Gates und Abwärts-Expander reduzieren den Ausgangspegel des Signals relativ zum Eingangspegel, nachdem der 
Eingangspegel unter einen bestimmten Schwellwert abfällt. 

Blockname Beschreibung 
�� DOWN EXP Abwärts-Expander 
�� GATE Gate 

Funktion 
Diese Prozessoren dienen zum Reduzieren oder Beseitigen von unerwünschten Hintergrundgeräuschen. 
Das Gate schaltet das Eingangssignal stumm, wenn es unter einen bestimmten Schwellwert abfällt. Der 
Abwärts-Expander verringert die Verstärkung langsam, nachdem das Eingangssignal unter einen 
bestimmten Schwellwert abgefallen ist, und bewirkt damit eine unauffälligere Pegelreduzierung als das Gate. 
Das Gate ist ideal, wenn niedrigpegelige Geräusche beseitigt werden müssen, die sonst vom 
Programmmaterial ablenken würden. Der Abwärts-Expander bietet sich in Situationen an, um das 
Hintergrundgeräusch etwas zu reduzieren, in denen eine vollständige Beseitigung des Signals als 
Unterbrechung des Programms auffallen würde. 

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente des Abwärts-Expanders und 
Gates, wobei der oben in Abbildung 45 dargestellte DOWN EXP als Beispiel dient. Diese beiden 
Prozessoren sind sich sehr ähnlich in der Verwendung. Unterschiede in ihren Merkmalen und ihrer 
Funktionalität werden gegebenenfalls erwähnt. 

Übertragungskennlinie 
Die Übertragungskennlinie zeigt die Einstellungen für den Schwellwert und den Kompressionsgrad als 
grafische Elemente an, die mit der Maus positioniert werden können. Die resultierende 
Übertragungskennlinie repräsentiert die Änderung im Signalausgangspegel. 

Abbildung 45 - DOWN EXP-Fenster 

Pegelsteller Übertragungs-
kennlinie

Schwellwert-Schieberegler 

Kompressionsgrad-Schieberegler 

Verstärkungsreduzierungs- 
Anzeige 

Übertragungskennlinien-Anzeige 
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Übertragungskennlinien-Anzeige 
Im Live-Modus stellt die Anzeige die Eingangspegel und relativen Ausgangspegel des Signals dar, sodass 
die Auswirkungen des Prozessors auf das jeweilige Programmmaterial ersichtlich sind. Diese Funktion kann 
mit der Menüoption [Options>Transfer Curve Meter] (Optionen>Übertragungskennlinien-Anzeige) aus- und 
eingeschaltet werden. In der Voreinstellung ist sie eingeschaltet. 

Hinweis: Wenn viele Anzeigen in der System-Prozessor-Software aktiv sind, kann die Leistung 
der Software beeinträchtigt sein. Die Übertragungskennlinien-Anzeige oder die 
Verstärkungsreduzierungs-Anzeige können einzeln oder beide im Menü [Options] 
ausgeschaltet werden. 

Schwellwert-Schieberegler 
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser 
Schieberegler am oberen Rand der Übertragungskennlinie kann mit der Maus nach links und rechts gezogen 
werden, um die Schwellwert-Einstellung zu ändern. 

Kompressionsgrad-Schieberegler 
Die Position des Kompressionsgrad-Schiebereglers entspricht der Einstellung der Kompressionsgrad-
Steuerung. Dieser Schieberegler am unteren Rand der Übertragungskennlinie kann mit der Maus nach links 
und rechts gezogen werden, um die Kompressionsgrad-Einstellung zu ändern. 

Verstärkungsreduzierungs-Anzeige 
Hier wird die gesamte Pegelanhebung oder -abschwächung angezeigt, die im Eingangssignal mit den 
jeweiligen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption [Options>Gain 
Reduction Meter] (Optionen>Verstärkungsreduzierungs-Anzeige) aus- und eingeschaltet werden. In der 
Voreinstellung ist sie eingeschaltet. 

Pegelsteller 
Mit den Pegelstellern werden die Ein- und Ausgangssignalpegel eingestellt. Der Bereich der verfügbaren 
Verstärkungswerte liegt zwischen -12 dB und +12 dB in Schritten von 0,5 dB mit 0 dB als Voreinstellung. Der 
Wert kann mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 erklärt werden. 

Anzeige Schwellwert überschritten 

 Signalpegel hat den Schwellwert überschritten 

 Signalpegel hat den Schwellwert nicht erreicht 

Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet. 

Schwellwert 
Hier wird der Pegel angezeigt, unter den die Eingangssignalverstärkung fallen muss, bevor der Prozessor sie 

verringert. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen, Eingeben eines Werts 
oder Betätigung des Schwellwert-Schiebereglers am oberen Rand der Übertragungskennlinie 
geändert werden. Der verfügbare Wertebereich reicht von -80,0 VU bis 0 VU in Schritten von 0,5 

VU mit einer Voreinstellung von -65,0 VU für das Gate und -40,0 VU für den Abwärts-Expander. 

Kompressionsgrad 
Hier wird der Betrag der Verstärkungsreduzierung angegeben, der am Ausgang des Prozessors relativ zum 

Eingangspegel erreicht wird. Eine Einstellung von 4:1 bedeutet zum Beispiel, dass eine 
Verringerung von 1 dB im Pegel des Programmmaterials eine Verringerung des 
Ausgangspegels vom Prozessor von 4 dB bewirkt. Der Wert kann durch Klicken auf die 
Drehpfeil-Schaltflächen, Eingeben eines Werts oder Betätigung des Kompressionsgrad-

Schiebereglers am unteren Rand der Übertragungskennlinie geändert werden. Der verfügbare Wertebereich 
reicht von 1:1 bis INF:1 in Schritten von 1/10 mit einer Voreinstellung von INF:1 für das Gate und 4:1 für den 
Abwärts-Expander. 
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Einregelzeit 
Hier wird angegeben, wie lange der Prozessor wartet, bis er zum Arbeitspegel zurückkehrt, 
nachdem der Eingangssignalpegel den Schwellwert überschritten hat. Die verfügbaren Werte 
reichen von 1 ms bis 200 ms mit einer Voreinstellung von 2 ms für das Gate und 20 ms für 

den Abwärts-Expander. 

Abklingzeit 
Hier wird angegeben, wie lange der Prozessor benötigt, um die vorgegebene 
Pegelreduzierung zu erreichen. Der Wert kann durch Klicken auf die Drehpfeil-Schaltflächen 
oder Eingeben eines Werts geändert werden. Der verfügbare Wertebereich reicht von 50 ms 

bis 1000 s mit einer Voreinstellung von 100 ms für das Gate und 50 ms für den Abwärts-Expander.  

Halten 
Hier wird angegeben, wie lange der Prozessor wartet, bis er anfängt den Pegel zu verringern, 
nachdem der Eingangssignalpegel unter den Schwellwert gefallen ist. Der Wert kann durch 
Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines Werts geändert werden. Der 
verfügbare Wertebereich erstreckt sich von 0 ms bis 500 ms mit einer Voreinstellung von 0 ms. 

Voreinstellung 
Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird ein Signal unverändert durch den Prozessor geführt. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf die 
Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der Momentaufnahme-
Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 
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Grafischer Equalizer 
Grafische Equalizer verfügen über einen festen Satz von Breitband-Filter mit konstantem Q-Faktor, die über das 
Frequenzspektrum verteilt sind und jeweils individuelle Regler für Anhebung/Absenkung aufweisen. Der System-
Prozessor bietet die folgenden Typen von grafischen Equalizern: 

Blockname Beschreibung 
�� GEQ10  Grafischer Equalizer mit 10 Bändern 
�� GEQ30  Grafischer Equalizer mit 30 Bändern 

Funktion 
Dieser Prozessor dient für praktische Breitband-Entzerrung in Räumen. Die Gesamt-Bandbreite und die 
Bandbreite der einzelnen Filter ist vom Typ des gewählten grafischen Equalizers abhängig. Der GEQ10 
verfügt über zehn 1-Oktave-Filter zwischen 31,5 Hz und 16 kHz, während der GEQ30 dreißig 1/3-Oktave-
Filter zwischen 25 Hz und 20 kHz aufweist.  

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der grafischen Equalizer, wobei 
der oben in Abbildung 46 dargestellte GEQ10 als Beispiel dient. Die Merkmale des GEQ30 sind mit 
Ausnahme der Anzahl der Bänder und des Gesamt-Frequenzbereichs identisch.  

Frequenzband-Fader 
Die Frequenzbereich-Fader werden eingestellt, indem der Knopf mit der Maus nach oben und unten gezogen 
oder indem am gewünschten Pegel auf die Skala geklickt wird. Jedes Frequenzband kann zwischen -18 dB und 
+12 dB in Schritten von 0,5 dB abgesenkt oder angehoben werden. Für weitere Informationen zum Einstellen 
der Fader siehe den Abschnitt Fader auf Seite 31. 

Frequenzgang-Diagramm 
Diese Kennlinie ist eine grafische Darstellung der Ergebnisse der Frequenzband-Einstellungen und des 
gewählten Typs des Filter-Q-Faktors. 

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke 
im Signalflussdiagramm. 

Abbildung46 − GEQ10-Fenster 
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Frequenz 
Hier wird das Frequenzband angegeben, das eingestellt wird. Durch Klicken auf die 
Drehpfeil-Tasten kann ein anderes Frequenzband gewählt werden. Die Voreinstellung 
ist das unterste Frequenzband. 

Verstärkung 
Hier wird die aktuelle Verstärkungseinstellung des gewählten Frequenzbands 
angegeben. Der Bereich der verfügbaren Verstärkungswerte liegt zwischen -18 dB 
und +12 dB in Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Der Wert kann 
mit den Methoden verändert werden, die im Abschnitt Fader auf Seite 31 erklärt 
werden.  

Typ des Filter-Q-Faktors 
Hier wird der Typ des Filter-Q-Faktors angegeben, der für alle 
Frequenzbänder eingestellt ist. Der Wert wird über die Pulldown-Liste 
geändert. Die Voreinstellung ist „Combining“. 

Combining Die Flanken zwischen den Frequenzbändern werden gemittelt, sodass eine 
insgesamt glatte Entzerrungskurve entsteht. 

Non-Combining Die Ergebnisse der einzelnen Frequenzbandsteller werden voneinander 
isoliert, wodurch die Verstärkungsregelung unabhängiger wird. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird die Umgehung abwechselnd ein- und ausgeschaltet. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Linear 
Auf diese Schaltfläche klicken, um die Verstärkung aller Frequenzbänder auf null zu stellen. 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf 
die Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 

ASCII-Dateien 
Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in 
das Frequenzgang-Diagramm importiert werden. 

 

Kopieren und Einfügen 
Mit dem Menü [Edit] (Bearbeiten) können Frequenzband-Einstellungen zwischen grafischen Equalizer des 
gleichen Typs kopiert und eingefügt werden. 

Hinweis: Es ist nicht möglich, Einstellungen zwischen den Prozessoren GEQ10 und GEQ30 
zu kopieren. 
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Parametrischer Equalizer 
Parametrische Equalizer gestatten es, die Anordnung, den Typ und die Bandbreite von mehreren Filtern an 
beliebigen Positionen im Frequenzspektrum zwischen 25 Hz und 20 kHz vorzugeben. Der System-Prozessor bietet 
die folgenden Typen von parametrischen Equalizern: 

Blockname Beschreibung 

��PEQ3 
��PEQ5 
��PEQ7 
��PEQ10 

Diese Prozessoren verfügen nur über Spitzenwert-/Bandsperrfilter. 

��PEQ3+CS 
��PEQ5+CS 
��PEQ7+CS 
��PEQ10+CS 

Diese Prozessoren verfügen über Spitzenwert-/Bandsperrfilter sowie 
einen Niederfrequenz-Filter mit steilflankiger oder Kuhschwanz-
Charakteristik oder einen Hochfrequenz-Filter mit steilflankiger oder 
Kuhschwanz-Charakteristik. 

Hinweis: Die Zahl im Blocknamen gibt die maximale Anzahl der für diesen Prozessor verfügbaren 
Spitzenwert-/Bandsperrfilter an.   

Funktion 
Dieser Prozessor dient für präzise Entzerrung des Raum-Frequenzgangs ohne unnötige Beeinträchtigung 
der benachbarten Frequenzen. Einen parametrischen Equalizer danach wählen, wie viele Frequenzbänder 
eingestellt werden müssen und ob der Prozessor Filter mit steilflankiger oder Kuhschwanz-Charakteristik 
enthalten soll. Wenn nur so wenig Filter eingesetzt werden, wie wirklich gebraucht werden, lässt sich DSP-
Kapazität einsparen. 

Merkmale des Parameterfensters 
Dieser Abschnitt erläutert die Funktionen und Parameter-Bedienelemente der parametrischen Equalizer, 
wobei der in Abbildung 47 auf der vorherigen Seite dargestellte PEQ3+CS als Beispiel dient. Die Merkmale 
der anderen parametrischen Equalizer unterscheiden sich hiervon nur in der Anzahl der Bänder und der 
Verfügbarkeit von Filtern mit steilflankiger/Kuhschwanz-Charakteristik. 

Abbildung 47 - PEQ3+CS-Fenster 

Filter-Ziehpunkt 

Frequenzgang-
Plotter

Schwellwert-Schieberegler Filterpunkt 

Frequenzgang-
Diagramm
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Frequenzgang-Plotter 
Dies ist der Bereich des Parameterfensters, in dem parametrische Filter angeordnet und eingestellt werden. Die 
Spitzenwert-/Bandsperrfilter werden grafisch als Punkte und die Filter mit steilflankiger/Kuhschwanz-
Charakteristik als quadratische Ziehpunkte dargestellt. Beim ersten Öffnen des Prozessorfensters enthält der 
Frequenzgang-Plotter keine Filterpunkte, und die Filter mit steilflankiger/Kuhschwanz-Charakteristik, falls 
verfügbar, erscheinen in ihren Voreinstellpositionen. Durch Klicken auf einen Filterpunkt oder Ziehpunkt wird 
seine Frequenzgang-Kennlinie angezeigt und es können Einstellungen vorgenommen werden. Für 
Anweisungen zum Hinzufügen von Filterpunkten siehe den Abschnitt auf Seite 68. 

Frequenzgang-Diagramm 
Diese Kennlinie ist eine grafische Darstellung der kombinierten Ergebnisse der Filterpunkte und Ziehpunkte 
im Frequenzgang-Plotter. 

Hinweis: Die Kurve enthält nicht die summierten Wirkungen der verschiedenen Prozessorblöcke 
im Signalflussdiagramm. 

Filterpunkte 
Spitzenwert-/Bandsperrfilter werden im Frequenzgang-Plotter als Filterpunkte mit einstellbaren Bandbreiten-
Steuerelementen an beiden Seiten dargestellt. Einmal auf einen Filterpunkt klicken, um ihn zu wählen, und 
dann seine Einstellungen mit der Maus, den Tastatur-Tasten oder den Wertefeldern ändern. Wenn ein 
Filterpunkt gewählt wird, wird seine Frequenzgang-Kennlinie grün im Frequenzgang-Plotter relativ zu null 
angezeigt. 

Filter mit steilflankiger/Kuhschwanz-Charakteristik 
Die Hoch- und Niederfrequenz-Filter mit steilflankiger/Kuhschwanz-Charakteristik werden als quadratische 
Ziehpunkte angezeigt. Jeder Ziehpunkt lässt sich abhängig von seiner vertikalen Position im Frequenzgang-
Plotter als Filter mit steilflankiger oder Kuhschwanz-Charakteristik einsetzen. Beim ersten Öffnen des 
Parameterfensters fungieren die Ziehpunkte als Hoch- und Niederfrequenz-Filter mit Kuhschwanz-
Charakteristik mit einer Voreinstellung von 0 dB bei 20 kHz bzw. 25 Hz. Sie verwandeln sich in Filter mit 
steilflankiger Charakteristik, wenn sie zum unteren Rand des Frequenzgang-Plotters gezogen werden.  

Frequenz 
Hier wird die Frequenz des gewählten Filterpunktes angezeigt. Der Wert kann durch 
Klicken auf die Drehpfeil-Schaltflächen, Verwendung von Tasten der Tastatur oder 
Eingeben eines Werts geändert werden. Der Frequenzbereich reicht von 25 Hz bis 20 
kHz mit einer Voreinstellung von 1 kHz, wenn ein neuer Filterpunkt hinzugefügt wird. 

Breite/Flanke/Typ 
Dieser Regelbereich ändert sich in Abhängigkeit vom Typ des gewählten Filters, wie unten angeführt. Für 
einen Filter mit steilflankiger Charakteristik bietet das Pulldown-Menü zwei Flanken zur Auswahl. Wenn ein 
Spitzenwert-/Bandsperrfilter gewählt ist, kann das Pulldown-Menü mit voreingestellten Werten verwendet 
oder die Breite innerhalb einer tausendstel Oktave eingegeben werden. Dieses Steuerelement enthält keine 
Einstellungen für Filter mit Kuhschwanz-Charakteristik. 

Filtertyp Darstellung Wertebereich 

Spitzenwert-
/Bandsperrfilter  

 

Von 1/70 Okt. bis 4 Okt., Voreinstellung: 2/3 Okt. 
Von 100,99 Q bis 0,27 Q, Voreinstellung: 2,14 Q 

Steilflankige 
Charakteristik  -6 dB/Okt. und -12 dB/Okt., Voreinstellung: -6 dB/Okt. 

Kuhschwanz-
Charakteristik  Keine 
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Verstärkung 
Hier wird die aktuelle Verstärkungseinstellung des gewählten Filters angegeben. Der 
Bereich der verfügbaren Verstärkungswerte liegt zwischen -18 dB und +18 dB in 
Schritten von 0,5 dB mit einer Voreinstellung von 0 dB. Beim Arbeiten mit einem 

Filter mit steilflankiger Charakteristik ist dieses Steuerelement deaktiviert, dann wird das Wort „CUT“ 
angezeigt. 

Neu 
Auf diese Schaltfläche klicken, um dem Frequenzgang-Plotter einen neuen Spitzenwert-
/Bandsperrfilter hinzuzufügen. Beim ersten Öffnen des Fensters gibt die Zahl unter dieser 
Schaltfläche die Anzahl der Filterpunkte an, die für den gewählten parametrischen 

Equalizer verfügbar sind. Sie verringert sich, wenn dem Frequenzgang-Plotter Filterpunkte 
hinzugefügt werden. Beim Erreichen der maximalen Anzahl von Filtern für den Prozessor wird die 
Schaltfläche deaktiviert. 

Löschen 
Auf diese Schaltfläche klicken, um die Filtereinstellungen zu löschen. Dann wird das Dialogfeld 
„Clear Options“ (Optionen für Löschen) eingeblendet, das die Option bietet, alle oder nur 
ausgewählte Filterpunkte aus dem Frequenzgang-Plotter zu löschen. Siehe den Abschnitt Mit 
Filtern arbeiten auf der folgenden Seite für mehr Informationen. 

Umgehung 
Durch Klicken auf diese Schaltfläche wird die Umgehung abwechselnd ein- und ausgeschaltet. Wenn die 
Umgehung aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Momentaufnahme 
Diese Funktion gestattet die Aufnahme eines Bildes der momentanen Frequenzgang-
Kennlinie, indem auf die Schaltfläche [Take] (Aufnehmen) geklickt wird. Durch Klicken auf 
die Schaltfläche [Show] (Anzeigen) wird die Aufnahme dann im Hintergrund für 
Vergleichszwecke angezeigt. Die Schaltfläche [Show] wird grün markiert, wenn die 
Momentaufnahme angezeigt wird. Für eine ausführliche Beschreibung der 
Momentaufnahme-Funktion siehe den Abschnitt Momentaufnahmen auf Seite 33. 

ASCII-Dateien 
Auf Seite 76 wird beschrieben, wie Daten mit Hilfe von SIA Smaart und Gold Line TEF in 
das Frequenzgang-Diagramm importiert werden. 

 

Mit Filtern arbeiten 
Beim ersten Öffnen des Parameterfensters eines 
parametrischen Equalizers befinden sich keine Spitzenwert-
/Bandsperrfilter im Frequenzgang-Plotter. Filterpunkte 
können nach Bedarf hinzugefügt werden, bis die für den 
gewählten Prozessorblock verfügbare maximale Anzahl 
erreicht ist. 

So wird ein neuer Filterpunkt hinzugefügt: 
1. Auf die Schaltfläche [New] (Neu) klicken. 
2. Ein Filterpunkt erscheint bei 0 dB mit einem Frequenz-

Voreinstellwert von 1 kHz und einer Bandbreite von 2/3 
Oktave. Abbildung 48 - Dialogfeld „Clear Options“  

(Optionen für Löschen) 
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So werden alle Filterpunkte entfernt: 
1. Auf die Schaltfläche [Clear] (Löschen) klicken oder [Edit>Clear Filters] (Bearbeiten>Filter 

löschen) aus der Menüzeile des Parameterfensters wählen. 
2. Das Dialogfeld „Clear Options“ (Optionen für Löschen) wird eingeblendet. 
3. [Clear All Filters] (Alle Filter löschen) wählen und auf [OK] klicken. 
4. Dadurch werden alle Filterpunkte aus dem Frequenzgang-Plotter entfernt und die Filter mit 

steilflankiger/Kuhschwanz-Charakteristik auf ihre Voreinstellungen zurückgesetzt. 

So werden ausgewählte Filterpunkte entfernt: 
1. Auf einen Filterpunkt klicken, um ihn zu wählen, oder mit STRG+Klicken mehrere Filter wählen. 
2. Die Taste ENTF drücken. - ODER - Auf die Schaltfläche [Clear] (Löschen) klicken, um das 

Dialogfeld „Clear Options“ (Optionen für Löschen) einzublenden, und die Option [Clear One 
Filter] (Einen Filter löschen) wählen, die auch für mehrere gewählte Filter wirksam ist. 

Hinweis: Es ist nicht möglich, die Ziehpunkte von Filtern mit steilflankiger/Kuhschwanz-
Charakteristik zu entfernen, sie können aber mit [Clear] oder ENTF auf ihre 
Voreinstellungen zurückgesetzt werden. 

Filter im Frequenzgang-Plotter einstellen 
Filtereinstellungen können durch Ziehen der Filterpunkte und Ziehpunkte mit der Maus geändert werden. 

So werden Verstärkung und Frequenz eingestellt: 
1. Den Cursor über die Mitte des Filterpunktes oder Ziehpunktes bringen. 
2. Der Cursor ändert seine Form zum Symbol für Verschieben: 
3. Klicken und den Filter nach links oder rechts ziehen, um die Frequenz einzustellen, oder nach 

oben oder unten, um die Verstärkung einzustellen. 

Hinweis: Der Frequenzgang-Plotter zeigt nur für den gewählten Filter eine Kennlinie an. Die 
kombinierte Kennlinie wird im Frequenzgang-Diagramm angezeigt. 

So wird die Filterpunkt-Bandbreite eingestellt: 
1. Den Cursor über einen der Bandbreiten-Steuerpunkte des Filters bringen. 
2. Der Cursor ändert seine Form zum Symbol für horizontale Größenänderung: 
3. Klicken und den Steuerpunkt nach links oder rechts ziehen, um die Bandbreite einzustellen. 

Feinregelung von Parametern 
Die Parameter für den gewählten Filterpunkt können mit den nachstehend beschriebenen Methoden präzise 
eingestellt werden. 

�� Eingabe von Werten in die Parameterfelder 
�� Betätigung der Drehpfeil-Tasten (oder des Dropdown-Feldes) neben den Parameterfeldern 
�� Verwendung der Tastatur-Tasten 



Modulare Prozessoren 

SHURE System-Prozessor P4800 Software-Bedienungsanleitung Seite 70 von 108 

Tasten der Tastatur 
Mit den folgenden Tasten der Tastatur können Feineinstellungen für den jeweils gewählten Filter 
vorgenommen werden. 

Taste Ergebnis 

← Verringert die Frequenz um einen Bildschirm-Bildpunkt 

→ Erhöht die Frequenz um einen Bildschirm-Bildpunkt 

↑ Erhöht die Verstärkung um 0,5 dB 

↓ Verringert die Verstärkung um 0,5 dB 

UMSCHALTTASTE mit ← Verringert die Frequenz um 1/3 Oktave 

UMSCHALTTASTE mit → Erhöht die Frequenz um 1/3 Oktave 

STRG mit ← Verringert die Bandbreite eines Filterpunktes in kleinen Schritten 

STRG mit → Vergrößert die Bandbreite eines Filterpunktes in kleinen Schritten 

UMSCHALTTASTE mit ↑  
oder BILD-AUF-TASTE Erhöht die Verstärkung um 3 dB 

UMSCHALTTASTE mit ↓  
oder BILD-AB-TASTE Verringert die Verstärkung um 3 dB 

LEERZEICHENTASTE  oder Klicken  
mit der rechten Maustaste Stellt die Verstärkung auf 0 dB ein 

Hinweis: Durch Ändern der Frequenz um einen Bildschirm-Bildpunkt ändert sich der Wert um 
etwa 1/100 einer Oktave oder 1 %.  

Kopieren, Ausschneiden und Einfügen 
Filterpunkte können zwischen Fenstern von parametrischen Equalizern kopiert, ausgeschnitten und 
eingefügt werden, wobei folgendes zu berücksichtigen ist: 

�� Im Parameterfenster, in das eingefügt werden soll, muss eine ausreichende Anzahl von 
verfügbaren Filterpunkten vorhanden sein. 

�� Die Einstellungen von Filtern mit steilflankiger/Kuhschwanz-Charakteristik können nur zwischen 
PEQ+CS-Prozessoren kopiert und eingefügt werden. 

Hinweis: Der Befehl „Cut“ (Ausschneiden) ist nicht für die Ziehpunkte von Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik verfügbar. 

So werden Filter kopiert und eingefügt: 

1. Durch Klicken einen Filter wählen oder mit einer der nachstehenden Methoden mehrere Filter 
wählen: 
�� STRG+Klicken 
�� Menüoption [Edit>Select All] (Bearbeiten>Alles auswählen) 

2. Die Menüoption [Edit>Copy] (Bearbeiten>Kopieren) wählen. 

3. Das Parameterfenster des parametrischen Equalizers öffnen, in das die Filtereinstellungen 
eingefügt werden sollen. 

4. Die Menüoption [Edit>Paste] (Bearbeiten>Einfügen) wählen. 

Hinweis: Wenn Filter Bestandteil einer Mehrfach-Auswahl sind, werden sie rosa markiert und ihre 
Parametereinstellungen gesperrt. Um die Wahl einer Mehrfach-Auswahl rückgängig zu 
machen, auf ein beliebiges Steuerelement im Parameterfenster oder auf einen Filter 
außerhalb des Auswahlbereichs klicken. 

any control in the parameter window, or on a filter outside the selection area. 
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Ducker 
Der Ducker bietet ein einfaches Verfahren zur Verwendung des P4800 in einem Audiosystem, das 
Durchsagefunktionen erfordert. Wenn ein Durchsagesignal vorhanden ist, werden andere Signale vom Ducker 
abgeschwächt bzw. „untergetaucht“. 

Blockname Beschreibung 
�� DUCK Ducker 

 
Funktion 

Ziehen Sie den Ducker und legen Sie ihn auf einem Eingangsstreifen ab, um diesen Eingang als Durchsagesignal zu 
kennzeichnen. Wenn das Durchsagesignal die Schwelle überschreitet, dämpft der Ducker alle anderen Signale, die 
an jedem Matrixmischpunkt vorhanden sind, zu dem es geführt wird. Das Durchsagesignal wird mit Hilfe des 
Matrixmischers oder der Kontrollkästchen „Paging Channels“ (Durchsagekanäle) im Parameterfenster des Duckers 
geführt. 

Hinweis: Der Ducker kann nur auf einem Eingangskanalstreifen abgelegt werden. Nicht mehr als 
einen Ducker auf jedem Eingangskanalstreifen ablegen. 

Um zu verhindern, dass Nebengeräusche vom Durchsageeingang hörbar werden, platzieren Sie vor dem Ducker ein 
Gate in das Signalflussdiagramm. 

Merkmale des Parameterfensters 

Übertragungskennlinie 
Die Übertragungskennlinie zeigt den Schwellwert als grafisches Element an, das mit der Maus positioniert 
werden kann. 

 Übertragungskennlinien-Anzeige 
Im Live-Modus stellt diese Anzeige den Eingangspegel das Durchsagesignals dar, damit der Schwellwert 
über den Umgebungsgeräuschen eingestellt werden kann. Diese Funktion kann mit der Menüoption 
[Options>Transfer Curve] (Optionen>Übertragungskennlinie) aus- und eingeschaltet werden. In der 
Voreinstellung ist sie eingeschaltet. 
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Hinweis: Die Softwareleistung kann beeinträchtigt werden, wenn viele Messanzeigen aktiv sind. 
Die Schwellwertanzeige oder die Pegelabschwächungsanzeige können einzeln oder 
beide im Menü [Options] (Optionen) ausgeschaltet werden. 

Schieberegler Threshold (Schwellwert) 
Die Position des Schwellwert-Schiebereglers entspricht der Einstellung der Schwellwert-Steuerung. Dieser 
Schieberegler kann mit der Maus am oberen Rand des Schwellwertdiagramms nach links oder rechts 
gezogen werden. Der Schwellwert ändert sich entsprechend. 

Anzeige Gain Change (Pegelabschwächungsanzeige) 
Diese Anzeige gibt die gesamte Pegelabschwächung an, die für die durch den Ducker bedämpften Signale 
mit den aktuellen Prozessoreinstellungen bewirkt wird. Diese Funktion kann mit der Menüoption 
[Options>Gain Reduction Meter] (Optionen>Pegelabschwächungsanzeige) aus- und eingeschaltet werden. 
In der Voreinstellung ist sie eingeschaltet. 

Anzeige Threshold Exceeded (Schwellwert überschritten) 

 Signalpegel hat den Schwellwert überschritten

 Signalpegel hat den Schwellwert nicht erreicht 

Diese Anzeige leuchtet gelb, wenn das 
Eingangssignal zum Prozessorblock den 
vorgegebenen Schwellwert überschreitet. 

Attenuation (Bedämpfung) 
Hierdurch wird die Pegelabschwächung geregelt, die auf die vom Ducker bedämpften Signale angewendet 
wird, wenn das Durchsagesignal den Schwellwert überschreitet. Dieser Wert kann durch Klicken auf die 
Drehpfeil-Schaltflächen oder Eingeben eines bestimmten Werts zwischen 1 dB und -INF geändert werden. 

Threshold (Schwellwert) 
 Hierdurch wird der Verstärkungspegel geregelt, den das Durchsagesignal erreichen muss, 
bevor der Prozessor die vom Ducker bedämpften Signale abschwächt. Der Wert kann durch 
Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines bestimmten Werts zwischen +20 

dB und –60 dB geändert werden. 

Attack (Ansprechzeit) 
 Hierdurch wird die Zeit geregelt, die der Prozessor benötigt, um den Verstärkungspegel der vom 
Ducker bedämpften Signale völlig abzuschwächen, nachdem das Durchsagesignal den 
Schwellwert überschreitet. Die Ansprechzeit kann durch Klicken auf die Drehpfeil-Schaltflächen 

oder Eingeben eines bestimmten Werts geändert werden. Der Bereich verfügbarer Werte erstreckt sich von 1 bis 
5000 ms. 
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Hold (Halten) 
Hierdurch wird die Zeit geregelt, während der der Prozessor die vom Ducker bedämpften 
Signale weiterhin abschwächt, nachdem das Durchsagesignal wieder unter den Schwellwert 
abgefallen ist. Dieser Wert kann durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben 

eines bestimmten Werts geändert werden. Der Bereich verfügbarer Werte erstreckt sich von 1 ms bis 10.000 
ms. 

Release (Freigabe) 
 Hierdurch wird die Zeit geregelt, die der Prozessor benötigt, um den vorherigen Pegel der 

vom Ducker bedämpften Signale wiederherzustellen, nachdem die Haltezeit verstrichen ist. 
Dieser Wert kann durch Klicken auf die Drehpfeil-Schaltflächen oder Eingeben eines 

bestimmten Werts geändert werden. Der Bereich verfügbarer Werte erstreckt sich von 1 ms bis 10.000 ms. 

Default (Voreinstellung) 
 Durch Klicken auf diese Schaltfläche wird der Prozessor auf seine Systemvoreinstellungen 
zurückgesetzt. 

Bypass (Umgehung) 
Durch Klicken auf diese Schaltfläche passiert das Signal den Prozessorblock ohne Veränderung. Wenn die 
Umgehungsfunktion aktiv ist, wird die Schaltfläche rot angezeigt. Die Voreinstellung ist inaktiv. 

 Umgehung aktiv 

 Umgehung inaktiv 

Paging Channels (Durchsagekanäle) 
Markieren Sie das Kästchen neben jedem Ausgang, zu dem das 
Durchsagesignal geführt werden soll. Dies entspricht der Führung des 
Eingangs mit dem Ducker zu Ausgangsmischpunkten im 
Signalflussdiagramm. 
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Importieren von ASCII-Dateien aus Smaart® oder Gold Line TEF 
Software 
 Fenster für graphische Equalizer, parametrische Equalizer und Filter mit steilflankiger/Kuhschwanz-Charakteristik 
können Daten anzeigen, die in einer ASCII-Datei enthalten sind, die entweder aus einer SIA-Smaart-
Übertragungsfunktionsmessung oder einer Gold Line TEF TDS-Messung exportiert wurden. 

Funktion 
Die ASCII-Dateiimportfunktion kann zur Anzeige von Frequenz/Amplituden-Informationen, die in Smaart 
oder TEF gemessen werden, verwendet werden. Durch Umkehrung der Daten kann die Anzeige als 
visuelle Hilfe bei der Einstellung der Equalizer-Parameter verwendet werden. Die Anzeige stellt nur die 
Amplitudenwerte für Frequenzen, die in der Datei enthalten sind, dar; sie interpoliert keine Linie 
zwischen tatsächlich gemessenen Punkten. Folglich kann Leerraum in der Anzeige auftreten, 
insbesondere bei niedrigen Frequenzen. 
Die ASCII-Importfunktion ist kompatibel mit Dateien, die aus folgenden Messungen erzeugt 
wurden: 

�� Übertragungsfunktionsmessungen in SIA-Smaart® Pro (Versionen 2/x und 3.x) und SIA 
SmaartLive™. 

�� TDS-Messungen in allen Versionen von TEF™ TDS-Software für Windows und DOS. 

Speichern von Smaart-Dateien im ASCII-Format 
Zum Exportieren einer Messung mit Hilfe der Smaart-Software messen Sie im Übertragungsfunktions-
Modus. Dann wählen Sie [File>ASCII Save] (Datei>Speichern als ASCII) in der Smaart-Anwendung aus. 

Speichern von TEF-Dateien im ASCII-Format 
Zum Exportieren einer Messung mit Hilfe der TEF TDS-Software gehen Sie folgendermaßen vor: 

1. Wählen Sie [File>Save] (Datei>Speichern) innerhalb der TEF TDS-Anwendung. 

2. Geben Sie die Dateiinformationen ein, und klicken Sie auf „Save“ (Speichern). Im Fenster 
„Save TDS File“ (TDS-Datei speichern) wählen Sie „ASCII“ als Dateityp aus. 
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Merkmale des Parameterfensters 

Import 
 Klicken Sie auf diese Schaltfläche, um ASCII-Dateien entweder aus Smaart oder TEF zu 

importieren. Wenn das Fenster [Open File] (Datei öffnen) erscheint, wählen Sie die zu 
importierende Datei aus. Die Daten aus der importierten Datei werden im Frequenzgang-

Diagramm angezeigt. Wird eine TEF TDS-Datei importiert, so wird die Durchschnittsamplitude bei 0 dB 
geplottet und alle anderen Amplitudenwerte sind entsprechend vorgespannt. Als Voreinstellung sind Smaart-
Übertragungsfunktionsdateien nicht versetzt. Die Amplituden werden um die 0-dB-Achse zentriert, ebenso 
wie in Smaart. 

Refresh (Aktualisieren) 
 Klicken Sie auf diese Schaltfläche, um die zuletzt importierte Datei nochmals zu importieren. 

Wenn eine neue Messung in Smaart oder TEF gemacht und mit demselben Dateinamen 
gespeichert wird, wodurch die vorherige Datei überschrieben wird, können Sie auf die Schaltfläche [Refresh] 
(Aktualisieren) klicken, um die neue Messung zu importieren, ohne den Dialog [Open File] (Datei öffnen) 
aufrufen zu müssen. 

Hinweis: Die Schaltfläche [Refresh] (Aktualisieren) ändert die Vorspannung der ursprünglichen 
Datei NICHT. Wenn sich die Durchschnittsamplitude einer TEF TDS-Datei ändert, ist die 
aktualisierte Datei immer noch um den ursprünglichen Durchschnittswert vorgespannt. 
Außerdem wird kein Offset, der der Datei mit Hilfe des Textfelds [Offset] hinzugefügt 
wird, geändert, wenn Sie auf [Refresh] (Aktualisieren) klicken. 

 Show (Anzeigen) 
Klicken Sie auf diese Schaltfläche, um die importierte Datei anzuzeigen oder zu verbergen. Die 
Schaltfläche [Show] (Anzeigen) ist grün, wenn eine Datei angezeigt wird. 

Offset 
 Hierdurch wird der Offset angegeben, um den die Anzeige von den in der ASCII-Datei 
enthaltenen tatsächlichen Amplitudenwerten versetzt ist. Als Voreinstellung wird eine TEF 
TDS-Messung um ihre Durchschnittsamplitude versetzt, damit sie um die 0-dB-Achse im 

Frequenzgang-Diagramm zentriert ist. 

Invert (Umkehren) 
Klicken Sie auf dieses Kästchen, um die angezeigten Daten um die X-Achse umzukehren. Sie 
können dann die umgekehrte Anzeige als visuelle Hilfe für die Equalizer-Parameter verwenden. 

[Invert] (Umkehren) ist als Voreinstellung ausgewählt. 

Help (Hilfe) 
Klicken Sie auf diese Schaltfläche, um auf die Online-Hilfe für das Importieren von Smaart- 
und TEF ASCII-Dateien zuzugreifen. 
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STEUERPINS ______________________________________________  
Die Pin-Anschlüsse an der Rückseite des System-Prozessors ermöglichen die externe Steuerung des Geräts und die 
Ausgabe von Logiksignalen. Externe Steuergeräte wie ein AMX, ein Crestron oder eine vom Benutzer hergestellte 
Steuervorrichtung können an die Steuereingänge angeschlossen werden. Diese Art von einfacher Geräte-Schnittstelle 
bietet den Endbenutzern die Möglichkeit, ohne den Einsatz eines Computers zwischen Presets umzuschalten, Kanäle 
stumm zu schalten oder die Verstärkung einzustellen. Der Logik-Ausgang kann mit LEDs, Relais oder Logik-Geräten 
von Drittanbieten verbunden werden, wenn die Installation externe Geräte oder Zustandsanzeigen zum Reagieren auf 
die aktiven Presets und Stummschaltung des System-Prozessors benötigt. 

Übersicht über die externe Steuerung 
Die externe Gerätesteuerung erfolgt auf drei verschiedenen Ebenen, wie unten in Abbildung 49 dargestellt. In diesem 
Beispiel ist der externe Steuereingang für Umschalten zwischen drei Presets, Einstellen der System-
Gesamtausgangsverstärkung mit einem Potentiometer und Stummschalten eines Eingangskanals mit einem 
einrastenden Schalter konfiguriert. Der Logik-Ausgang ist so konfiguriert, dass er externe Geräte in Abhängigkeit vom 
aktiven Preset aktiviert und den Stummschaltstatus eines Eingangskanals über eine LED anzeigt. 
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1. Externe Anschlüsse 
Bei der Erstinstallation des Geräts sollte entschieden werden, welche Art von Steuereingang und 
Logikausgang die Installation erfordert, dann werden die Blockstecker-Anschlussklemmen entsprechend 
verdrahtet. Für Anweisungen und Verdrahtungspläne siehe den Abschnitt „Steuerpin-anschlüsse“ der 
Geräte-Installationsanleitung. 

2. Pin-Konfiguration 
Im Fenster „Control Pins“ (Steuerpins) der Software-Schnittstelle den System-Prozessor so 
konfigurieren, dass er die Geräte-Steueranschlüsse einwandfrei erfasst. Diese Konfiguration wird als 
globale Einstellung im Gerät gespeichert und kann auch als Computerdatei gespeichert werden. Siehe 
die Anweisungen dafür im Abschnitt Pin-Konfiguration auf Seite 80. 

Abbildung 49 - Drei Ebenen der externen Gerätesteuerung 

Installationsebene

Geräteebene 

Presetebene

LOGIK-AUSGANG STEUER-EINGANG 

Prozessor-Zuordnung  

Pin-Konfiguration  

Externe Anschlüsse  
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3. Prozessor-Zuordnung 
Nachdem das Gerät zum Erkennen der externen Steuerung konfiguriert wurde, im Abschnitt für 
Prozessor-Zuordnung des Fensters „Control Pins“ den Steuerverbindungen Ein- und Ausgangskanäle 
zuordnen. Jedes Preset und jede Szene-Datei speichert eine eigene Prozessor-Zuordnungstabelle. 
Siehe die Anweisungen dafür im Abschnitt Prozessor-Zuordnung auf Seite 83. 

Das Fenster „Control Pins“ (Steuerpins) 
Das Fenster „Control Pins“ bildet eine Schnittstelle für die globale Konfiguration von Steuerpins auf der Geräteebene 
und für die Zuordnung von Prozessoren zu Steuervorrichtungen speziell für jedes Preset. Mit der Menüoption 
[Devices>Control Pins Configuration] (Geräte>Steuerpins konfigurieren) vom Hauptfenster auf dieses Fenster 
zugreifen.  

Konfigurationsansichten 
Das Fenster „Control Pins“ verfügt über zwei verschiedene Konfigurationsansichten: Steuerungs-Eingang 
und Logik-Ausgang. Auf [Control In] (Steuerungs-Eingang) oder [Control Out] (Steuerungs-Ausgang) oder 
auf die entsprechenden Pin-Steckverbinder klicken, um abhängig von den Pins, die konfiguriert werden 
sollen, zwischen den Ansichten umzuschalten.  

CONTROL IN 
Diese Ansicht dient zum Konfigurieren und Zuordnen der Steuerungs-Eingangsstifte, um die folgenden 
Funktionen über externe Geräte durchzuführen: 

�� Umschalten zwischen den im Gerät gespeicherten Presets 
�� Kanäle stumm schalten und ihre Stummschaltung aufheben 
�� Verstärkungspegel einstellen 

LOGIC OUT 
Diese Ansicht dient zum Konfigurieren und Zuordnen der Logik-Ausgangsstifte, um die folgenden Zustände 
an externe Anzeigen oder Geräte zu übertragen: 

�� Preset-Nummer des aktiven Presets 
�� Stummschaltungszustand eines Ein- oder Ausgangskanals 

Abbildung 50 - Fenster „Control Pins“ (Steuerpins): Ansicht „Control In“ (Steuer-Eingang) 
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Parametereinstellungen für Preset-Codierung 
Diese Parameterfelder werden neben [Control In] und [Logic Out] im oberen Bereich des Fensters „Control 
Pins“ eingeblendet. Die kombinierten Einstellungen in diesen Feldern bestimmen die Konfiguration des 
Preset-Steuerblocks. Zuerst die Anzahl der Presets eingeben und dann einen Codierungstyp wählen. 

Hinweis: Es bestehen Einschränkungen hinsichtlich der Verwendung von Codierungstypen in 
Kombination mit der angegebenen Anzahl der Presets. Für weitere Informationen siehe 
den Abschnitt Preset-Codierungstypen auf Seite 81. 

# Presets 
Hier wird die Anzahl der Presets im Gerät angegeben, auf die mit externen Geräten in der 
gegebenen Konfigurationsansicht zugegriffen werden soll. Der Wertebereich reicht von 0 bis 128 
mit einer Voreinstellung von null. 

Codierungstyp 
Hier wird der Codierungstyp angegeben, der für die Preset-Steuerung verwendet werden 
soll. Die verfügbaren Werte unterscheiden sich in Abhängigkeit von der Anzahl, die in das 
Wertefeld [# Presets] (Anzahl der Presets) eingegeben wurde, wie unten im Abschnitt 
„Codierungstypen“ weiter erläutert wird. Die Voreinstellung ist „keiner“. 

Schaltfläche „More Info“ (Weitere Informationen) 
Durch Klicken auf diese Schaltfläche wird auf die Hilfethemen des Fensters „Control Pins“ zugegriffen. 

Pin-Konfigurationsabschnitt 
Dieser Fensterabschnitt dient zum Konfigurieren des System-Prozessors für einwandfreies Erkennen von 
Steuerpin-Verbindungen mit externen Geräten. Beim ersten Öffnen des Fensters sind alle Verbindungen 
deaktiviert und gibt es keine Unterscheidung zwischen den Funktionen der Pins. Nach der Festlegung, wie 
viele Pins gegebenenfalls für Preset-Steuerung verwendet werden sollen, werden diese Verbindungen in der 
Anzeige einem Preset-Steuerblock zugeteilt, und etwaige restliche Pins können der Prozessorsteuerung 
zugeordnet werden. 

Hinweis: Im Live-Modus können keine Änderungen der Pin-Konfiguration mit Ausnahme von 
Deaktivierung und Aktivierung von Verbindungen vorgenommen werden. Einrichten und 
Änderung der Pin-Konfiguration sind nur im Design-Modus möglich. 

Diese Einstellungen werden auf der Geräteebene gespeichert. Sie werden nicht zusammen mit Presets oder 
Szene-Dateien gespeichert und ändern sich beim Umschalten zwischen Presets im Gerät nicht. Diese 
Konfiguration kann als Computerdatei gespeichert werden, wenn der System-Prozessor beim Arbeiten nicht 
angeschlossen ist, oder für Datensicherung und Archivierungszwecke. 

Preset-Steuerblock 
Anfänglich wird kein Preset-Steuerblock im Fenster angezeigt. Nach der Eingabe von Einstellungen in den 
Parameterfeldern [# Presets] und [Encoding Type] wird er links vom Steuerpin-Abschnitt des Fensters 
eingeblendet. Die Pin-Verbindungen können abwechselnd aktiviert und deaktiviert werden, indem mit der 
linken Maustaste auf den Block geklickt oder [Disable] (Deaktivieren) aus dem Pulldown-Menü an der 
rechten Seite des Blocks gewählt wird. Für weitere Informationen über Preset-Codierung siehe den Abschnitt 
Preset-Codierungstypen auf Seite 81. 

Hinweis: Nachdem das Gerät für externe Preset-Steuerung konfiguriert wurde, können Presets 
erst wieder vom Computer geändert werden, nachdem die Presetsteuerungs-
Verbindung im Fenster „Control Pins“ deaktiviert wurde. 
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Verbindungsblöcke 
Die Anzahl der Verbindungsblöcke, die im Fenster erscheinen, hängt davon ab, wie viele Pins nach der 
Einstellung der Preset-Steuerung noch verfügbar sind. Einer Pin-Verbindung können verschiedene 
Steuereinheiten oder Logik-Ausgänge zugewiesen werden, indem eine Wahl aus dem Pulldown-Menü an 
der rechten Seite des Blocks vorgenommen wird. Die Pin-Verbindungen können abwechselnd aktiviert und 
deaktiviert werden, indem mit der linken Maustaste auf den Block geklickt oder [Disable] (Deaktivieren) aus dem 
Pulldown-Menü gewählt wird.  

Prozessor-Zuordnungsabschnitt 
In diesem Fensterabschnitt wird für jedes Preset bestimmt, welche Prozessoren die externen Geräte 
ansprechen. Die Ein- und Ausgangskanäle des Presets erscheinen in einer Spalte unter jedem Pin-
Zuweisungsblock, der einer Steuereinheit oder einem Logik-Ausgang zugeordnet wurde. Die Prozessor-
Zuordnung kann im Live- oder Design-Modus erfolgen. Im Live-Modus ist die Titelleiste dieses 
Fensterabschnitts blau und im Design-Modus schwarz. 

Hinweis: Eine Prozessor-Zuordnung wird zusammen mit dem Preset oder der Szene-Datei 
gespeichert, daher muss eine Prozessor-Zuordnung erstellt werden, die mit der Pin-
Konfiguration des Geräts für jedes im Gerät gespeicherte Preset übereinstimmt. 

Kontrollkästchen für Prozessor-Zuordnung 
Auf ein Kontrollkästchen klicken, um den entsprechenden Ein- oder Ausgangskanal dem 
Zuweisungsblock zuzuordnen. Das Kontrollkästchen wird blau gefüllt, wenn es gewählt 
ist. Den Eingangs-Steuereinheiten können mehrere Prozessoren zugeordnet werden, 
dem Logik-Ausgang aber nur einer. Durch Klicken auf das Kontrollkästchen wird es 
abwechselnd in die Auswahl aufgenommen und daraus entfernt.  

 Prozessor-Kontrollkästchen für Zuordnung gewählt 

 Kontrollkästchen nicht gewählt 

Stummschaltungen 
Die Kanal-Stummschaltung kann durch einen einrastenden Schalter oder einen nicht 
einrastenden Schalter gesteuert werden, sie kann außerdem an den Logik-Ausgangspins 
angegeben werden. 

Abbildung 52 - 
Stummschaltungs-

Zuordnung 

Abbildung 51 - Verbindungsblöcke 

Aktivierte
Verbindung

Deaktivierte 
Verbindung 

Deaktivierte 
Verbindung 

Typen von 
Steuereinheiten:      Keine     100-kOhm-Potentiometer    Einrastender Schalter

Nicht einrastender 
Schalter 
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Verstärkungen (nur Steuereingang) 
 Die Verstärkung kann extern durch ein 100-kOhm-Potentiometer gesteuert werden. Direkt unter jedem 
Verbindungsblock, der einem Potentiometer zugeordnet ist, befindet sich eine Verstärkungsskala in der Form 
einer blauen Leiste. Der Bereich, in dem das Potentiometer den Pegel einstellt, kann von maximal -30 dB bis +30 
dB angegeben werden. Der Voreinstellbereich ist -30 dB bis 0 dB. 

Hinweis: Verwenden Sie ein logarithmisches 100-kOhm-Potentiometer mit 5 % Toleranz. Die 
meisten Potentiometer weisen 10 % oder 20 % Toleranz auf. Wenn der 
Leerlaufwiderstand des Potentiometers weniger als 95 kOhm (mehr als -5 % Toleranz) 
beträgt, hebt es den Signalverstärkungspegel nicht hinreichend an. Allerdings können 
Sie ein 10 % oder 20 % Potentiometer verwenden, sofern der tatsächliche 
Widerstandswert mehr als 95 kOhm beträgt. 

Pin-Konfiguration 
Die Pin-Konfiguration bildet die zweite Ebene der externen Steuerung und muss eingerichtet werden, bevor die 
Prozessor-Zuordnung festgelegt werden kann. Der Pin-Konfigurationsabschnitt des Fensters „Control Pins“ ist ein 
Software-Modell der Verdrahtung zur Hardware, die das Gerät erfordert, um diese Verbindungen einwandfrei zu 
erkennen. Die Konfiguration kann direkt im Gerät gespeichert werden, sie kann auch im PC gespeichert und später 
zum System-Prozessor übertragen werden. 

Hinweis: Einrichten und Änderung der Pin-Konfiguration sind nur im Design-Modus möglich. 

Eine neue Pin-Konfiguration erstellen 
1. In den Design-Modus schalten. 
2. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im 

Hauptmenü wählen. 
3. Das Fenster „Control Pins“ (Steuerpins) wird eingeblendet. 
4. Die Ansicht [Control In] (Steuerungs-Eingang) oder [Logic Out] (Logik-Ausgang) wählen. 
5. Die Preset-Steuerung konfigurieren. 

a) Die Anzahl der Presets in das Wertefeld [# Presets] eingeben. 

b) Einen Codierungstyp aus dem Pulldown-Menü [Encoding Type] wählen. 

c) Der Preset-Steuerpinblock erscheint im Pin-Konfigurationsabschnitt des Fensters. 

d) Wenn Prioritätscodierung für den Steuereingang verwendet wird, die entsprechenden Preset-
Nummern unter dem Preset-Steuerblock eingeben (siehe Abbildung 55 auf der folgenden Seite). 

6. Verbliebene Pins für externe Steuereinheiten oder einen Logik-Ausgang konfigurieren, indem 
eine Wahl aus dem Pulldown-Menü an der rechten Seite des Blocks vorgenommen wird. 

Abbildung 53 - 
Verstärkungs-

Zuordnung 

So wird der vom Potentiometer eingestellte 
Verstärkungsbereich bearbeitet: 
1. Den Cursor irgendwo entlang der Skala 

anordnen und mit der linken Maustaste 
klicken. 

2. Das Dialogfeld „Range Edit“ (Bereich 
bearbeiten) wird eingeblendet. 

3. Den Bereich der Verstärkungseinstellung 
für das angeschlossene Potentiometer 
eingeben. 

4. Auf [OK] klicken. 
5. Der neue Bereich wird durch die Länge 

der blauen Leiste angegeben.  

Abbildung 54 - Dialogfeld „Range Edit“ 
(Bereich bearbeiten) 
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7. Die Menüoption [Configuration>Store to Device] (Konfiguration>Im Gerät speichern) wählen. 
8. Das Dialogfeld „Select Devices“ (Geräte wählen) wird eingeblendet. 
9. Ein Gerät wählen und auf [OK] klicken. 
10. Die Pin-Konfiguration wird im Gerät gespeichert. 

Eine Konfiguration im PC speichern 
1. Die obigen Schritte 1 bis 6 ausführen. 

2. Die Menüoption [Configuration>Store to PC] (Konfiguration>Im PC speichern) wählen. 

3. Das Dialogfeld „Save Config As“ (Konfiguration speichern unter) wird eingeblendet. 

4. Zum gewünschten Verzeichnis gehen, einen Dateinamen eingeben und auf [OK] klicken. 

5. Die Konfiguration wird im Computer als Datei mit der Dateinamenerweiterung „.PIN“ 
gespeichert. 

Eine vorhandene Pin-Konfiguration bearbeiten 
1. In den Design-Modus schalten. 

2. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im 
Hauptmenü wählen. 

3. Das Fenster „Control Pins“ (Steuerpins) wird eingeblendet. 

4. Die Menüoption [Configuration>Recall From Device] (Konfiguration>Vom Gerät abrufen) 
wählen. 

5. Das Dialogfeld „Select Devices“ (Geräte wählen) wird eingeblendet. 

6. Ein Gerät wählen und auf [OK] klicken. 

7. Das Fenster „Control Pins“ wird mit der aktuellen Pin-Konfiguration gesetzt. 

8. Die gewünschten Änderungen vornehmen. 

9. Die Menüoption [Configuration>Store To Device] (Konfiguration>Im Gerät speichern) wählen. 

10. Das Dialogfeld „Select Devices“ (Geräte wählen) wird eingeblendet. 

11. Ein Gerät wählen und auf [OK] klicken. 

12. Die Pin-Konfiguration wird im Gerät gespeichert. 

Preset-Codierungstypen 
Gegenwärtig sind drei verschiedene Typen von Preset-Codierung für Steuereingang und zwei für 
Steuerausgang verfügbar. Einen Codierungstyp gemäß der Art der Hardware, die an die Steuerpins 
angeschlossen werden soll, der Anzahl der Presets, zwischen denen im Gerät umgeschaltet werden soll, 
und der Anzahl der Pins, die für andere Funktionen benötigt werden, wählen. 

Prioritäts- oder Eins-zu-Eins-Codierung 
Maximale Anzahl der Presets: 8 
Anzahl der erforderlichen Pins:  1 bis 8, einen für jedes Preset 

Durch Prioritäts-Codierung für Steuereingang und Eins-zu-Eins-Codierung 
für Logik-Ausgang wird jede Pin-Verbindung einer eindeutigen Preset-
Nummer zugewiesen. Dies ist die Voreinstellung für den Codierungstyp, 
wenn bis zu 8 Presets in das Wertefeld [# Presets] eingegeben werden. 

Für Steuereingang zeigt der Preset-Steuerblock unter jedem Pin ein 
Wertefeld für die Eingabe der Preset-Nummern an. Bei der ersten Anzeige 
des Blocks beginnen die Voreinstellungen bei 1 und erhöhen sich von 
links nach rechts. Diese Werte können geändert werden, indem in jedes 
Feld geklickt und eine Nummer von 1 bis 128 eingegeben wird. Falls der 
Benutzer versehentlich eine Kombination der externen Steuerschalter 
drückt, wechselt das Gerät zum Preset mit der höchsten Priorität. 

Abbildung 55 -  
Prioritäts-Codierung 
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Binäre Codierung 
Maximale Anzahl der Presets: 128 
Anzahl der erforderlichen Pins:  Siehe die rechts stehende Tabelle 

Die binäre Codierung setzt eine Binärzahl einer Preset-Nummer des 
System-Prozessors für sowohl Steuereingang als auch Logikausgang 
gleich. Dies ist die Voreinstellung für den Codierungstyp, wenn 9 oder 
mehr Presets in das Wertefeld [# Presets] eingegeben werden. 

Der Binärcode entspricht den Spannungszuständen an den Steuerpins 
an der Rückseite des System-Prozessors. 

�� Logisch 0 = Pin spannungsführend 
�� Logisch 1 = Pin massegeschlossen 

Der Binärcode, den der System-Prozessor zum Codieren von Presets 
verwendet, kann mit den nachstehenden Anweisungen berechnet 
werden, oder siehe unter Anhang A auf Seite 94 für vollständige 
Binärcodierungstabellen für einen bis sieben Pins. 

So wird die Preset-Nummer in einen Binärcode umgewandelt: 

1. Von der Preset-Nummer den Wert 1 abziehen. 

2. Das Ergebnis unter Beachtung der folgenden Regel in sein binäres Äquivalent umwandeln: 

Das höchstwertigste Bit entspricht immer dem Pin 1 und das niedrigstwertigste Bit entspricht immer dem Pin 
mit der höchsten Nummer unter denjenigen, die für Preset-Steuerung verdrahtet wurden, wie unten in 
Abbildung 56 dargestellt. 

Beispiel - Preset Nr. 7: 
�� 7 – 1 = 6 
�� 6 in Binärform = 110 

Hinweis: Für genaue Preset-Umschaltung am Steuereingang muss die binäre Codierung für jedes Preset 
die gleiche Anzahl Bits enthalten, wie Steuerpins für Preset-Codierung verdrahtet wurden. Links 
vom Binärwert Nullen hinzufügen, bis die gleiche Anzahl von Ziffern wie verdrahtete Steuerpins 
für Preset-Codierung vorhanden sind, wie oben in Abbildung 56 dargestellt. 

Benutzerdefinierte Schalter-Codierung (nur Steuereingang) 
Maximale Anzahl der Presets: 10 
Anzahl der erforderlichen Pins:  1 

Die benutzerdefinierte Schalter-Codierung für den Steuereingang setzt die 
Widerstandswerte den Preset-Nummern eins bis zehn gleich. Dieser 
Codierungstyp ist nur verfügbar, wenn ein Wert von 10 oder niedriger in das 
Wertefeld [# Presets] eingegeben wird. Aus der Tabelle 3 im Abschnitt 
„Control Pins Connections“ der Geräte-Installationsanleitung sind weitere 
Informationen darüber ersichtlich, welcher Widerstandswert welchen Preset-
Nummern entspricht.  

Nr. der Presets Nr. der 
erforderlichen Pins

2 1 

4 2 

8 3 

16 4 

32 5 

64 6 

128 7 

Abbildung 56 - Binäre Codierung von Preset Nr. 7 für drei, vier und fünf Pins 

Abbildung 57 – 
Benutzerdefinierte 
Schalter-Codierung 
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Verbindungstypen 
Pins, die nicht für Preset-Steuerung verwendet werden, können für Prozessor-Steuerung und Logik-Ausgang 
zugewiesen werden. Die folgende Tabelle veranschaulicht die verfügbaren Optionen für diese Verbindungen. 
Auf das Pulldown-Menü klicken, das durch den gelben Pfeil an der rechten Seite des Zuweisungsblocks 
gekennzeichnet ist, um einen Steuereinheitstyp zu wählen. 

Pinzuweisung Beschreibung EIN-/AUS ANG Verwendungszweck 

 
Einrastender Schalter EINGANG 

Zum Stummschalten von Ein- und Ausgangskanälen. Vorgesehen 
für Verwendung mit einer externen Steuereinheit, die zwischen zwei 
Positionen wechselt. Kann auch mit einem nicht einrastenden 
Schalter verwendet werden. In diesem Fall wird der Kanal bei 
Drücken des Schalters stumm geschaltet, bei Loslassen des 
Schalters wird die Stummschaltung aufgehoben. 

 
Nicht einrastender Schalter EINGANG 

Zum Stummschalten von Ein- und Ausgangskanälen. Vorgesehen 
für Verwendung mit einem externen nicht einrastenden Schalter. 
Bei jedem Drücken des Schalters wird die Stummschaltung 
abwechselnd ein- und ausgeschaltet. 

 
100-kOhm-Potentiometer EINGANG 

Dient zum Einstellen der Verstärkung in einem vom Benutzer 
definierten Bereich von maximal -30 dB bis +30 dB. 

 
Logikausgang AUS GANG 

Übermittelt den Status der Stummschaltung an externe 
Vorrichtungen wie LEDs, Relais oder binäre Logik-Hardware. 

Prozessor-Zuordnung 
Die Prozessor-Zuordnung ist die dritte und letzte Ebene der externen Steuerung. Damit externe Vorrichtungen die 
Verstärkung und Kanal-Stummschaltung des System-Prozessors steuern bzw. den Stummschaltungs-Status 
erkennen können, muss jedes Preset im Gerät den Steuerungsverbindungen zugeordnet werden. Prozessor-
Zuordnungstabellen werden mit den einzelnen Presets oder Szene-Dateien gespeichert. Die einzelnen Presets nach 
einer der folgenden Methoden zuordnen. 

�� Eine Vorlage erstellen, die für die einzelnen Presets als Ausgangsbasis dienen soll. 
�� Die einzelnen Presets vom Gerät abrufen und eine Prozessor-Zuordnungstabelle hinzufügen. 
�� Die einzelnen Szene-Dateien im PC öffnen und eine Prozessor-Zuordnungstabelle hinzufügen. 

Hinweis: Vor der Erstellung einer Prozessor-Zuordnungstabelle müssen die Steuerpins 
konfiguriert werden. 

Eine Prozessor-Zuordnungstabellen-Vorlage erstellen 
Wenn mehrere Presets im Gerät gespeichert werden sollen, kann beim Erstellen der Prozessor-
Zuordnungen Zeit gespart werden, indem eine Preset- oder Szene-Datei-Vorlage als Ausgangspunkt erstellt 
wird. Diese Vorlage kann die Kanalnamen, die Prozessor-Zuordnungstabelle und andere allgemeine 
Signalflusskonfigurationsdaten enthalten, die für jedes im jeweiligen Gerät gespeichertes Preset zutreffen. 

So wird eine Preset-Vorlage, die eine Prozessor-Zuordnungstabelle enthält, erstellt: 

1. Im Design-Modus die Ein- und Ausgangskanäle nach dem jeweiligen Gerät benennen. 
(Siehe die Anweisungen dafür im Abschnitt Ein- und Ausgänge kennzeichnen auf Seite 17.) 

2. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im 
Hauptmenü wählen. 

3. Das Fenster „Control Pins“ (Steuerpins) wird eingeblendet. 

4. Die gewünschte Pin-Konfiguration mit einer der folgenden Methoden laden: 
�� Die Menüoption [Configuration>Open From PC] (Konfiguration>Vom PC öffnen) wählen. 
�� Bei Anschluss am System-Prozessor die Menüoption [Configuration>Recall From Device] 

(Konfiguration>Vom Gerät abrufen) wählen. 

5. Die Ein- und Ausgangskanäle erscheinen im Fensterabschnitt mit der Prozessor-
Zuordnungstabelle unter den Verbindungsblöcken, die Steuereinheiten oder Logikausgängen 
zugeordnet wurden. 
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6. Für jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-
Kontrollkästchen neben den Kanälen klicken, auf die die Verbindung zugreift. 

7. Das Fenster „Control Pins“ schließen. 

8. Die Szene-Datei im PC speichern. (Siehe die Anweisungen dafür im Abschnitt Szene-Dateien 
auf Seite 27.) 

9. Diese Vorlage als Ausgangspunkt für alle Presets verwenden, die für das Gerät erstellt werden. 

Ein vorhandenes Preset oder eine vorhandene Szene-Datei zuordnen 
Vorhandene Presets können zugeordnet werden, nachdem sie im Gerät gespeichert wurden, und Szene-
Dateien können zugeordnet werden, nachdem sie im PC gespeichert wurden. 

So wird ein vorhandenes Preset im Live-Modus zugeordnet: 
1. Das Gerät in den Live-Modus schalten. 
2. Das Preset wählen, das zugeordnet werden soll. 
3. Das Hauptfenster schaltet in den Vorschau-Modus. 
4. Sicherstellen, dass das richtige Preset gewählt wurde, und auf [Load] (Laden) klicken. 
5. Das gewählte Preset wird aktiv. 
6. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im 

Hauptmenü wählen. 
7. Das Fenster „Control Pins“ wird eingeblendet, wobei die Ein- und Ausgangskanäle unter den 

zugewiesenen Pin-Verbindungen aufgelistet sind. 
8. Für jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-

Kontrollkästchen neben den Kanälen klicken, auf die die Verbindung zugreift. 
9. Die Zuordnung wird zusammen mit dem Preset im Gerät gespeichert.  
10. Ein anderes Preset wählen, das zugeordnet werden soll (es ist nicht erforderlich, das Fenster 

„Control Pins“ zu schließen).  

So wird eine vorhandene Szene-Datei im Design-Modus zugeordnet: 

1. Sicherstellen, dass der Design-Modus aktiv ist. 
2. Auf die Schaltfläche [Open] (Öffnen) in der Steuerleiste des Hauptfensters klicken. 

3. Das Dialogfeld „Open Scene“ (Szene öffnen) wird eingeblendet. 
4. Die Szene wählen, die zugeordnet werden soll, und auf [OK] klicken. 
5. Das gewählte Preset wird im Signalflussdiagramm angezeigt. 
6. Die Option [Devices>Control Pin Configuration] (Geräte>Steuerpin-Konfiguration) im 

Hauptmenü wählen. 
7. Das Fenster „Control Pins“ (Steuerpins) wird eingeblendet. 
8. Die gewünschte Pin-Konfiguration mit einer der folgenden Methoden laden: 

�� Die Menüoption [Configuration>Open From PC] (Konfiguration>Vom PC öffnen) wählen. 
�� Bei Anschluss am System-Prozessor die Menüoption [Configuration>Recall From Device] 

(Konfiguration>Vom Gerät abrufen) wählen. 
9. Für jeden zugewiesenen Verbindungsblock auf die Prozessor-Zuordnungstabellen-

Kontrollkästchen neben den Kanälen klicken, auf die die Verbindung zugreift. 
10. Zurück zum Hauptfenster gehen (es ist nicht erforderlich, das Fenster „Control Pins“ zu 

schließen). 
11. Die Szene-Datei im PC speichern. (Siehe die Anweisungen dafür im Abschnitt Szene-Dateien auf 

Seite 27.) 

12. Eine andere Szene-Datei öffnen, die zugeordnet werden soll. 
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SICHERHEIT _______________________________________________  
Sicherheit ist ein optionales Merkmal, mit dem die installierende Person oder ein Sicherheits-Administrator den Zugriff 
des Endbenutzers auf die Einstellungen des System-Prozessors über einen Computer einschränken kann. Der 
Administrator ist die Person, die das Gerätekennwort und die Zugangsstufe, mit dem das Gerät nach der Installation 
arbeitet, einstellt. Es bestehen drei verschiedene Zugangsstufen für das Gerät. 

Stufe 1 
Wenn das Gerät auf die Stufe 1 einstellt ist, hat der Benutzer uneingeschränkten Zugang zu den Funktionen 
des System-Prozessors mit der Ausnahme von zwei Funktionen, die immer durch das Administrator-
Kennwort geschützt sind: 

1. Einstellen der Sicherheitsstufe für das Gerät 

2. Ändern des Administrator-Kennworts 

Stufe 2 
Bei Einstellung des Geräts auf die Stufe 2 hat der Benutzer eingeschränkten Zugang, der durch den 
Sicherheits-Administrator definiert wird. Der nachstehende Zugang zum System-Prozessor kann für die Stufe 
2 zugelassen werden: 

�� Ändern von Presets über einen PC 
�� Ändern der Matrixmischer-Signalführung 
�� Zugang zum Ändern von Prozessor-Einstellungen für alle Blöcke, die nicht durch den 

Administrator gesperrt wurden (siehe den Abschnitt Sicherheit individueller Prozessoren auf 
Seite 87 für weitere Informationen) 

Stufe 3 
Diese Stufe gestattet schreibgeschützten Zugang zu den Einstellungen des System-Prozessors für das jeweils 
aktive Preset. 

Hinweis: Die Sicherheit betrifft nur den Zugang über die Software-Schnittstelle. Sie schränkt die 
Steuerung durch externe Geräte über die Steuerpins oder MIDI nicht ein. 

Gerätesicherheit einrichten 
Die Einrichtung der Sicherheit ist der letzte Schritt bei der Einrichtung des Geräts. Für die Einstellung der 
Gerätesicherheit sind zwei hauptsächliche Schritte auszuführen, wie nachstehend beschrieben. 

Ein Kennwort einrichten 
Bevor die Benutzer-Zugangsstufe im Gerät eingestellt werden 
kann, muss das Kennwort eingerichtet werden, mit dem der 
Zugang als Sicherheits-Administrator geschützt wird. 

So wird ein Kennwort eingerichtet: 
1. Das Gerät in den Live-Modus schalten. 
2. [Security>Set Password] (Sicherheit>Kennwort einstellen) aus 

dem Hauptmenü wählen. 
3. Das Dialogfeld „Create Password“ (Kennwort einrichten) wird 

eingeblendet. 
4. Ein Kennwort in das Feld [Administrator Password] 

(Administrator-Kennwort) eingeben. 
5. Durch Betätigung der Taste Tab zum Feld [Confirm Password] 

(Kennwort bestätigen) gehen und das Kennwort erneut eingeben. 
6. Die Felder [Administrator Name] (Administratorname) und [Phone or Contact info] (Telefon oder 

Kontakt-Informationen) ausfüllen. 

Hinweis: Alle Einträge im Dialogfeld „Create Password“ sind auf eine Länge von fünfzehn 
Zeichen beschränkt. 

Abbildung 58 - Dialogfeld „Create 
Password“ (Kennwort einrichten) 
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Benutzer-Zugangsstufe einstellen 
Nach dem Einrichten eines Kennworts wird das Gerät 
automatisch auf die Benutzer-Zugangsstufe 1 eingestellt. Wenn 
der Zugang zum Gerät weiter eingeschränkt werden muss, das 
Gerät auf die gewünschte Zugangsstufe einstellen.  

So wird die Benutzer-Zugangsstufe eingestellt: 

1. Das Gerät in den Live-Modus schalten. 

2. [Security>Level] (Sicherheit>Stufe) aus dem Hauptmenü 
wählen. 

3. Das Dialogfeld „Password Required“ (Kennwort erforderlich)  
wird eingeblendet. 

4. Das Kennwort eingeben und auf [OK] klicken. 

5. Das Dialogfeld „Set Security“ (Sicherheit einstellen) wird 
eingeblendet. 

6. Auf das Optionsfeld links neben der gewünschten Stufe 
klicken. 

7. Gegebenenfalls benutzerdefinierte Optionen für die Stufe 2 
vorgeben. 

8. Auf [OK] klicken. 

Gerätesicherheit ändern 
Falls Änderungen an der Gerätekonfiguration oder den Sicherheitseinstellungen notwendig werden, nachdem der Zugang 
eingeschränkt wurde, muss zuerst die Gerätesicherheit zurück auf die Stufe 1 zurückgestellt werden. 

Hinweis: Für diese Funktionen wird das Kennwort des Sicherheits-Administrators benötigt. 

Zugangsstufe ändern 
Die obigen Anweisungen zum Einstellen der Zugangsstufe ausführen. 

Das Kennwort ändern 
So wird ein vorhandenes Kennwort geändert: 

1. Das Gerät in den Live-Modus schalten. 

2. [Security>Set Password] (Sicherheit>Kennwort einstellen) 
aus dem Hauptmenü wählen. 

3. Das Dialogfeld „Set Password“ (Kennwort einstellen) wird 
eingeblendet. Der Cursor befindet sich im Feld [Old 
Password] (Altes Kennwort). 

4. Das aktuelle Kennwort eingeben. 

5. Durch Betätigung der Taste Tab zum Feld [Administrator 
Password] (Administrator-Kennwort) gehen und das neue 
Kennwort eingeben. 

6. Durch Betätigung der Taste Tab zum Feld [Confirm Password] (Kennwort bestätigen) gehen 
und das neue Kennwort erneut eingeben. 

7. Gegebenenfalls die Felder [Administrator Name] (Administratorname) und [Phone or Contact 
info] (Telefon oder Kontakt-Informationen) ändern. 

8. Auf [OK] klicken. 

Hinweis: Alle Einträge im Dialogfeld „Set Password“ sind auf eine Länge von fünfzehn 
Zeichen beschränkt. 

Abbildung 59 - Dialogfeld „Password 
Required“ (Kennwort erforderlich) 

Abbildung 60 - Dialogfeld „Set Security“ 
(Sicherheit einstellen) 

Abbildung 61 - Dialogfeld „Set Password“ 
(Kennwort einstellen) 
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Sicherheit aufheben 
Die Gerätesicherheit kann vollständig zurück auf die Voreinstellung gesetzt werden, sodass andere ein 
Administrator-Kennwort einstellen und Benutzer-Zugangsstufen definieren können. 

So wird der Kennwortschutz entfernt: 

1. Das Gerät in den Live-Modus schalten. 

2. [Security>Set Password] (Sicherheit>Kennwort einstellen) aus dem Hauptmenü wählen. 

3. Das Dialogfeld „Set Password“ (Kennwort einstellen) wird eingeblendet, wie in Abbildung 61 auf 
der vorigen Seite dargestellt. 

4. Das aktuelle Kennwort in das Feld [Old Password] (Altes Kennwort) eingeben und die 
Eingabetaste drücken oder auf [OK] klicken. 

5. Gegebenenfalls den Administratornamen und die Kontaktinformationen löschen. 

6. Die Felder [Administrator Password] (Administrator-Kennwort) und [Confirm Password] 
(Kennwort bestätigen) leer lassen. 

7. Auf [OK] klicken. 

8. Damit sind alle Zugangseinschränkungen aufgehoben. 

Hinweis: Die Sicherheitsattribute individueller Prozessorblöcke bleiben bestehen, sind aber 
unwirksam, bis das Gerät auf die Zugangsstufe 2 eingestellt wird. 

Sicherheit individueller Prozessoren 
Durch individuelle Prozessorsicherheit wird der Zugang zu bestimmten Prozessorblöcken in einem Preset gesperrt. 
Es ist möglich, den Zugang zu einem einzelnen Block, zu mehreren Blöcken oder zu allen Blöcken in einem Preset 
zu sperren. Diese Funktion kann beispielsweise verwendet werden, wenn der Endbenutzer in der Lage sein soll, 
Verstärkungseinstellungen zu ändern, aber nicht PEQ-Einstellungen. Ein gesperrter Prozessor kann immer noch 
geöffnet werden, um Pegelanzeigen zu überwachen oder Einstellungen einzusehen. 

Während die Benutzer-Zugangsstufe gerätespezifisch ist, ist die Prozessorblock-Sicherheit presetspezifisch. 
Außerdem ist die individuelle Prozessorsicherheit ein separates Attribut eines jeden Blocks. Wenn beispielsweise ein 
gesperrter Block kopiert wird, wird dieses Sicherheitsattribut mit dem Block kopiert. Dieses Attribut bleibt beim 
Arbeiten im Design-Modus und Live-Modus bestehen. 

So werden Prozessorblöcke gesperrt: 

1. Das Gerät in den Live-Modus schalten. 

2. Sicherstellen, dass das Gerät auf die Sicherheitsstufe 1 eingestellt ist. 

3. Durch Klicken einen Prozessorblock markieren oder mit Strg+Klicken mehrere Blöcke wählen. 

4. [Security>Level 2>Lock Selected] (Sicherheit>Stufe 2>Sperre gewählt) aus dem Hauptmenü 
wählen. 

5. Neben dieser Menüoption wird ein Häkchen eingetragen, um darauf hinzuweisen, dass der 
gewählte Prozessor gesperrt ist. 

6. Das Gerät auf die Benutzer-Zugangsstufe 2 einstellen. 

Hinweis: Es ist möglich, Prozessorblöcke im Design-Modus zu sperren, aber dies wird erst 
wirksam, wenn die Szene-Datei in einem Gerät als Preset gespeichert und die Sicherheit 
dieses Geräts auf die Stufe 2 eingestellt wird. 
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BERICHTE DRUCKEN _______________________________________  
Die Software des P4800 kann Berichte zur Dokumentation aller im Gerät gespeicherten Presets und Einstellungen 
drucken. Diese Berichte sind für die folgenden Zwecke vorgesehen. 

1. Dokumentation der Gerätekonfiguration für den Kunden und Endbenutzer 

2. Erstellung einer Sicherheitskopie auf Papier, sodass die Gerätekonfiguration erforderlichenfalls 
rekonstruiert werden kann 

Hinweis: Die Berichte werden direkt zu einem Drucker und nicht in eine Datei ausgegeben, 
sodass zur Verwendung dieser Funktion ein Drucker angeschlossen sein muss. 

So werden P4800-Berichte gedruckt: 

1. [File>Print] (Datei>Drucken) aus dem Hauptmenü wählen. 

2. Das Dialogfeld „Choose Report“ (Bericht wählen) wird 
eingeblendet. 

3. Auf den Bericht klicken, der gedruckt werden soll. 

4. Ein Dialogfeld wird für den gewählten Bericht eingeblendet. 

5. Die Informationen, die in den Bericht aufgenommen werden 
sollen, nach den Anweisungen im folgenden Abschnitt 
festlegen. 

6. Auf [OK] klicken. 

7. Das Windows-Dialogfeld „Print“ (Drucken) wird eingeblendet. 

P4800-Berichte 
Geräteinformationen 

Der Bericht „Device Information“ (Geräteinformationen) listet alle Informationen auf Geräteebene mit 
Ausnahme des Sicherheits-Kennworts auf. Wenn das Dialogfeld „Device Information“ eingeblendet wird, aus 
der Pulldown-Liste [Device] (Gerät) das Gerät wählen, für das ein Bericht gedruckt werden soll. Die 
Informationen für das gewählte Gerät eingeben und auf [OK] klicken. Die hier eingegebenen Informationen 
werden nur im anschließenden Bericht gedruckt, aber nicht für zukünftige Verwendung gespeichert. Für ein 
Muster dieses Berichts siehe Seite 90. 

Abbildung 62 - Dialogfeld „Choose Report“ 
(Bericht wählen) 

Abbildung 63 - Dialogfeld „Device 
Information“ (Geräte-Informationen) 
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Preset-Informationen und Informationen über das aktuelle Preset 
Der Bericht „Preset Information“ (Preset-Informationen) listet die Einzelheiten über ein bestimmtes, im Gerät 
gespeichertes Preset auf. Wenn das Dialogfeld „Preset Information“ eingeblendet wird, aus der Pulldown-
Liste [Device] (Gerät) das Gerät wählen, für das ein Bericht gedruckt werden soll. Dann das Preset wählen, 
für das ein Bericht gedruckt werden soll, und auf [OK] klicken. Für ein Muster dieses Berichts siehe Seite 91 
und 92. 

Der Bericht „Current Preset Information“ (Informationen über das aktuelle Preset) ist identisch dazu. Er 
enthält die Einzelheiten des Presets oder der Szene, das/die gerade angezeigt wird. 

Prozessor-Informationen 
Der Bericht „Processor Information“ (Prozessor-Informationen) listet die Einstellungen von einem oder 
mehreren Prozessorblöcken auf. Im Dialogfeld „Processor Information“ wird eine Liste aller festen und 
verschiebbaren Prozessoren aus der angezeigten Szene oder dem angezeigten Preset angezeigt. Einen 
Prozessor durch Klicken oder mehrere mit UMSCHALTTASTE+Klicken wählen und dann auf [OK] klicken. Für 
ein Muster dieses Berichts siehe Seite 93. 

Abbildung 66 - Dialogfeld „Processor Information“ 
(Prozessor-Informationen) 

Abbildung 64 - Dialogfeld „Preset Information“ 
(Preset-Informationen) 

Abbildung 65 - Dialogfeld „Current Preset Information“ 
(Informationen über das aktuelle Preset) 
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Muster der Berichte 

DEVICE INFORMATION 
Installation Information: 

Location: 4325 W. Division, Chicago 

Client: Sacred Heart School 

Designer: Bob Reiling 

Installer: RC Communications 

System Description: 

Main Gymnasium System Processor 

 

Hardware Information: 

ShureLink Device ID: 15 

Device Name: Gymnasium 

 

Control Input Pin Configuration: 
Pin-1: Encoding Type: Priority, Mapped to preset: 1 
Pin-2: Encoding Type: Priority, Mapped to preset: 2 
Pin-3: Encoding Type: Priority, Mapped to preset: 3 
Pin-4: Encoding Type: Priority, Mapped to preset: 4 
Pin-5: Switch 
Pin-6: Potentiometer 
Pin-7: Potentiometer 
Pin-8: NONE [DISABLED] 
 

Control Output Pin Configuration: 
Pin-1: Encoding Type: One to One, Mapped to preset: 1 
Pin-2: Encoding Type: One to One, Mapped to preset: 2 
Pin-3: Encoding Type: One to One, Mapped to preset: 3 
Pin-4: Encoding Type: One to One, Mapped to preset: 4 
Pin-5: Logic Control 
Pin-6: Logic Control [DISABLED] 
Pin-7: Logic Control [DISABLED] 
Pin-8: Logic Control [DISABLED]  
 

Preset Information: 

Total Presets: 4 

 Preset 1 Concert 

 Preset 2 Assembly 

 Preset 3 Game 

 Preset 4 Dance 

 
1 of 1 March 29, 2001, 11:11AM
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PRESET INFORMATION: 
 

Preset ID: 2 

Preset Name: Assembly 

Descripiton: Preliminary tuning. 

 

 
 

 
Control Input Pin Mapping: 
Pin-1: Reserved for Preset Control - See Device Information 
Pin-2: Reserved for Preset Control - See Device Information 
Pin-3: Reserved for Preset Control - See Device Information 
Pin-4: Reserved for Preset Control - See Device Information 
Pin-5: Mutes: Input: 2 
Pin-6: Gains: Input: 1 2 , Gain Range: -30.0 to 30.0 dB 
Pin-7: Gains: Output: 1 2 3 4 5 6 7 8 , Gain Range: -30.0 to 30.0 dB 
Pin-8: N/A 

 
Control Output Pin Mapping: 
Pin-1: Reserved for Preset Display - See Device Information 
Pin-2: Reserved for Preset Display - See Device Information 
Pin-3: Reserved for Preset Display - See Device Information 
Pin-4: Reserved for Preset Display - See Device Information 
Pin-5: Mutes: Input: 2 
Pin-6: Mutes: N/A 
Pin-7: Mutes: N/A 
Pin-8: Mutes: N/A 

 

1 of 2 March 29, 2001, 11:12AM
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Drag and Drop Processors: 
 

Input-1, Slot-1, Processor: PEQ 10CS Input-3, Slot-1, Processor: N/A  
Input-1, Slot-2, Processor: N/A  Input-3, Slot-2, Processor: N/A  
Input-1, Slot-3, Processor: N/A  Input-3, Slot-3, Processor: N/A  
Input-1, Slot-4, Processor: N/A  Input-3, Slot-4, Processor: N/A  
Input-1, Slot-5, Processor: SFT LIM  Input-3, Slot-5, Processor: N/A 
 

Input-2, Slot-1, Processor: PEQ 10CS Input-4, Slot-1, Processor: N/A  
Input-2, Slot-2, Processor: GEQ30  Input-4, Slot-2, Processor: N/A  
Input-2, Slot-3, Processor: N/A  Input-4, Slot-3, Processor: N/A  
Input-2, Slot-4, Processor: N/A  Input-4, Slot-4, Processor: N/A  
Input-2, Slot-5, Processor: N/A  Input-4, Slot-5, Processor: N/A 
 

Output-1, Slot-1, Processor: PEQ 10CS Output 5, Slot-1, Processor: PEQ 5CS 
Output-1, Slot-2, Processor: CUT/SHELF  Output-5, Slot-2, Processor: N/A  
Output-1, Slot-3, Processor: N/A  Output-5, Slot-3, Processor: N/A  
Output-1, Slot-4, Processor: N/A  Output-5, Slot-4, Processor: N/A  
Output-1, Slot-5, Processor: N/A  Output-5, Slot-5, Processor: N/A 
Output-1, Slot-6, Processor: N/A  Output-5, Slot-6, Processor: DLY 150ms 
 

Output-2, Slot-1, Processor: PEQ 5CS Output-6, Slot-1, Processor: PEQ 5CS  
Output-2, Slot-2, Processor: N/A  Output-6, Slot-2, Processor: N/A  
Output-2, Slot-3, Processor: N/A  Output-6, Slot-3, Processor: N/A  
Output-2, Slot-4, Processor: N/A  Output-6, Slot-4, Processor: N/A  
Output-2, Slot-5, Processor: N/A  Output-6, Slot-5, Processor: N/A 
Output-2, Slot-6, Processor: N/A  Output-6, Slot-6, Processor: DLY 150ms 
 

Output-3, Slot-1, Processor: PEQ 5CS Output-7, Slot-1, Processor: N/A  
Output-3, Slot-2, Processor: N/A  Output-7, Slot-2, Processor: N/A  
Output-3, Slot-3, Processor: N/A  Output-7, Slot-3, Processor: AGC  
Output-3, Slot-4, Processor: N/A  Output-7, Slot-4, Processor: SFT LIM  
Output-3, Slot-5, Processor: N/A  Output-7, Slot-5, Processor: N/A 
Output-3, Slot-6, Processor: N/A  Output-7, Slot-6, Processor: DLY 150ms 
 

Output-4, Slot-1, Processor: PEQ 5CS Output-8, Slot-1, Processor: PEQ 3CS 
Output-4, Slot-2, Processor: N/A  Output-8, Slot-2, Processor: N/A  
Output-4, Slot-3, Processor: N/A  Output-8, Slot-3, Processor: AGC  
Output-4, Slot-4, Processor: N/A  Output-8, Slot-4, Processor: LIM  
Output-4, Slot-5, Processor: N/A  Output-8, Slot-5, Processor: N/A 
Output-4, Slot-6, Processor: DLY 150ms  Output-8, Slot-6, Processor: DLY 150ms 

2 of 2 March 29, 2001, 11:12AM 
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PROCESSOR INFORMATION: 
 
Input Gain Block 
Security: Unlocked 
Input-1:, Name: Main input, Operating Level: +4 dBu, Polarity: + , Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A 
Input-2:, Name: Foyer, Operating Level: +4 dBu, Polarity: + , Gain: 8.5dB, Pad: On, Mute: Off, Link Group: N/A 
Input-3:, Name: Record AUX, Operating Level: +4 dBu, Polarity: + , Gain: 0.0dB, Pad: On, Mute: On, Link Group: N/A 
Input-4:, Name: Not used, Operating Level: +4 dBu, Polarity: + , Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A 
 
 
 
 
 
 

Input-1, Slot-1, Processor: PEQ 10CS 
Name: PEQ with CS, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Filter: L, Type: Shelf, Freq: 0.0kHz, Gain: 0.0dB, Width(oct): 
Filter: H, Type: Shelf, Freq: 20.0kHz, Gain: 0.0dB, Width(oct): 
Filter: 3, Freq: 0.1kHz, Gain: -2.0dB, Width(oct): 2/3  
Filter: 4, Freq: 2.2kHz, Gain: -6.0dB, Width(oct): 1/10 
Filter: 5, Freq: 0.3kHz, Gain: -4.5dB, Width(oct): 1/3 
Filter: 6, Freq: 5.0kHz, Gain: 2.5dB, Width(oct): 1 
Filter: 7, Freq: 2.7kHz, Gain: -3.0dB, Width(oct): 1/2  
  
 
 
 
  
  

Input-1, Slot-5, Processor: SFT LIM 
Name: Soft Limiter, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Threshold: 9.5 VU, Attack: 2ms, Ratio: 100.0, Decay: 50ms 
Input Gain: 0.00, Output Gain: 0.00 
Knee Soft 
 
 
 
 
 
 

Input-2, Slot-1, Processor: PEQ 10CS 
Name: PEQ with CS, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB, Width(oct):  
Filter: H, Type: Shelf, Freq: 10.9kHz, Gain: -18.5dB, Width(oct):  
Filter: 3, Freq: 4.3kHz, Gain: -9.0dB, Width(oct): 2/3  
Filter: 4, Freq: 0.7kHz, Gain: 4.5dB, Width(oct): 1 
Filter: 5, Freq: 0.2kHz, Gain: -9.0dB, Width(oct): 1/6 
Filter: 6, Freq: 0.1kHz, Gain: -6dB, Width(oct): 1/3 
Filter: 7, Freq: 6.8kHz, Gain: -6.0dB, Width(oct): 1/6  
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ANHANG A: TABELLEN FÜR BINÄRE CODIERUNG ______________  
Die folgenden Tabellen enthalten die Binärcodes für die Presets des System-Prozessors. Diese Codierung auf die 
Steuerungs-Eingangspins anwenden, um das Gerät zum entsprechenden Preset umzuschalten. Der System-
Prozessor gibt das jeweils aktuelle Preset an den Logikausgangspins mit dieser Codierung an. 

Binäre Codierung über ein Pin 

PRESET Nr. PIN 1 

1 O 

2 I 

Binäre Codierung über zwei Pins 

PRESET Nr. PIN 1 PIN 2 

1 O O 

2 O I 

3 I O 

4 I I 

Binäre Codierung über drei Pins 

PRESET Nr. PIN 1 PIN 2 PIN 3 

1 O O O 

2 O O I 

3 O I O 

4 O I I 

5 I O O 

6 I O I 

7 I I O 

8 I I I 
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Binäre Codierung über vier Pins 

PRESET 
Nr. 

PIN 1 PIN 2 PIN 3 PIN 4 

1 O O O O 

2 O O O I 

3 O O I O 

4 O O I I 

5 O I O O 

6 O I O I 

7 O I I O 

8 O I I I 

9 I O O O 

10 I O O I 

11 I O I O 

12 I O I I 

13 I I O O 

14 I I O I 

15 I I I O 

16 I I I I 
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Binäre Codierung über fünf Pins 

PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 

1 O O O O O 

2 O O O O I 

3 O O O I O 

4 O O O I I 

5 O O I O O 

6 O O I O I 

7 O O I I O 

8 O O I I I 

9 O I O O O 

10 O I O O I 

11 O I O I O 

12 O I O I I 

13 O I I O O 

14 O I I O I 

15 O I I I O 

16 O I I I I 

17 I O O O O 

18 I O O O I 

19 I O O I O 

20 I O O I I 

21 I O I O O 

22 I O I O I 

23 I O I I O 

24 I O I I I 

25 I I O O O 

26 I I O O I 

27 I I O I O 

28 I I O I I 

29 I I I O O 

30 I I I O I 

31 I I I I O 

32 I I I I I 
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Binäre Codierung über sechs Pins 
PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 

1 O O O O O O 

2 O O O O O I 

3 O O O O I O 

4 O O O O I I 

5 O O O I O O 

6 O O O I O I 

7 O O O I I O 

8 O O O I I I 

9 O O I O O O 

10 O O I O O I 

11 O O I O I O 

12 O O I O I I 

13 O O I I O O 

14 O O I I O I 

15 O O I I I O 

16 O O I I I I 

17 O I O O O O 

18 O I O O O I 

19 O I O O I O 

20 O I O O I I 

21 O I O I O O 

22 O I O I O I 

23 O I O I I O 

24 O I O I I I 

25 O I I O O O 

26 O I I O O I 

27 O I I O I O 

28 O I I O I I 

29 O I I I O O 

30 O I I I O I 

31 O I I I I O 

32 O I I I I I 

33 I O O O O O 

34 I O O O O I 

35 I O O O I O 

36 I O O O I I 

37 I O O I O O 

38 I O O I O I 

39 I O O I I O 

40 I O O I I I 

41 I O I O O O 

42 I O I O O I 

43 I O I O I O 

44 I O I O I I 
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 

45 I O I I O O 

46 I O I I O I 

47 I O I I I O 

48 I O I I I I 

49 I I O O O O 

50 I I O O O I 

51 I I O O I O 

52 I I O O I I 

53 I I O I O O 

54 I I O I O I 

55 I I O I I O 

56 I I O I I I 

57 I I I O O O 

58 I I I O O I 

59 I I I O I O 

60 I I I O I I 

61 I I I I O O 

62 I I I I O I 

63 I I I I I O 

64 I I I I I I 
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Binäre Codierung über sieben Pins 
PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

1 O O O O O O O 

2 O O O O O O I 

3 O O O O O I O 

4 O O O O O I I 

5 O O O O I O O 

6 O O O O I O I 

7 O O O O I I O 

8 O O O O I I I 

9 O O O I O O O 

10 O O O I O O I 

11 O O O I O I O 

12 O O O I O I I 

13 O O O I I O O 

14 O O O I I O I 

15 O O O I I I O 

16 O O O I I I I 

17 O O I O O O O 

18 O O I O O O I 

19 O O I O O I O 

20 O O I O O I I 

21 O O I O I O O 

22 O O I O I O I 

23 O O I O I I O 

24 O O I O I I I 

25 O O I I O O O 

26 O O I I O O I 

27 O O I I O I O 

28 O O I I O I I 

29 O O I I I O O 

30 O O I I I O I 

31 O O I I I I O 

32 O O I I I I I 

33 O I O O O O O 

34 O I O O O O I 

35 O I O O O I O 

36 O I O O O I I 

37 O I O O I O O 

38 O I O O I O I 

39 O I O O I I O 

40 O I O O I I I 

41 O I O I O O O 

42 O I O I O O I 

43 O I O I O I O 

44 O I O I O I I 

45 O I O I I O O 

46 O I O I I O I 

47 O I O I I I O 
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

48 O I O I I I I 

49 O I I O O O O 

50 O I I O O O I 

51 O I I O O I O 

52 O I I O O I I 

53 O I I O I O O 

54 O I I O I O I 

55 O I I O I I O 

56 O I I O I I I 

57 O I I I O O O 

58 O I I I O O I 

59 O I I I O I O 

60 O I I I O I I 

61 O I I I I O O 

62 O I I I I O I 

63 O I I I I I O 

64 O I I I I I I 

65 I O O O O O O 

66 I O O O O O I 

67 I O O O O I O 

68 I O O O O I I 

69 I O O O I O O 

70 I O O O I O I 

71 I O O O I I O 

72 I O O O I I I 

73 I O O I O O O 

74 I O O I O O I 

75 I O O I O I O 

76 I O O I O I I 

77 I O O I I O O 

78 I O O I I O I 

79 I O O I I I O 

80 I O O I I I I 

81 I O I O O O O 

82 I O I O O O I 

83 I O I O O I O 

84 I O I O O I I 

85 I O I O I O O 

86 I O I O I O I 

87 I O I O I I O 

88 I O I O I I I 

89 I O I I O O O 

90 I O I I O O I 

91 I O I I O I O 

92 I O I I O I I 

93 I O I I I O O 

94 I O I I I O I 

95 I O I I I I O 

96 I O I I I I I 
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PRESET Nr. PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

97 I I O O O O O 

98 I I O O O O I 

99 I I O O O I O 

100 I I O O O I I 

101 I I O O I O O 

102 I I O O I O I 

103 I I O O I I O 

104 I I O O I I I 

105 I I O I O O O 

106 I I O I O O I 

107 I I O I O I O 

108 I I O I O I I 

109 I I O I I O O 

110 I I O I I O I 

111 I I O I I I O 

112 I I O I I I I 

113 I I I O O O O 

114 I I I O O O I 

115 I I I O O I O 

116 I I I O O I I 

117 I I I O I O O 

118 I I I O I O I 

119 I I I O I I O 

120 I I I O I I I 

121 I I I I O O O 

122 I I I I O O I 

123 I I I I O I O 

124 I I I I O I I 

125 I I I I I O O 

126 I I I I I O I 

127 I I I I I I O 

128 I I I I I I I 



Anhang B 

SHURE System-Prozessor P4800 Software-Bedienungsanleitung Seite 102 von 108 

ANHANG B: DSP-AUSLASTUNG PRO PROZESSOR ______________  
Die folgende Tabelle führt den Prozentsatz der DSP-Ressourcen auf, den die einzelnen Prozessoren belegen. Die 
DSP-Ressourcen werden durch folgende Faktoren bestimmt: 

�� Kombination der verwendeten Prozessoren 
�� Anordnung der Prozessoren im Signalflussdiagramm 

Die erste Spalte [% des DSP] führt den Prozentsatz der DSP-Ressourcen auf, die jeder Prozessor in einem P4800 
mit einer Seriennummer, die mit dem Buchstaben N oder höher beginnt, belegt. 

Die zweite Spalte [% des DSP] führt den Prozentsatz der DSP-Ressourcen auf, die jeder Prozessor in einem P4800 
mit einer Seriennummer, die mit den Buchstaben L oder M beginnt, belegt. 

Hinweis:Sie können die DSP-Ressourcen, die eine Konfiguration belegt, nicht genau schätzen, 
indem Sie lediglich die in dieser Tabelle aufgeführten Prozentsätze addieren. 

 

KATEGORIE BLOCKNAME BESCHREIBUNG 

% des 
DSP N 
oder 

höher 

% des 
DSP L 
oder M 

GEQ 10 Grafischer Equalizer mit 10 Bändern 3,5 3,9 Grafischer 
Equalizer GEQ 30 Grafischer Equalizer mit 30 Bändern 7,7 8,5 

PEQ 3 Parametrischer Equalizer mit 3 Bändern 2,1 2,3 
PEQ 5 Parametrischer Equalizer mit 5 Bändern 2,5 2,8 
PEQ 7 Parametrischer Equalizer mit 7 Bändern 2,9 3,3 
PEQ 10 Parametrischer Equalizer mit 10 Bändern 3,5 3,9 
PEQ 3 + C/S Parametrischer Equalizer mit 3 Bändern mit Filtern mit steilflankiger/Kuhschwanz-

Charakteristik 
2,5 2,8 

PEQ 5 + C/S Parametrischer Equalizer mit 5 Bändern mit Filtern mit steilflankiger/Kuhschwanz-
Charakteristik 

2,9 3,3 

PEQ 7 + C/S Parametrischer Equalizer mit 7 Bändern mit Filtern mit steilflankiger/Kuhschwanz-
Charakteristik 

3,3 3,7 

PEQ 10 + C/S Parametrischer Equalizer mit 10 Bändern mit Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik 

4,0 4,4 

Parametrischer 
Equalizer 

CUT/SHELF Hoch- und Niederfrequenz-Filter mit steilflankiger Charakteristik/Hoch- und 
Niederfrequenz-Filter mit Kuhschwanz-Charakteristik 

2,7 3,0 

DFR5 Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern 11,1 12,4 Rückkopplungs- 
Reduzierung DFR10 Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern 12,4 13,8 

DLY 5ms Maximale Verzögerung von 5 ms 3,3 3,7 
DLY 150ms Maximale Verzögerung von 150 ms 3,3 3,7 
DLY 500ms Maximale Verzögerung von 500 ms 3,3 3,7 

Delay 

DLY 2s Maximale Verzögerung von 2 Sekunden 3,3 3,7 

COMP Kompressor 2,1 2,3 
SFT COMP Kompressor - Soft-Knee-Option 2,3 2,6 
ST COMP Stereo-Kompressor 4,2 4,6 
SFT ST COMP Stereo-Kompressor - Soft-Knee-Option 5,6 6,2 
LIM Limiter 2,1 2,3 
SFT LIM Limiter - Soft-Knee-Option 2,3 2,6 
ST LIM Stereo-Limiter 4,2 4,6 
SFT ST LIM Stereo-Limiter - Soft-Knee-Option 5,6 6,2 
AGC Automatische Verstärkungsregelung 2,9 3,2 
GATE Gate 2,4 2,7 
DOWN EXP Abwärts-Expander 2,4 2,7 
PEAKLIM Peak-Stop-Limiter 2,8 3,2 

Dynamik 

DUCK Ducker 3,5 3,9 
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XOVER 2 2-Wege-Frequenzweiche 3,7 4,1 
XOVER 3 3-Wege-Frequenzweiche 4,7 5,2 
XOVER 4 4-Wege-Frequenzweiche 5,7 6,4 
XOVER 5 5-Wege-Frequenzweiche 6,7 7,5 
SPLIT 2 2-Wege-Verteiler 0,9 1,0 
SPLIT 3 3-Wege-Verteiler 1,0 1,1 
SPLIT 4 4-Wege-Verteiler 1,2 1,3 

Frequenzweiche 

SPLIT 5 5-Wege-Verteiler 1,4 1,5 
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ANHANG C: DATEINAMENERWEITERUNGEN ___________________  
Die folgende Tabelle enthält die Erweiterungen der verschiedenen Dateitypen, die von der System-
Prozessor-Software erzeugt werden. 

 

Dateinamen-
erweiterung Herkunft 

.agc Automatische Verstärkungsregelung 

.backup Gesamte Geräte-Datensicherung 

.cdk Ein- und Ausgangsverstärkung 

.comp Kompressor 

.cutshf Hoch- und Niederfrequenz-Filter mit steilflankiger 
Charakteristik/Hoch- und Niederfrequenz-Filter mit  
Kuhschwanz-Charakteristik 

.dfr10 Digitale Rückkopplungsreduzier-Stufe mit 10 Bändern 

.dfr5 Digitale Rückkopplungsreduzier-Stufe mit 5 Bändern 

.dly150ms Maximale Verzögerung von 150 ms 

.dly2s Maximale Verzögerung von 2 Sekunden 

.dly500ms Maximale Verzögerung von 500 ms 

.dly5ms Maximale Verzögerung von 5 ms 

.duck Ducker 

.exp Abwärts-Expander 

.gate Gate 

.geq10 Grafischer Equalizer mit 10 Bändern 

.geq30 Grafischer Equalizer mit 30 Bändern 

.lim Limiter 

.mix Matrixmischer 

.peaklim Peak-Stop-Limiter 

.peq10 Parametrischer Equalizer mit 10 Bändern 

.peq10cs Parametrischer Equalizer mit 10 Bändern mit Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik 

.peq3 Parametrischer Equalizer mit 3 Bändern 

.peq3cs Parametrischer Equalizer mit 3 Bändern mit Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik 

.peq5 Parametrischer Equalizer mit 5 Bändern 

.peq5cs Parametrischer Equalizer mit 5 Bändern mit Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik 

.peq7 Parametrischer Equalizer mit 7 Bändern 

.peq7cs Parametrischer Equalizer mit 7 Bändern mit Filtern mit 
steilflankiger/Kuhschwanz-Charakteristik 

.pin Pin-Konfiguration 

.scn Szene-Datei 

.softcomp Kompressor - Soft-Knee-Option 

.softlim Limiter - Soft-Knee-Option 

.softstcomp Stereo-Kompressor - Soft-Knee-Option 

.softstlim Stereo-Limiter - Soft-Knee-Option 

.stcomp Stereo-Kompressor 

.stlim Stereo-Limiter 

.xover2 2-Wege-Frequenzweiche 

.xover3 3-Wege-Frequenzweiche 

.xover4 4-Wege-Frequenzweiche 

.xover5 5-Wege-Frequenzweiche 
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ANHANG D: STÖRUNGSSUCHE_______________________________  

Kommunikationsstörung zwischen dem Computer und dem P4800: 
Die folgenden Meldungen werden bei Kommunikationsstörungen der P4800 Software mit dem Gerät 
angezeigt.  

„COM(port) is already in use or does not exist...“ (COM-Anschluss wird bereits 
verwendet oder existiert nicht) 
Diese Meldung wird unter den folgenden Umständen angezeigt: 

�� Der vorgegebene COM-Anschluss wird bereits von einer anderen Anwendung verwendet. 

Wenn der vorgegebene COM-Anschluss bereits von einer anderen Anwendung verwendet wird, lässt sich 
das Problem durch Beenden der anderen Anwendung beheben. Beispiele von Anwendungen, die den COM-
Anschluss geöffnet halten, sind der HotSync Manager und ähnliche Dienstprogramme zur Synchronisierung 
des Computers mit Geräten wie Palm Pilot™. Das Schließen solcher Programme ist unter Umständen nicht 
einfach möglich, da sie häufig als Hintergrundanwendungen ausgeführt werden. Informationen sind aus dem 
Benutzerhandbuch der jeweiligen Anwendung ersichtlich. Desktop-Computer verfügen gewöhnlich über 
mehr als nur einem physischen seriellen Anschluss. In diesem Fall kann das Problem behoben werden, 
indem ein anderer COM-Anschluss gewählt und das serielle Kabel für den P4800 dort angeschlossen wird. 

�� Der serielle Anschluss des Computers ist deaktiviert. 

Die BIOS-Einrichtroutine ausführen und den seriellen Anschluss aktivieren. Dabei die Einstellungen des 
seriellen Anschlusses (IRQ- und E/A-Adresse) notieren und sicherstellen, dass unter Windows diese 
Einstellungen einem COM-Port zugewiesen sind. Danach diesen COM-Anschluss in der P4800 Software 
wählen. 

„Network not ready...“ (Netzwerk nicht bereit) 
Diese Meldung weist darauf hin, dass die P4800 Software den COM-Anschluss erfolgreich öffnen konnte, aber 
kein daran angeschlossenes Gerät vorfand. Vor der Kommunikation mit dem P4800 sicherstellen, dass er 
eingeschaltet ist und seinen Startablauf beendet hat. Wenn der Computer mehr als einen COM-Anschluss 
aufweist, sicherstellen, dass das Netzwerkkabel an den gleichen COM-Anschluss angeschlossen ist, der im 
Dialogfeld „Select COM Port“ (COM-Anschluss wählen) eingestellt wurde. 

Sicherstellen, dass ein einwandfreies serielles DB9-Kabel verwendet wird und dass es richtig am Computer 
und am P4800 angeschlossen ist. Außerdem sicherstellen, dass die Verbindung zum richtigen Anschluss am 
Gerät hergestellt wurde: der RS232 ist der Anschluss, der normalerweise verwendet wird. 

„No devices detected.“ (Keine Geräte gefunden) 
Die P4800 Software hat ein anderes Gerät als ein P4800 am gewählten COM-Anschluss vorgefunden. 
Möglicherweise ist ein Modem oder ein anderes serielles Gerät wie beispielsweise ein DFR11EQ vorhanden. 
Dieses Problem lässt sich beheben, indem der COM-Anschluss gewählt wird, an dem der P4800 
angeschlossen ist. 

An der Vorderseite des P4800 wird ein statisches LED-Muster angezeigt: 
An der Gerätevorderseite wird möglicherweise ein ungewöhnliches LED-Muster angezeigt, wenn der P4800 
einen internen Fehler wie in den folgenden Beispielen hat: 

�� Der Steuerpin-Versorgungsstrom (5 Volt, max. 100 mA) war zu hoch oder ist massegeschlossen. Alle 
Steuerpin-Anschlüsse entfernen und die Spannungsversorgung des Geräts aus- und wieder einschalten. 

�� Eine beschädigte Szene ist im Gerätespeicher vorhanden und muss gelöscht werden. Wenn das Problem 
nach Ausführung der nachstehenden Anweisungen fortbesteht, wenden Sie sich an Shure’s Applications 
Group. 

So werden beschädigte Presets gelöscht: 

1. Die P4800 Software öffnen und im Design-Modus „File>Delete Preset“ (Datei>Preset löschen) 
wählen. 

2. Presets, die als „Corrupted“ (Beschädigt) angezeigt werden, löschen. Wenn das aktive Preset 
(LIVE) die Störung verursacht, auf [Cancel] (Abbrechen) klicken. 
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8. „File>New“ (Datei>Neu) wählen, um eine leere Szene zu erzeugen, und dann „File>Store 
Preset“ (Datei>Preset speichern) wählen und das beschädigte aktive Preset (LIVE) mit der 
leeren Szene überschreiben. 

�� Die Aktualisierung der Firmware wurde unterbrochen. Zur Korrektur die nachstehenden Anweisungen 
ausführen. Wenn das Problem fortbesteht, wenden Sie sich an Shure’s Applications Group. 

So wird die Firmware-Aktualisierung abgeschlossen: 

1. Die Spannungsversorgung des Geräts aus- und wieder einschalten. 

2. [Firmware Upgrade] (Firmware-Aktualisierung) aus dem Menü [File] (Datei) auswählen. 

3. Wenn die Software zur Aktualisierung des Codes auffordert, auf [Continue] (Weiter) klicken. 

Umschalten von Geräte-Presets vom Computer ist nicht möglich: 
• Die Sicherheitsstufe des Geräts überprüfen. Damit Presets vom Computer umgeschaltet werden können, 

muss das Gerät auf Sicherheitsstufe 1 oder auf die benutzerdefinierte Stufe 2 eingestellt sein. Für weitere 
Informationen siehe den Abschnitt Sicherheit auf Seite 85. 

• Wenn die Preset-Umschaltung über die Steuerungs-Eingangspins aktiviert ist, reagiert das Gerät nicht auf 
Preset-Umschaltung über den Computer. Zum Beheben des Problems die Steuerpins für Preset-
Umschaltung im Fenster „Control Pin“ deaktivieren. Für weitere Informationen siehe den Abschnitt Preset-
Steuerblock auf Seite 78. 

Die Software schaltet unvermittelt vom Live-Modus in den Design-Modus: 
Wenn beim Arbeiten im Live-Modus an den Steuereingängen angeschlossene Geräte zum Umschalten von 
Presets, Stummschalten von Kanälen oder Einstellen der Lautstärke verwendet werden, schaltet die 
Software möglicherweise in den Design-Modus. Dies ist ein normaler Vorgang. Die Überwachung von 
externer Gerätesteuerung über die Software wird gegenwärtig nicht unterstützt. Bei schnelleren Computern 
tritt diese Situation weniger oft ein. 
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ANHANG E: FIRMWARE-AKTUALISIERUNGEN __________________  
Wenn ein P4800 zum ersten Mal angeschlossen wird, erhalten Sie eventuell eine Aufforderung zur Aktualisierung der 
Firmware. Falls diese Aufforderung erfolgt, ist eine Aktualisierung erforderlich, bevor die neuen Funktionen und 
Verbesserungen der Softwareversion 4.0 des P4800 Systemprozessors genutzt werden können. 

 

Bevor mit der Aktualisierung weitergemacht wird, müssen alle Shure Link Kabel und sämtliche externen Steuergeräte 
abgenommen werden. Sie sollten auch alle anderen offenen Anwendungen schließen. Stellen Sie mit einem RS-232-
Kabel eine direkte Verbindung mit dem P4800 her 

 

Sie können dann eine Sicherungskopie aller Daten in Ihrem P4800 erstellen, indem Sie auf die Schaltfläche [Backup 
Device] (Gerät-Datensicherung) klicken und die Anweisungen befolgen. Nachdem die Datensicherung 
abgeschlossen ist, beginnt die Firmware-Aktualisierung. Unterbrechen Sie die Aktualisierung nicht, nachdem sie 
begonnen hat! 

 

Hinweis: Wenn die Firmware-Aktualisierung aus irgendeinem Grund fehlschlägt (z.B. aufgrund 
eines Stromausfalls oder eines abgenommenen Kabels), müssen Sie [Firmware 
Upgrade] (Firmware-Aktualisierung) im Menü [File] (Datei) wählen, um den 
Aktualisierungsvorgang nochmals zu starten. 
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